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Section I 
OVERVIEW 

What This Provides a method for easily creating waveforms needed by ad- 
vanced signal generating and signal processing instruments. Program Does Tektronix instruments, such as arbitrary waveform generators and 
oscilloscopes that have the "save-on-delta" feature, are en- 
hanced by a software program that greatly assists a user in 
producing waveforms. With W a ~ e w r i t e r , ~ ~  you can use these ad- 
vanced instruments with a minimum of effort. 

With the WaveWriter package, you can create original wave- 
forms or edit waveforms that have been acquired from various 
instrument sources. WaveWriter gives you interactive control of 
the waveform generating process. You communicate with Wave- 
Writer through the Microsoft WindowsTM environment. 

Menus wavewriter menu operations include: 

File 

Start a new waveform 
Open and save waveforms 
Print a hardcopy of the current display 
Exit Wave Writer 

Edit 

Modify an existing waveform 
Flip waveforms horizontally and vertically 
Change horizontal and vertical resolution 

Display 

Set waveform and screen display characteristics 

Draw 

Modify an existing waveform or envelope 
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What You Get With This Program 

E Create 

Generate a sine, triangle, square, and pulse 
Generate a waveform from an equation 
Create an envelope 
Generate a waveform using a sequence of waveforms 

a SigProc (Signal Processing) 

Add, subtract, multiply, divide, and scale waveforms 

Transfer 

Select target instrument 
Setuplconfigure communication parameters 
Move data from instruments to WaveWriter 
Move data from WaveWriter to instruments 

WaveWriter also provides help screens to aid use of the pro- 
gram. 

What You Get The Package consists of: 

With This Program 
E Two 5l/4" high density diskettes 

a Two 3'/2" diskettes 

a The WaveWriter User Guide 

E The WaveWriter Quick Reference 

a A registration card for future updates. 
Be sure to send it in. 

1-2 Wave Writer USER GU IDE 



What You Need to Run This Software 

What YOU Need to Wavewriter is designed to run only in a Microsoft Windows 
environment. Microsoft Windows must be installed on your Run This system before running Wavewriter. See the Microsoft Windows 
User's Guide for installation instructions. 

The Computer The recommended minimum configuration for your system is: 

IBM PCIAT or compatible (however, a system with an 80386 
processor runs noticeably faster - particularly when multi- 
tasking) 

640 kbytes of memory 

A hard disk 

m A graphics monitor interface, preferably an EGA or VGA 
adapter. A CGA adapter will run in high resolution mode, but 
displays in monochrome. A monochrome graphics adapter 
(Hercules or compatible) will run with Windows, but a color 
adapter is recommended for the sake of clearly separating 
screen information. 

A National Instruments GPIB adapter. 

Microsoft Windows 3.0 

Optional Equipment Wavewriter will run without a math coprocessor, but perfor- 
mance will suffer. Although WaveWriter (and Windows) can be 
run from the keyboard, a mouse is highly recommended. 

Supported lnstrument~ Currently, the following Tektronix instruments are supported by 
Wave Writer, Version 2.0: 

11 K and DSA Series Digital Storage Oscilloscopes 

2200 Series Digital Storage Oscilloscopes 

2400 Series Digital Storage Oscilloscopes 

AFG 5101/5501 Arbitrary Function Generator 

w VX5260 VXI Digitizer 

VX5790 VXI Arbitrary Waveform Generator 
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About This Manual I 

About This Manual 

OI'ganiZati~n It is our intent to present information to you in the order in 
which you need it from the the time you unpack everything until 
you store away a waveform you've created. Briefly, this manual 
contains: 

Introduction Section 1 - Overview. This program and its environment. 

Section 2 - Getting Started 

Installing WaveWriter on your PC system 
Starting the program 
Setting up the hardware environment 

Section 3 - Using WaveWriter 

Using the Microsoft Windows environment 
Basic operation of the WaveWriter program 

Section 4 - A WaveWriter Tutorial 

How to... A more detailed description of each of the main menu operations 
in WaveWriter is found in Sections 5 through 11. 

Section 5 - How to use FILE operations 

Section 6 - How to EDIT waveforms 

Section 7 - How to DISPLAY waveforms 

Section 8 - How to DRAW waveforms 

Section 9 - How to CREATE waveforms, Envelopes, 
and Sequences 

Section 10 - How to PROCESS waveforms arithmetically 
(Sig Proc) 

Section 11 - How to TRANSFER waveforms 

References Appendix A - Menu map 

Appendix B - Quick reference 

Appendix C - File structures 

Appendix D - Error messages 

Appendix E - Index 

- - 
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About This Manual 

C0Il~eI l f iOn~ Here is a description of the terms and notations used in this 
manual. 

Keynames The names of keys ( IEsCAPE], m, IENTER I; 
I BACKSPACE I )  are spelled out, even though they may be 
abbreviated or replaced with a symbol on your keyboard. 

Key Combinations When two or more keys are to be pressed at the same time, they 
and Sequences are separated with a plus sign (such as- + +or 

pzFmq + IALfl+ pmq). 
When keys are to be pressed one after the other, the keys (in se- 
quence) are shown separated with commas. For example, "Press m, W]'' means to press -land release it, then 
press pTJ and release it. 

Direction Keys The direction keys are the four arrow keys on your keypad or the 
seoarate arrow keys on an enhanced keyboard. The name used 
in iext refers to the direction the arrow points ( I], v1, 
I, orDOWNI)- 

Entering Data When in DOS, examples of communication between you and your 
from the Keyboard computer are shown in this manner: 

Enter text file name: a:\directory \test.txt 

In the example, roman text is displayed by the operating system 
or the application program. Italic text is text that you are to 
enter verbatim. Bold text is a placeholder that you are to replace 
with specific information appropriate to the situation - for in- 
stance, in the example, directory should be replaced with the cor- 
rect path name to access the file test. txt . In examples, such 
as this, it is assumed that the lENTERI key is pressed at the end 
of a line in which you enter data. 

CAU TION In the Windows environment, t h e [ ]  key is 
not used to terminate a text string. [ENTER] is 
used to initiate a series of actions based on a 
group of selections made in a dialog box. There- 
fore, its use may result in more taking place than 
you expected. See Section 3, Using WaveWriter, 
for more information. 

Wavewriter USER G U ID E  1-5 



About This Manual 

Keyboard versus Mouse All of the selection operations used with this program can be 
done with either a mouse or with a sequence of keystrokes. 
Wherever you can make this choice, instructions are shown both 
ways. At the top of keyboard instructions is a picture of a key- 
board, and a picture of a mouse tops mouse instructions: 

These are instruct~ons for selecting opera- These are instructions for selecting 
tions with keyboard keystroke sequences. operations with a mouse. 

Mouse Terms 
Move With the mouse on a flat surface, and without pressing any of its 

buttons, changing the position of the mouse will cause a cor- 
responding change in position of the mouse cursor on the monitor 
display. 

Drag To "drag" something on the screen means to move the mouse 
cursor arrow to the item to be moved. Press and HOLD the LEFT 
mouse button, and move the mouse to reposition the item. When 
the selected item is located where you want it, release the mouse 
button. 

Point Move the mouse to place the end of the arrow cursor on an 
object, command, or filename. 

Click Press and release the LEFT mouse button. 

Double-click Press and release the LEFT mouse button twice in rapid 
succession. 

NOTE Microsoft Windows only uses the LEFT button on 
a mouse. However, the Wavewriter program 
also uses the RIGHT mouse button for certain 
functions. 
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Technical Support 

Technical Support 

Wave Writer In ~ o r t h  America, for technical support, first contact your local 
sales office; or call the Tektronix national marketing center 

(800) 426-2200, extension 391 1. 

between 8:00 a.m. and 500 p.m., Pacific Time. 

Outside of North America, call your local Tektronix sales office 
or distributor. 

Microsoft Windows For technical support for Microsoft Windows, contact your 
Microsoft support center. 
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Technical Support I 
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Section 2 
GETnNG STARTED 

Software 
Installation 

Programs and Files The Wavewriter program comes to you on both 5'~' (1.2 
Mbyte) and 3'/2" (1.44 Mbyte) diskettes. Either of the two dis- 
kette sizes can be used to install WaveWriter on your system. 
Use the one that matches your system configuration or 
preference. 

Making a Backup Copy Magnetic diskettes are subject to physical damage and the data 
on them is easily destroyed by inadvertant stray magnetic fields. 
A backup copy is inexpensive insurance against loss of data. 

Before proceeding, you should make a copy of each of the disk- 
ettes in the WaveWriter package. Use the copies for installing 
programs and files, and store the original diskettes in a safe place. 

Consult your DOS or Windows 3.0 manual for instructions on 
making copies of the diskettes. 
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Starting Wave Writer 

ln~falling Files Insert the WaveWriter Setup and Program diskette (Disk 1) in 

on a Hard Disk drive A: 

If you are not in Windows type WIN a:\install 

If you are in Windows with the Program Manager active 

Click on the Elle command. The file menu should appear. 

Click on the Bun command. The Bun dialog box should ap- 
pear. 

In the Command Line edit box type a:\lnstall and click on 
OK. 

At this point follow the instructions in each dialog box that ap- 
pears until installation is complete. If you have a question or a 
problem occurs, click on Help in the dialog box. 

Aborting the Installation If, at any time, you need to terminate the installation procedure, 
Click on Exit in the dialog box. 

Starting TO stalt Wavewriter double click on the Wavewriter icon 

WaveWriter 
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I Hardware Setup 

Hardware Setup 

C~f l f ig~r ing GPlB To avoid conflicts between option cards and the GPlB card, you 
will need to ensure the DMA and interrupt channels are not the 
same as those of other devices in your PC. Consult the user's 
guide for your GPlB interface card to determine any hardware in- 
stallation and setup that may be necessary. For example, if 
another interface card uses DMA channel 1, you need to set your 
GPlB card to a different DMA channel. Seldom, if ever, can two 
or more devices share the same DMA channel. 

Note to The SET GPIBO command is no longer needed in the 
WaveWriter 1.0 Users AUTOEXEC.BAT file. 
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Section 3 
USING WA VNVRITER 

In t rod U C ~ ~ O  n This section covers some basic Wavewriter concepts, shows 
you the basics of how to use this product, and gives you some 
background on the Microsoft Windows environment. 

The Target lnstrument Fundamental to WaveWriter is the concept of the target instru- 
ment. The target instrument is the instrument for which you are 
creating waveforms. The selected target instrument defines instru- 
ment specific parameters and limits, such as clock rate and verti- 
cal display ranges. When you bring in a waveform (from a 
different instrument or from a file) and the parameters do not 
match, you are informed of any discrepancies. The waveform 
may be altered to conform to the target instrument limits. 

Before you begin creating or editing waveforms, you should select 
the appropriate target instrument (see ConfigureIChange Instru- 
ment in the Transfer menu). This insures that the waveform you 
are creating is suitable for the target instrument. 

Acquisition Only Instrument This is an instrument driver that only acquires waveforms for 
WaveWriter. It does not have the capability of receiving a 
waveform and , therefore, can never become the target instru- 
ment. Acquisition Only instruments appear in the instrument list 
box when the Transfer Acquire menu item is selected. Com- 
munication parameters are set in the Transfer Configure dialog 
as explained in the Transferring Waveforms section. 

Clock Rate Another fundamental concept in WaveWriter is that all 
waveforms in memory have the same clock rate (tirnelpoint). If 
you need to create waveforms of different clock rates, you must 
change the clock rate (see Change Clock Rate in the Display 
menu). Changing the clock rate reassigns the timelpoint for all 
waveforms in memory. It does not expand or compress the 
waveform to maintain the timing relationship, although that func- 
tion is provided in WaveWriter (see Horizontal Resolution in 
the Edit menu). To create waveforms of different clock rates, we 
suggest you set the clock rate appropriately, create the 
waveform, save the waveform on disk, delete the waveform from 
WaveWriter memory, and then repeat the process for other 
waveforms. 
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Offset Offset is handled in two ways within WaveWriter. The offset may 
be externally associated with a waveform, or it may be part of the 
waveform data values. 

When acquiring or reading a waveform from an instrument or file, 
any offset externally associated with the waveform is remembered 
by WaveWriter. 

For example, if acquiring from a 2400 Series DSO, offset is the 
equivalent of the vertical position control. If acquiring from the 
AFG 510115501, this is the OFFSET parameter. If you attempt to 
send that waveform to an instrument or write it to a file, you can 
modify the offset and store it with the waveform. If you modify the 
offset previously defined for that waveform, the changed value is 
remembered by WaveWriter. This offset is displayed with each 
entry in the Waveform List (described later in this section). 

It is also possible to include an offset value in the waveform data 
values themselves. This is in addition to any offset externally 
defined. Add Scalar offsets waveform data values. The functions 
which create waveforms (Sine, Triangle, Pulse, Square, and 
Equation) also build the offset directly into the waveform data. 
For these cases, the waveform is no longer centered around 0 
Volts on the display. Unless an external offset was already 
defined for the waveform, the external offset would be 0 Volts. 

Display I Bit range The horizontal axis represents time and is displayed in either 
points or seconds. The vertical axis displays the voltage and is 
always symmetrical around 0 Volts. The maximum peak-to-peak 
display amplitude can never exceed the maximum peak-to-peak 
amplitude of the target instrument. Although the waveform 
amplitude may exceed this limit, the data is clipped on the dis- 
play, and clipped if sent to the target instrument or saved in an 
instrument-specific file. 

The vertical axis amplitude represents the full bit range of the 
target instrument. That is, if the vertical axis range is set from 
+ 5 Volts to - 5 Volts, and the target instrument has 12-bit 
resolution, 5 Volts would represent level 2047, and -5 Volts 
would represent -2047. 

To use the maximum resolution of the instrument, we suggest 
you set the vertical scale to the full amplitude of the waveform 
(see Set Axis Ranges or Autoscale Current Waveform in Sec- 
tion 7 How to Display Waveforms). In addition, the waveform 
data needs to be centered around zero Volts. For example, if the 
waveform data values are offset so that they only lie in the upper 
half of the Waveform Display Area, only half the resolution is 
being used. You can use the Add Scalar function to add or sub- 
tract necessary offset so the waveform is symmetrical around 0 
Volts, and then assign this scalar amount as an external offset 
when you save or send the waveform. 
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I Why Use Windows? 

Markers Markers delimit segments of the waveform. For many menu selec- 
tions, you have the option of using the entire waveform, or only 
the portion of the waveform between and including the markers. 
The distance between the markers can never exceed the maxi- 
mum record length for the target instrument. If the Start or Stop 
marker is dragged past this length, the corresponding marker will 
be moved with it. (See Markers later in this section for more infor- 
mation.) 

Why Use Microsoft Windows is a control program that provides a common 
interface between DOS, application programs, and you. With 

ws ? Windows, you can start several programs and switch between 
them, as needed, with a few keystrokes or a point and click with 
a mouse. Since you can leave a task without shutting it down, it 
is quickly resumed without having to restart - you can pick up 
where you left off. 

Windows is a memory manager that lets several programs "set 
up shop" and arbitrates the demands these different tasks have 
on the system. 

If you are already an experienced Windows user, proceed to 
Setting Characteristics, later in this section. If not, read on for 
some information on using Windows. 

This section is not meant to be an exhaustive tutorial on Win- 
dows. Our purpose is to familiarize you with the conventions used 
by this and other programs designed to work with Windows. For 
more information, read the Microsoft Windows User's Guide (pub- 
lished by the Microsoft Corporation) or one of several other books 
on the subject. 



Conslstent Command Style 

Consistent Windows defines the display area of each task with a rectangular 
border. Many of these rectangular "windows" can be displayed Corn rnand on your monitor screen at the same time - each one repre- 
senting an activated program. Each window generally has these 
common elements (also shown in Figure 3-1): 

Border - defines the display area for a task. 

Title Bar - shows the name of the program running in this 
window. May also show the name of a file associated with 
the program. A highlighted title bar indicates the currently 
active window. The Wavewriter title bar also displays the 
currently selected target instrument and the name of the cur- 
rent waveform (if any). 

Control-Menu Box - when selected, displays the Control- 
menu. 

Control-Menu - has commands that control the size and 
placement of the selected window. 

Minimize Box - replaces a running program window with 
an icon. The program is still running, but the symbol (icon) 
representing the program only takes up a small space on 
the display screen. 

Maximize Box - enlarges a window to fill the entire display 
screen. No other windows or icons are visible when the cur- 
rent window is maximized. Some applications that need the 
full screen may not have a border and can't be resized. 
Also, these applications may not have a maximize box. 

Menu Bar - selectable groups or categories of commands 
are listed in the menu bar. 

Work Area - the space where your application program 
displays text and graphics, and where you enter information 
for the program. The work area may be split into two or 
more smaller windows within the border. If your work is 
larger than can be displayed in the work area, some applica- 
tion programs add scroll bars to one or two borders of the 
work area (see Scrolling, below). 

In addition, the MS-DOS Executive window has: 

Disk-drive Icons - pictorial representations of the disk 
drives in your system configuration. The icon of the current- 
ly active drive is highlighted. 

Listing of the current directory - the highlighted entry in 
the list is the one currently under consideration by MS-DOS 
for the next operation, whatever that may be. 
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Consistent Command Style 

Figure 3- 1. 
Window Display Elements. 
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Scrolling 

rolling If there is too much information to fit in a window (such as a long 
directory listing), a scroll bar may appear at the side of the win- 
dow frame. A window may have a vertical scroll bar, a horizontal 
scroll bar, or both. Scroll bars let you scan the window (work 
area) to access parts of your workspace beyond what's visible on 
the screen. 

When you've reached the work area border, t o  scroll the screen: 

P r e s s m ,  FRIGHTJ,pJ, or 
pm]  (as appropriate) to move the dis- 
play further. For example, if you've 
reached the far right of the work area, 
press pRWq repeatedly to advance the 
window to the right. The display in the 
work area moves to the left as you do so, 
exposing more and more of the right side 
of your work. 

The length of a scroll bar represents 
the length of the workspace in the 
dimension controlled by the scroll bar. 

To see a part of the workspace that is 
currently invisible, drag the scroll box 
to the approximate location desired 
(toward the beginning, middle, or end 
of the scroll bar). 

Some applications let you scroll a screen- To scroll ONE LINE or ONE COLUMN 
ful at a time: at a time, move the mouse cursor 

(arrow) to a scroll arrow (pointing in 
pXC3ZT.C. moves window UP or LEFT the desired direction) and clrck the 
one screen. LEFT mouse button. 

moves window DOWN or To scroll larger chunks at a time, move 
RIGHT one screen. the mouse cursor to the scroll bar at 

either side of the scroll box and click 
the LEFT mouse button. 



Menus 

Menus There are two kinds of menus used with a window: the control- 
menu and application menus. Application menus contain com- 
mands that are specific to an application program. This section 
deals with the control-menu and menu commands that are 
features of WaveWriter: 

COntrO~-menll The Control-menu has commands that change a window's size, 
reposition it, restore it to its previous size or location, or close the 
window. The Control-menu commands Minimize and Maximize do 
the same thing as the Minimize and Maximize boxes. 

To access the control-menu: 

Press lAn] + 1-1. Point the cursor arrow at the Control- 
menu box and click the LEFT mouse 

When the pull-down Control-menu appears, the Restore com- 
mand is highlighted. If the window has not been resized, the Re- 
store command is also shown in gray letters. This means that the 
Restore command is not an available option at this time. This is 
typical of all pull-down menu commands - a grayed-out option 
can not be selected. 

To access other command options: 

. . . 
Press the FJWNl or keys to highlight :.'!: 

. . . 
other options. 

Press to select a highlighted 
option. 

. .. 
To close the current window, 
press -1 

. . . r. Move the mouse up or down to change 
' ,  which option is highlighted. . . 

, .  
Press the LEFT mouse button to select 

. . . 
i:: a highlighted option. 

To close a current window, move the 
mouse arrow outside the window to an 
unused part of the display and click the 
LEFT mouse button. 
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Underlined Letters 

Underlined Letters Underlined letters provide keyboard access to commands. They 
are found in menu bars, pull-down menus, and dialog boxes (see 
Dialog Boxes, Keyboard Direct Access for more informat ion). 

Menu Bars Each command option in a menu bar has an underlined letter. 
This letter can be used in combination with the key as a 
keyboard shortcut to select a menu bar option and pull down its 
menu. 

Pull-down Menus In pull-down menus, pressing the underlined letter in the desired 
command selects that option. 

Alternate Menu After a menu bar option has been pulled-down, you can use 
the ILEFf] and v7 keys to pull down adjacent menu bar op- Bar Selections tions. That is, when a menu is displayed, press w] and the 
menu is replaced by the menu to its left. If you press the 
menu is replaced by the menu to its right. When you reach either 
end of the menu bar, an additional key press takes you to the 
other end of the menu bar. 

Making a Selection TO select a highlighted menu item: 

. . . .: 
I:;:: Press p3iTiTl . Press the LEFT mouse button. 

Some commands in a menu list may need more information from 
you before proceeding, and display a dialog box to prompt you for 
further data. These commands are marked in the menu list with 
three dots (an ellipsis) following the command name. 

Command selections displayed in gray are not available under the 
current conditions. 
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Dialog Boxes 

Dialog Boxes When you select a menu command that requires you to enter text 
or to inspect or modify a program parameter setting, a dialog box 
pops up in the middle of the display. Dialog boxes can be very 
simple or quite complicated, depending on how much information 
the program needs to do the job you requested it to do. 

C0nf ~ O I S  Dialog boxes have several classes of controls (Figures 3-2A and 
3-28) that handle data differently: 

List box - a list of names related to the current operation 
(see Figure 3-2B). 

r- \ 

I c :  \DIRNAME 

- - -- -  Push button - a rectangular button internally labeled with 
the action taken when it is selected. 

Edit box - a space for you to enter or modify text. 

O A O  Radio button - a captioned round button that selects only 
one of several optional features or conditions. 

"[XI " Check box - a captioned square box used where several 
options can be selected at the same time. 

Group Boxes A group of related controls may be enclosed in a border with a 
descriptive heading - this is called a group box. 

The TAB key The key can be used to move between areas of a dialog 
box when selecting options. The caption of the control to which 
you've moved is enclosed in a dotted line. In the case of option 
buttons, the caption of the currently selected button is enclosed. 

Keyboard If a letter in the name of a control or group box heading is under- 
Direct Access lined, you can access the control or group box directly: press and 

hold m, press and release the underlined letter, then 
release m. 
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Dialog Boxes 

Figure 3-2A. 
Dialog Box Areas. 
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Figure 3-28. 
Dialog Box Areas. 

P r i n t e r s  - 
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Data Already Entered A dialog box may pop up with information already in place. This 
data is typically default or previous conditions; but the program 
can also display parameter values suggested by the present 
circumstances. In any case, you are free to make changes if the 
feature is not displayed in gray. 

- 

Grayed Display Grayed commands or options can not be accessed under the 
conditions in effect at the time the dialog box is displayed. 

-List Box 
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Dialog Boxes 

Edit Boxes In an edit box, a flashing vertical cursor marks the insertion point. 
Highlighted text is replaced when a key is pressed. When you 
press a displayable key, the character is displayed at the insertion 
point. Any existing text at the right of the insertion point is moved 
to the right. 

To edit existing text: 

Move the insertion point to the desired 
place in the text line with the or 
vfl key. Add characters as needed, 
or use either the 7 1  or 
p E T € ]  key to remove unwanted text. 

v l  moves the insertion point to the 
beginning of the line. moves the in- 
sertion point to the end of the line. 

..... . . . 

. ... ... 

... . . . 
iiSi ... Press to move to the next area. . . . 
. . . ... . . . 
. . ..... . . . ..... 

Point the mouse cursor at the desired 
insertion point and click the LEFT 
mouse button. 

Enter or remove the desired characters 
from the keyboard as shown at left. 
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Dialog Boxes 

List Boxes A list box is a column of names that you can choose from. These 
might be disk drive, file, and/or directory names, but can be a list 
of almost anything pertinent to a given function. If there are more 
names than can fit in the display, the list box has one or more 
scroll bars. Some names are enclosed in brackets: 

[ S ~ I R ]  - Text enclosed in brackets is a subdirectory 
name. 

[ . . ] - The parent directory, one level up, is indicated with 
two periods enclosed in brackets. 

[-A-] - A letter enclosed in hyphens and brackets is a 
disk drive designation. 

To select a list box item: 

Use the [UVJ and keys to high- 
light the desired selection. 

. . 
If the list is longer than can be displayed iiii:. . . 
in the list box, use -1 . ... ... . . .  . 

. . .  and [I to scroll the list. ... ... . . .  

. . .  . . .  
... 

moves to the beginning of the list. i.ili 
... ... 

moves to the end of the list. ... ... ... ... 
... . . .  ... ... 

To select a highlighted item, press . . .  . . .  . . .  
... ... 

r s P A C E B A R l o r m .  ... ... ... ... ... 

Point the cursor arrow at the desired 
item and click the LEFT mouse button. 
(In some cases, a double click is 
necessary - more later.) 

iiiij If the desired item isn't visible, use the ,:!! 



I Dialog Boxes 

Push Buttons Push buttons start an action process for a given dialog box. The 
default push button, if any, has a bolder outline than other push 
buttons in the same dialog box. 

If you press the default push button and any other dialog 
box selections (default or otherwise) are automatically chosen. 

Radio Buttons TO select an radio button: 

After moving to a radio button control with 
the key, you can move within the 
control area with direction keys. Moving 
to an item within the control area selects 
that item. When you to another con- 
trol, the selected item stays selected. 

... ... 
$$ To select an radio button, point to the . . .  ... ..... ... ... iiiii desired button and click the LEFT ... 

Check Boxes TO select a check box: 

You can always cancel a dialog box with the -1 key. 
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Setting Characteristics 

Set f i ng Waveform characteristics are defined by setting or modifying 
parameters in dialog boxes that appear when some menus are Characteristics selected~ 

units of Measure Wherever it's appropriate, units of measure are appended to an 
edit box at its right side. Modifiers to those units are included as 
part of the data within the edit box. For example, a value of 230 
milliseconds is displayed as: 

The modifiers that are recognized by WaveWriter are these 
Systeme Internationale (SI) characters. Case is significant. 

G = giga 
M = mega 
K = kilo 
m = milli 

u = micro 
n = nano 
p = pic0 

Non-integer numeric values can be expressed in scientific or 
exponentialnotation. Scientific notation uses a mantissa (a 
decimal number) followed by an exponent. The form for this type 
of number is: 

- n.nn E- n 
The signs can be omitted for positive values. 

The earlier 230 millisecond example could also be entered as any 
of the following: 

Choice of Units Some parameters can be expressed in different units of measure. 
Horizontal units can be either Seconds or Points. Phase angle 
can be Degrees or Radians. (Vertical units are always Volts.) 

Units of measure are selected with option buttons. When a dif- 
ferent unit of measure is chosen, the current edit box value is con- 
verted to the new units. 



I Waveform List 

Waveform List The Waveform ~ i s t  area of the display lists the waveforms current- 
ly loaded in memory. You can pick from this list to select a dif- 
ferent waveform as the current waveform. To change waveforms, 
point to the desired waveform in the list and click the LEFT 
mouse button or, using the keyboard cursor keys, highlight the 
desired waveform in the list and press 1-1 or m. 
Each waveform name in the list is displayed in the color defined 
for that waveform, except white is displayed as black. The current 
waveform is highlighted. If there are more names than can fit in 
the Waveform List box, scroll bars are added to the display. 

Also, on each entry line, the Waveform List shows the 
waveform's saved offset value, length, and waveform type. The 
length is the number of data points in the waveform. The 
waveform type is either "Wfm" for waveforms, or "Env" for en- 
velopes. (See Offset earlier in this section.) 

NOTE Select colors with care. If the waveform color is 
the same as the background color, it won't be 
visible. If this happens, correct one or both colors 
with the Set Colors & Line Styles command in 
the Display menu. 

The Waveform List can be moved, resized vertically, or changed 
to an icon. When WaveWriter starts, the Waveform List is dis- 
played as an icon. Any user activity (keyboard or mouse) also 
reduces the Waveform List to an icon at the bottom of the screen 
automatically. At any time, while WaveWrlter is active, the 
Waveform List icon can be expanded to a window for viewing 
filenames and selecting loaded waveforms. You can do this by 
either pointing to the Waveform List icon and double-clicking the 
mouse, or by using the key to move to the icon and select- 
ing it with the - or p3liTRl key. If the Wave Writer win- 
dow is maximized, use the Change Current Waveform com- 
mand in the Display menu. 

Figure 3-3 R E F I E N U .  ADF - 1 0 0 m U  1 . 3 1 m S  
Waveform List. SQUARE.ADF OU 1 . 3 1 m S  W f m  

- 
- P U L S E - A D F  OU 1 . 2 8 m S  W f m  -- 

INTERMOD.  ADF OU 2 . 5 6 m S  W f m  
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The Wave Writer Window 

The WaveWriter 
Window 

Markers In the horizontal axis, portions of the displayed waveform can be 
bounded by the Start Marker and the Stop Marker. These 
markers are used to define a narrower region to be acted on by 
various WaveWriter command tools. 

Each marker has a 'Ylag" attached to it at the top of the 
waveform display area. The Start Marker flag is marked with the 
symbol ">>" and the Stop Marker flag is marked with "<c". 

The precise location of the markers is displayed in the upper left 
corner of the window. The distance between the markers can't 
exceed the maximum record length of the target instrument. If the 
Stop Marker is dragged past this length, it will pull the Start 
Marker with it. The same is true in the other direction; the Start 
Marker will also pull the Stop Marker. The readout is either in 
Points or Seconds, to match the waveform display. (See Set Axis 
Ranges in the Display menu.) 

To adjust the markers: 

. . . ... ... . . . . . . . . . . , . 

i:ii'i to a Start or Stop Marker. The . . . >:. 
,. .. . , . ::::. 

i:ii; . . . selected marker flashes one time. Press j:ji 
-1 orlENrER] to activate the 
marker Use the LEFT and RIGHT cursor 

... 
;":! . . keys to position the marker. Press 
'! ( s P A C E B A R I o r V j t o s e t t h e  ... ... ... ... 

' marker. 
... 

Click and HOLD the LEFT mouse button 
on the marker you wish to move. Drag 
the marker horizontally to the desired posi- 
tion. When you release the mouse button, 
the marker is set. 

Title Bar The Title Bar lists 3 items separated with colons: The name 
" WaveWriter," the target instrument, and the name of the current 
waveform. 

Coordinates The precise location of the pointer or the crosshair cursors 
(whichever is selected), is displayed in the lower left corner of the 
window. The X readout is either in Points or Seconds, to match 
the waveform display. The Y readout is always in Volts. 
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The Wave Writer Window 

Figure 3-4. 
Wave Writer Window Display Elements. 

' \ Scroll Box Icons Cursor Arrow 

Waveform Display Area This area of the screen displays the waveforms that have been 
acquired, created, or modified. When a waveform is created (or 
acquired), even if a longer length is valid for an instrument, the 
range that can be displayed in Wavewriter is 0 - 32766 points 
The Waveform Display Area can scroll throughout this range. 

I I 
Border Waveform Display Area 

Wavewriter USER GUIDE 3-1 7 

Cursor/Crosshair Coordinates Horizontal Scroll Bar Vertical Scroll Bar 



The Wave Writer Window I 
Clock The readout in the upper right corner of the window is the clock 

rate of the waveforms in the Waveform List. All waveforms in 
memory have the same clock rate. See Change Clock Rate in 
Section 7. The clock rate is used in frequency and equation cal- 
culations. 

Menu Bar The Menu Bar just below the Title Bar displays the menus avail- 
able to you. Select a menu with a point and click of the mouse or 
press and hold , press and release the underlined letter, 
then release pJ . 

Help The menu item at the far right of the Menu Bar is the Help com- 
mand. You can select the Help command to provide you with a 
brief explanation of the workings of various Wavewriter com- 
mands. When Help is selected from the main menu bar (with no 
dialog box displayed on the screen), a Help Topics dialog box 
(Figure 3-5) appears with a list box of available help text mes- 
sages. 

Figure 3-5. 
The Help Dialog Box. i l e  Menu Oueruiew 

Menu Oueruiew 

[T] (Lancel] 

OK - displays help for this highlighted topic. Return from the 
help message display by selecting the Control-menu box and 
then selecting Close from the Control-menu or double-clicking 
the Control-menu box. 

Cancel - returns to the main screen display. 
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Section 4 
TUTORIAL 

What This In this section we will cover the essentials of using Wavewriter. 
Tutorial Covers This includes the user interface (commands, controls, and dis- 

plays). The tutorial is broken into five lessons: 

W Systemfundamentals. 

Creating and modifying waveforms. 

Working with an AFG 51 0115501 Arbitrary Function Generator. 

Working with a 2400 Series Digital Oscilloscope and envelope 
waveforms. 

Working with a VX5790 VXI Arbitrary Waveform Generator and 
the Sequence Editor. 

Each lesson can be followed independently of the others. We 
recommend, however, that you go through lesson 1 first, and then 
on to the lesson suited to the instrument you'll be using. The les- 
sons use waveforms and other files that are distributed with Wave 
Writer and are loaded when you install the software. The last three 
lessons require that the instrument be available for some parts of 
the lesson. 

In each lesson, you are asked to clear waveforms from memory 
before beginning. If there are waveforms in memory which have not 
been altered, you will be prompted to save them first. If you want to 
save the data, select Yes. Otherwise, select No. 

In some lessons, you save files that you create. Therefore, if you go 
through the same tutorial more than once, the file you are creating 
will already be on disk. If so, you will be warned and asked if you 
want to overwrite it. Select Yes to overwrite it. 

Whenever you see a phrase like, 

Enter "1 .24uW in the Start edit box. 

it means to place the cursor in the Start edit box (by clicking on it 
with the mouse, tabbing to it, or using the accelerator key) and 



Tutorial I 
in~uttina the characters 1.24~.  It does not mean to Dress 
t h e m ]  key too. For dialog boxes. the -1 key is usually the 
equivalent of selecting OK. 

We are assuming that you are already familiar with the Microsoft 
Windows interface. If not, please refer to the appropriate Microsoft 
Windows manuals and possibly their tutorial on learning Windows. 

We are also assuming that you are using a mouse. We feel that this 
is the best way to use WaveWriter, although it can be used without 
a mouse. If you do not have a mouse, refer to either your Microsoft 
Windows manuals, or Section 3 of this user guide, for information 
about how the Microsoft Windowsinterface works without a mouse. 

Lesson 1 : 
System Fundamentals 

Overview The objective of this lesson is to familiarize you with the basic 
operation of WaveWriter. We will address the important concepts 
of the target instrument, clock rate, and offset. We will describe the 
WaveWriter display including how to set up the horizontal and ver- 
tical axis scales, how to move the markers, and how to use the cur- 
sor coordinates. We will tell you how to display help screens. 

Step 1 : If you have not installed WaveWriter, please do so before you 
StaaingWaveWriter continue. 

For this example, we are assuming that you have installed 
Wavewriteron directory C:\ WW. If not, please substitute for 
C:\WW the drive and directory where you have installed Wave 
Writel: 

a) Enter CD C:\WW to make the Wavewriterdirectory the 
default directory. 

b) If you have Windows/286, enter WIN WAVE. 

c) If you have Windows/386,enter WIN386 WAVE. 

WaveWriter is loaded and the copyright screen is displayed. Note 
that the Wavewritertitle bar includes the name WaveWriter and 
the target instrument. Below that is the main menu bar. Below the 
File menu selection are the Start and Stop marker locations. Below 
the Help menu selection is the system clock rate. The Waveform 
DisplayArea is below that. To the lower left of the Waveform 
DisplayArea is the cursor coordinates display. If you move the 
mouse cursor around in the Waveform DisplayArea, you will notice 
that the coordinates display is updated. 
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Note If you are using a monochrome monitor, you may want to use the 
Display menu function Set Colors & Line Styles to use only the 
colors black and white. For example, either set the current 
waveform, background waveforms, and labels & units colors to 
black and the background and graph background to white, or vice 
versa. Otherwise, the waveforms may not be visible in the default 
colors. 

Step 2: Help information is available to you when you use WaveWriter. 
Using the Help function The help screens that are displayed are very similar to information 

that is found in the WaveWriter User Guide. 

There are two ways that you can display help screens within 
WaveWriter. The Help function in the main menu will display a list 
of all help topics available. In addition, each dialog box in Wave 
Writer has a Help command button. If you select the Help com- 
mand button, you will get information pertinent to the dialog box 
(menu selection). 

a) Select the Help function from the main menu. 

The Help Topics dialog box is displayed. It lists all help topics 
which are available. 

b) Double-click on the WaveWriter Overview topic. 

The Overview help screen is then displayed. This discusses 
the concepts of target instrument, clock rate, offset, dis- 
playlbit range, markers, and acquisition only instruments. 

c) Point to the vertical scroll box, click the LEFT mouse button, 
and drag it to the bottom to view the entire help window. 

d) To close the help window, double-click on the Control-menu 
box at the upper left corner of the help window. 

This returns you to the Help Topics dialog box. 

e) Point to the vertical scroll down arrow, click and hold the 
LEFT mouse button, to scroll through the entire help topics 
list. 

f) Select Cancel when you are done viewing the help topics to 
exit the Help function. 



Tutorial 1 

Selecting 
Step 3: The selected target instrument defines instrument specific 

the target instrument parameters and limits such as clock rate, Start and Stop marker 
limits, and vertical resolution and display range. The target instru- 
ment is the only instrument that you can send waveform data to 
until you select a different target instrument. 

Figure 4- 1. 
Con figure/Change 

lnstrwment Dialog Box. 

If you will always use Wavewriterwith one target instrument, you 
simply set it once and it will be remembered from then on. If you will 
be building waveforms for more than one instrument, you will need 
to set the appropriate target instrument before you begin creating 
the waveform to insure that it is acceptable for that instrument. 

a) Select the Transfer menu function Configureichange 
lnstrument. 

The ConfigureIChange lnstrument dialog box is displayed, as 
shown in Figure 4-1. 

WX526O. DRU GPIBO UXI PRI 07 dovOl 

This dialog box is used to change the target instrument. It is 
also used to add, change or delete instruments which are 
configured. 

The line in the Configurations list box with the >> indicates 
the instrument which is selected as the target instrument. 

Lines marked with an asterisk (*) are acquisition only instru- 
ments and cannot be selected as the target instrument. 

b) Double-click on the AFG 51 01 driver in the Configurations list 
box, if it is not already the target instrument. 
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c) Select the Help command button. 

The ConfigureIChange Instrument help window is displayed. 
Read through the text to leam about how this selection is 
used to configure new instruments. 

d) Double-click on the Control-menu box to close the help 
window. 

e) Select OK 

f) If the system clock rate is not valid for the newly selected tar- 
get instrument, you are warned and offered the chance to 
change it to the nearest valid rate for the new target instru- 
ment. Accept the value offered. Select Yes. 

g) You may also be warned that the display amplitude is too 
large for the new target instrument. It will automatically be ad- 
justed to the maximum allowed by the target instrument. 

The target instrument is now set to the AFG 51 0115501 and 
the Wavewritertitle bar displays AFG 5101, the configured 
name. If the system clock rate was changed, its display is up- 
dated as well. 

Step 4: All waveforms in memory have the same clock rate, therefore chang- 
Setting the clock rate ing the clock rate affects the frequency content of all waveforms in 

memory. The waveform shape or size (number of points) is not 
changed by this command, only the time per point is changed. 

a) Select the Display menu function Change Clock Rate. 

Since the AFG 51 01/5501 is the target instrument, the 
AFG 5101/5501 Clock Rate dialog box is displayed (see Fig- 
ure 4-2). You have the option of entering the clock rate in 
either Time per Point or Frequency. 

b) Enter 2u in the Time per Point edit box. 

Note This can be done several ways. The Time per Point enty could be 
entered as 2E-6,2u, or .000002. If you enter the clock rate in Fre- 
quency, you could have entered the clock rate as either 500K, 
500000, or5E5. 

c) To see the equivalent frequency, press . 

The Frequencyedit box is updated to 500 K, as shown in 
Figure 4-2. 
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Figure 4-2. 

AFG 5101/5501 Change 
Clock Rate Dialog Box. 

Time p e r  P o i n t :  I 2 "  I S - 
(016) 

Frequency: 7 1  Hz - 

d) Select OK to confirm the clock rate selection. 

The clock rate display is updated to show the new clock 
rate. If the horizontal axis is displayed in seconds, the labels 
are updated to reflect the new clock rate. 

Step 5: Set Axis Ranges sets the ranges for the vertical and horizontal axis 
Setting theaxis ranges scales of the waveform display. This selects a portion of the overall 

waveform to be displayed. Parts of waveforms outside the 
WaveformDisplayArea are clipped, not lost, and can be restored 
by setting a wider range again in the Set Axis Ranges dialog box. 

a) Select the Display menu function Set Axis Ranges. 

The Set Axis Ranges dialog box is displayed (see Figure 4-3). 

b) Enter "2.5" in the Amplitude edit box. 

This will set the vertical axis from 1.25 Volts to -1.25 Volts. 

c) Select the Seconds option button. 

Note that the units next to the Startand Stopedit boxes are 
changed to Sec. The selection of this option not only affects 
the way you enter the Start and Stop point, but also indicates 
the units used for the horizontal axis, the Startand Stop 
marker readouts, and the X coordinate readout. 

d) Enter "0" in the Start edit box. 

e) Enter "2.046m" in the Stop edit box. 

The dialog box should now appear as shown in Figure 4-3. 
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Vert ical  Horizontal 

0 Poin t s  

Start:  [ Sec 

f) Select OK. 

The WaveformDisplayArea is then changed to reflect the 
new axis selection. The horizontal axis, Startand Stop 
markers, and X coordinate are displayed in seconds. 

Step 6: Not all waveforms that are loaded or acquired have the appropriate 
Read a waveform from disk clock rate. Wavewritercan manipulate a waveform so that it can 

conform to the required clock rate. The following procedure will 
illustrate this capability. 

a) Select the File menu selection Open. 

The Open dialog box is displayed. 

b)' Select the ULTRASON.ADFfilefrom the Files In list box. 

c) Select OK. 

At this time a dialog box is displayed warning you that the 
clock rate of the waveform does not match the target instru- 
ment clock rate. You are offered three choices on how to 
resolve the differences, as shown in Figure 4-4. 

Figure 4-4. 
Different Clock Rate Dialog Box. 

T a r g e t  I n s t r u m e n t  Time p e r  P o i n t  = 2 u  

Inooming U a u e f o r n  Time p e r  P o i n t  = 1.28~ 

@ i . ~ ' ~ ~ ' - . ~ ' - ' ~ ' ~ '  
~~hansa..~~~!!.~*n-sss.C1~P!!k RJ-Kt??: ttoo.f 2u 

O n a s s a g e  Incoming  U a u e f o r n  t o  M a i n t a i n  T i m i n g  

O C h a n g e  System C l o c k  R a t e  t o  1.28~ 

( pk 1 s a n o e l  ( u.1~  3 
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The first selection, will change the clock rate of the incoming 
waveform to the system clock rate. It simply reassigns the 
timelpoint of the waveform without changing any data. 

The second selection will either lengthen or shorten the 
waveform to maintain the timing relationship. In other words, 
one second in the incoming waveform will equal one second 
at the current clockrate. 

The third selection will change the system clock to the rate of 
the incoming waveform. If there were other waveforms in 
memory, their clock rate would be reassigned as well. 

d) Select the Change the lncoming Clock Rate option button. 

e) Select OK to confirm the selection. 

The waveform is then loaded, and the time per point reas- 
signed from 1.28uS to 2uS. The waveform becomes the cur- 
rent waveform, as noted in the title bar. 

Now we will load the file again, but this time we will choose 
the second option to maintain timing so as to compare 
results. 

f) Select the File menu selection Open. Double-click on the 
ULTRASON.ADF entry in the Files In list box. 

You are warned that the file already exists and given the op- 
tion to replace the waveform or create a new waveform. 

g) Select the CreateNew Waveform option button. 
Enter ULTRA2 in the New WaveformName edit box. 
Select OK . 
The dialog box warning you of the different clock rates is 
then displayed. 

h) Select the Massage lncoming Waveform to Maintain Timing 
option button and select OK. 

You are then asked to choose between three transform 
methods, as shown in Figure 4-5. 

Figure 4-5. 
Transform Methods Dialog Box. Transform Method: O r i g i n a l  Data t o  New Data 

@ iHearest-,&~1ddtte_r!..-!~i_?.f.: PPr_es:~~e~-,_S_sttee~..5<Fazte~-~J 
0 s h o r t  Funct ion:  Genera l  Purpose  ( S t a n d a r d )  

Q ~ o n g e r  Funct ion:  P r e s e r v e s  S i n e  Uaves  ( S l o w e r )  
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Selection of the nearest related point option replicates a 
single data level to calculate the needed data points and is 
the fastest method. Selection of short function option uses 
linear interpolation to calculate the needed data and is slight- 
ly slower than the preceding option. This selection is best 
suited when working on mixed signals such as pulse and 
sinusoidal waveforms within the same waveform. Selection of 
the long function option uses a spline interpolation algorithm 
to calculate the required data. This selection requires the 
longest amount of time and is best suited for sinusoidal type 
waveforms. It also produces the highest degree of accuracy. 

i) Select the Short Function option button. 

j) Select OK to confirm the selection. 

The waveform is then decimated to conform to the system 
clock rate. Notice the differences in the waveforms. The new 
waveform becomes the current waveform, as noted by the 
change in the title bar, and the change of waveform colors. 

The Waveform DisplayAreashould now appear as shown in 
Figure 4-6. 

Figure 4-6. 
Waveform Display Area. 

k) Load two more waveforms from disk using the following 
steps: 

Select the File menu selection Open. 
Double-click on the SAMPLE.ADF entry in the Files In list box. 

This time, since the clock rate conforms to the system clock 
rate, the waveform is loaded automatically and becomes the 
current waveform. 
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Select the File menu selection Open. 
Double-click on the DECAY.ADF entry in the Files In list box. 

The waveform is brought into WaveWritermemory and be- 
comes the current waveform. 

Step 7: The AutoscaleCurrent Waveform function is used to automatically 
Autoscaling thecurrent Waveform change the axis scales to best fit the current waveform. The last two 

waveforms that were read into Wavewriterexceeded the vertical 
axis previously established in Set Axis Ranges. 

a) Select the Display menu function Autoscalecurrent 
Waveform 

The vertical and horizontal axis scales are automatically 
changed based on the maximum and minimum Volts and 
record length of the current waveform. 

Note that the waveform data was still there, even though the 
display clipped it. 

Step 8: To magnify a region of the WaveformDisplayArea , use the Zoom 
Zooming In to see the waveform In menu selection. This allows you to specify a region to be en- 

larged. This is useful for viewing and drawing. 

a) Select the Display menu function Zoom In. 

The left hand corner of the zoom box appears. We will mag- 
nify the second cycle of DECAY.ADF. 

b) Using the coordinate readouts, place the corner at ap- 
proximately x: 378uS, y: 3.53V. Press the LEFT mouse but- 
ton and drag to approximately x: 766uS, y: 300mV. Release 
the mouse button. 

The region within the box is now magnified. 

c) Select the Display menu function Zoom Out to return to the 
original display. 

Step 9: Many Wavewriterfunctions operate on the current waveform. 
Selecting the current waveform Many also establish the current waveform. For example, when you 

loaded a new waveform from disk, it automatically became the cur- 
rent waveform. To designate another waveform as the current 
waveform, you use the WaveformList. The WaveformList can be 
displayed either by selecting the Display menu function Change 
CurrentWaveform, or by double-clicking on the WaveformList 
icon at the bottom of the display. The WaveformListdisplays a list 
of waveforms currently in memory. The offset remembered for each 
waveform, the length, and the waveform type is also displayed. 
Waveform type is either waveform (WFM) or envelope (ENV). 
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a) Double-click on the Waveform Listicon. 

The list shown in Figure 4-7 would be displayed. The rec- 
tangle indicates that DECAY .ADF is the current waveform. 

Figure 4-7. 
Waveform List. 

b) Click on SAMPLE.ADF to make it the current waveform. 

Note that the Wavewritertitle bar is changed to reflect your 
choice. SAMPLE.ADF is now displayed in the current 
waveform color. 

Note that the WaveformList will become an icon again as 
soon as you click outside the Waveform List Window. 

Step 10: Offset is handled in two ways within WaveWriter. The off set may be 
Usingoffset externally associated with the waveform, or it may be part of the 

waveform data values. 

When acquiring or reading a waveform from an instrument or file, 
any offset externally associated with the waveform will be remem- 
bered by WaveWriter For example, if you read in a waveform file 
which has an offset stored with it, it will be remembered by Wave 
Writer and displayed in the Waveform List, but will not be used 
when displaying the data. If you send the waveform to an 
AFG 5101/5501, or VX5790 AWG, the offset will be sent with the 
waveform (e.g.OFFSET parameter). If you send it to a 2400 Series 
DSO, the vertical position control will be set to the offset value. 

It is also possible to add offset into the waveform data values them- 
selves. This would be in addition to any offset externally defined. 
Add Scalarwill offset the waveform data values. Also, the functions 
which create waveforms (Sine, Triangle, Pulse, Square, and 
Equation) build the offset directly into the waveform data. For these 

- -- 
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cases, the waveform will no longer be centered around 0 Volts on 
the display. Unless an external offset was already defined for the 
waveform, the external offset would be 0 Volts. 

a) If the Waveform List is not still displayed, doubleclick on the 
Waveform List icon. 

Note that file SAMPLE.ADF has an external offset associated 
with it. The rest do not. 

Look at the WaveformDisplayArea. WaveformDECAY.ADF 
has offset built into the data, i.e., there is no external offset as- 
signed, but the waveform is not centered around 0 Volts on 
the display. 

It is possible to have both an external offset, and to build 
some offset into the data itself. 

Step 11 : Markers delimit segments of the waveform in the horizontal axis. 
Using the markers For many menu selections, you have the option of using the entire 

waveform, or only the portion of the waveform between and includ- 
ing the markers. The distance between the markers can never ex- 
ceed the maximum record length for the target instrument. If the 
Start or Stop marker is dragged past this length, the corresponding 
marker will be moved with it. 

Each marker has a flag attached to it at the top of the waveform dis- 
play area. The Start marker flag is marked with the symbol >> and 
the Stop Marker with c < . 

The precise location of the markers is displayed in the upper left 
corner of the window. 

a) To move the Start Marker, click and drag on the box with the 
>>. As you drag the marker to the right, the Stop Marker 
will move with it automatically. As you then move the Start 
Marker back to the left, the Stop Marker will no longer move 
with it. Note that as you move the markers, the marker 
readouts are updated as well. 

b) To move the Stop Marker, click and drag on the box with the 
<<. 

Note Due to screen resolution, it is sometimes difficult to move a marker 
a point at a time. If this is a problem, use the Zoom In function to 
enlarge the region, move the markers as desired, and select Zoom 
Out. 



I Tutorial 

Lesson 2: 
Creating and Saving 

a Television Signal 
Waveform 

Overview This lesson steps you through the creation of a television signal 
waveform using various WaveWriter menu selections. You will 
learn to use: 

Create functions (Equation, Sine, and Pulse) 
Draw functions (Autoline and Horizontal) 
Edit functions (Copy Between Markers and Replace 

Between Markers) 
SigProcfunctions (Add Scaler, Multiply by Scaler and 

Multiply Waveforms). 

The waveform you will create is a NTC-7 composite test signal. It 
consists of 5 parts: 

H Horizontal Blanking Pulse 

H Line Bar 

H Modulated Sine-Squared Pulse 

4 Modulated 5-riser staircase 

Figure 4-8 is a picture of the waveform you will be creating. 

Figure 4-8. 
NTC-7 Composite Test Signal. 
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Step 1 : 

Clear all waveforms from 
Wave Writer memory, if any exist 

a) Select the Edit menu function Clear Waveform@) 

The Clear Waveform(s) dialog box appears. 

b) Select the All Waveformscommand button. 

Note Clear Waveform(s) is grayed and unavailable if there are no 
waveforms in memory. If there are waveforms in memory which 
have been altered and not saved, you are given the option to save 
them before deleting them. 

Step 2: 
Change the target instrument 

to the VX5790 

a) Select the Transfer menu function ConfigureIChange 
Instrument. 

The ConfigureIChange Instrument dialog box appears. 

b) Double-click on the Configuration list box entry for 
WVX5790.DRV. 

Note that the >> indicator is now with the VX5790 entry. 

c) Select OK. 

d) If you are warned that the current system clock rate is invalid 
for the newly selected target instrument, select OK to accept 
the clock rate offered. 

Note that the Wavewritertitle bar displays VX5790 as the tar- 
get instrument. 

Step 3: 
Change the system clock rate 

to 34.9 nanoseconds 

a) Select the Display menu function Change Clock Rate. 

The Change Clock Rate dialog box for the VX5790 AWG 
appears (see below). 

b) Select the External option button. 

c) Enter 34.9n in the External edit box. 
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d) Select the Use New Ext Rate command button. 

Note that the Time/Pointlist box is updated. 

e) Select 34.9 nanoseconds from the Time/Point list box. 

The dialog box should now appear as follows: 

Figure 4-9. 
VX5790 Change Clock Rate 

Dialog Box. 
Time/Point: 

-Master Clock 

0 internal: 1 0  nSec 

@ t e r a :  34.1 Sec 

Use New Ext Rate - 

Selected Sec/Point: 34.9n S 
Selected Freouency: 28.6533tlHz 

(7) (-1 [fi) 

f) Select OK 

The clock rate display just below the menu bar at the far right 
is updated to show the new system clock rate. 

Step 4: 
Create a new waveform 

a) Select the File menu function New. 

The New dialog box appears. 

b) Enter "lesson2" in the New WaveformNameedit box. 

c) Select the Seconds option button. 

d) Enter 63.6576~ in the Record Length edit box. 

e) Select the Normal Waveformoption button. 

f) Select OK. 

A new waveform is created at 0 Volts. This waveform 
becomes the current waveform, as noted in the Wavewriter 
title bar. 
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Step 5: 

Set up the axis to display 
the desired amplitude and 

record length 

a) Select the Display menu function Set Axis Ranges. 

The Set Axis Ranges dialog box appears. 

b) Enter "2" in the Amplitude edit box. 

c) Select the Seconds option button. 

d) Enter " 0  in the Startedit box. 

e) Enter 63.6227~ in the Stop edit box. 

f) Select OK. 

The vertical and horizontal axis ranges are updated to reflect 
your responses. The horizontal axis, markers and X coor- 
dinate readouts are in seconds. 

Step 6: 
Create the horizontal 

blanking pulse 

a) Select the Display menu function Zoom In. 

The left hand corner of the zoom box appears. 

b) Using the coordinate readouts, place the corner at ap- 
proximately x: OS, y: 350mV. Press the LEFT mouse button 
and drag to approximately x: 9 6 ,  y: -720mV. Release the 
mouse button. 

The region within the box is now magnified. 

c) Select the Draw menu function Horizontal. 

d) Position the cursor at x: 1.54uS, y: -285.7mV (+I- 1 OmV). 
Click the LEFT mouse button and drag to x: 6.42uS. (Note 
that as you drag the mouse, the horizontal line always stays 
at the original voltage selected.) Release the LEFT mouse 
button to end the line segment. Press the RIGHT mouse but- 
ton to redraw the display. 
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Note If you have difficulty positioning to the initial location using the 
mouse, use the mouse to get close to it, and then use the direction 
keys to move to the exact location. 

e) Select the Display menu function Zoom Out. 

f) Select the Create menu function Sine. 

The Sine dialog box appears (see below). 

g) Select the Ampl/Offset option button in the Verticalgroup 
box. 

h) Enter "285.7mV in the Amplitude edit box. 

i) Enter "0" in the Offsetedit box. 

j) Select the Secondsoption button in the Horizontalgroup 
box. 

k) Click on the Cycles check box if it isn't empty. 

Note that the Calculate command button is changed to say 
Calculate Cycles. This is the parameter which will be calcu- 
lated, based on the Start Point, Stop Point, Frequency, and 
system clock rate. 

I) Enter "6.98~" in the Start Pointedit box. 

rn) Enter "9.42~" in the Stop Point edit box. 

n) Enter "3.58606557Mn in the Frequency edit box. 

o) Select the Calculate Cycles command button. 

Cycles is updated based on the parameters entered. The 
value should be 8.88. 

p) Enter "0" in the Phase edit box. 

q)  Select the Replace option button in the Action group box. 

The Sine dialog box should now appear as shown in Figure 
4-1 0. 
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Figure 4- 10. 
Sine Dialog Box. U o r t i o a l  'Hor izonta l  

O n a x / n i n  @ ~ r r o l / o f f s ~ +  9 Sooonds 0 P o i n t s  

m a t a r t  Po in t1  I 6 . 9 8 ~  1 sco 
(Pk-Pk) [XI sfom P o i n r l  I 9 . 4 2 ~  ] Soo 

FrefluonOyr 13 .58606557~  ] Hz 

Aotion 
8 Borlaoo 

0 I n s e r t  

ehasrr L 0 Radians 
o h w  waveform 1 oogroos 

(-1 ( )  ( Helo  ) 
I 

r) Select OK. 

s) Select the Display menu function Zoom In to magnify the 
region just created. 

The display should be similar to that shown in Figure 4-1 1. 

Figure 4- 1 1. 
Horizontal Blanking Pulse. 

t) Select the Display menu function Zoom Out to return to the 
original display. 

Step 7: 
Create line bar 

a) Select the Create menu function Pulse. 

The Pulse dialog box appears. 

b) Fill out the Pulse dialog box as shown in Figure 4-1 2. 
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Figure 4- 12. 
Pulse Wave Dialog Box to 

Create Line Bar. Vertical -Horizontal @ Seconds 0 Points 

[ X I ~ t a r t  Point: -1 Sec 

tlinirmnr u [XI S ~ O D  Point: 11 S ~ C  

Period: p z z q  Sfit2 

@ Replace 

0 in ser t  

0 Add 
0 & w  Waueforn 

Pulse Yidth (50%): -1 sec 

Risgtime: Falltine: 
[ 1 0 4 . 7 n l s e c  1 1 0 4 . 7 n l s c c  

(7) 

C) Select OK. 

Step 8: 
Create 2T pulse 

a) Select the Create menu function Equation. 

The Equation dialog box now appears (see below). 

b) Select the Library command button. 

The Equation Library dialog box is displayed. 

c) Select the 2T pulse entry by double-clicking on it. 

The Equation dialog box is redisplayed with the selected 2T 
pulse equation in the Equation edit box. 

d) Select the Seconds option button. 

e) Enter '33.923~" in the Start Pointedit box. 

f) Enter '34.551 u" in the Stop Point edit box. 

g) Select the Replace option button. 

The dialog box should appear as shown in Figure 4-1 3. 
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Figure 4- 13. 
Equation Dialog Box for 2T Pulse. 

Figure 4- 14. 
2T Psrlse Display. 

Eauation: 

[.7143*(sin(2+~i*(t-.000033923)*796178.34)*2) 1 
Horizontal 

($ Reolace 
Start Point: 1-1 0 points 
$fop Point: ( @ 

0 &u Vaveforn 

( ~ d d  Eguation to ~ i b r o r y )  [-) (-) (-) (Help) 

h) Select OK. 

i) Select the Display menu function Zoom In to magnify the 
region just created. 

The 2T Pulse is displayed in Figure 4-14. 

j) Select the Display menu function Zoom Out to return to the 
original display. 

Step 9: 
Create the modulated sine 

squared pulse 

We will build the modulated sine squared pulse by creating two in- 
dividual waveforms, multiplying them together, and then copying 
the result into the lesson 2 waveform we are creating. 

Steps a through e could be done all in one step using the modsin2 
equation in step a instead of the sin2 equation, but we wanted to 
show you how to use the SigProc and Edit functions. 
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a) Select the Create menu function Equation. 

Select the Librarycommand button. 

The Equation Library dialog box is displayed. 

Select the sin2 entry by double-clicking on it. 

The Equation dialog box is redisplayed with the selected sin2 
equation in the Equation edit box. 

Enter "0" in the Startpoint edit box. 
Enter "3.385~" in the Stop Point edit box. 
Select the New Waveformoption button. 
Enter "sin2" in the WaveformName edit box. 
Select OK. 

The sine squared waveform is then created starting at time 0. 

b) Select the Create menu function Equation. 

Select the Library command button. 

The Equation Library dialog box is displayed. 

Select the carrier entry by double-clicking on it. 

The Equation dialog box is redisplayed with the selected car- 
rier equation in the Equation edit box. 

Select the NewWaveform option button. 
Enter "carrier" in the WaveformName edit box. 
Select OK. 

Notice that the Start and Stop Points remain the same as 
the previous step. 

The carrier waveform is then created starting at time 0. 

c) Now we will offset the carrier and scale it back to 1 Volt. 

Select the Slg Proc function Add Scalar. 
Enter 1 in the Add Scalar edit box. 
Select the Entire Waveform option button. 
Select OK. 

Select the SigProc function Multiply by Scalar. 
Enter .5 in the Multiply by Scalar edit box. 
Select the Entire Waveform option button. 
Select OK. 
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d) Select the SlgProc function Multiply Waveforms. 

Double-click on the carrier entry in the Displayed Waveforms 
list box. 

Note that the black rectangle is now around the Wfm2 entry 
indicating that it is the edit box which will receive the input. 

Double-click on the sin2 entry in the DisplayedWaveforms 
list box. 

Click on the Wfm3 edit box and enter "rnodsin2" to put the 
product in a new waveform named modsin2. 

Select OK. 

modsin2 is now the current waveform. 

e) Select the SigProcfunction Multiply by Scalar. 
Enter .7143 in the Multiply by Scalar edit box. 
Select OK. 

f) Select the Display menu function Zoom In to magnify the 
region between approximately x: OS, y: 700mV and 
x: 4.26uS, y: -100mV. . 

Move the StattMarker to 0s. 
Move the Stop Marker to 3.385 US (the end of modsin2 
waveform). 

g) Select the Edit menu function Copy Between Markers. 

This copies the data in modsin2, the current waveform, into 
the edit buffer. 

h) Select the Edit menu function Clear Waveform(s) to remove 
from memory the three waveforms we just created. 
Click on the sin2 entry. 
Press and hold the v] key. 
Click on the carrier entry. 
Click on the modsin2 entry. 

L Select OK. 

For each waveform selected, you are warned that you 
haven't saved the waveform and given the opportunity to 
save it before it is deleted. Select No for each option since 
we don't need these waveforms any longer. 
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i) Select the Display menu function Zoom In to magnify the 
region between approximately x: 36uS, y: 750mV and 
x: 42uS, y: -1 00mV. 

Move the Start Marker to 37.4131.1s. 
Move the Stop Marker to 40.833~s. 

Select the Edit menu function Replace Between Markers. 

This takes a copy of the edit buffer, which contains the modu- 
lated sine squared pulse, and puts it into the current 
waveform between the markers. 

It should appear as shown in Figure 4-15. 

Figure 4- 15. 
Modulated Sine Squared Pulse. 

j) Select the Display menu function Zoom Out to return to the 
original display. 

Step 10: 
Create the modulated 5-Riser 

staircase test signal 

a) Select the Create menu function Sine to create the first sine 
wave. 

The Sine dialog box is displayed. Note that the values you 
entered last time are remembered. You only need to modify 
the entries which are different. 

b) Fill out the dialog box as shown in Figure 4-1 6. 
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Figure 4- 16. 
Sine Dialog Box for First 

Portion of 5-Riser Staircase. 

c) Select OK. 

V e r t i c a l  

I m ~ l i t u d e :  1-1 U 
(Pk-Pk) 

Action 
$ R e ~ l a c e  

0 Add 
0 N e w  Waveform 

d) Select the Create menu function Sine to create the next sine 
wave on the stairstep. 
Enter "1 28.6mV in the Offset edit box. 
Deselect the Stop Point check box so that Stop Point is 
calculated. 
Enter "49.523~" in the Start Pointedit box. 
Enter "9.1 25" in the Cycles edit box. 
Select the Calculate Stop Point command button to see the 
resulting Stop Point. 
Select OK. 

- Horizontal  
$ Seconds 0 P o i n t s  

[ X l ~ t a r t  Point: 1 1  Sec 

S t o p  9 o i . n ~ :  1 S1c 

[XI c y c l e s :  

- - - -- -- - - - - - - - 
;Calculate  Stop Point!  

0 Radians 
Phase: I] - e g r e e s  

e) Select the Create menu function Sine to create the next sine 
wave on the stairstep. 
Enter "257.1 m" in the Offset edit box. 
Enter "52.07~" in the Start Pointedit box. 
Select OK. 

(-7ji-) (Z] [F) 

f) Select the Create menu function Sine to create the next sine 
wave on the stairstep. 
Enter "385.7mn in the Offset edit box. 
Enter "54.61 7u" in the Start Pointedit box. 
Select OK. 

g) Select the Create menu function Sine to create the next sine 
wave on the stairstep. 
Enter "514.3m" in the Offsetedit box. 
Enter "57.1 64u" in the Startpoint edit box. 
Select OK. 

h) Select the Create menu function Sine to create the last sine 
wave on the stairstep. 
Enter "642.9mn in the Offsetedit box. 
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Enter "59.714~" in the Start Point edit box. 
Select OK. 

i) Select the Display menu function Zoom In to magnify the 
region between approximately x: 60uS, y: 800mV and 
x: 63.65uS, y: -1 00mV. 

j) Select the Draw menu function Autolineto draw the final line 
of the waveform. 

k) Position the cursor at x: 62.26uS, y: 714.3mV (+I- 1 OmV). 
Click the LEFT mouse button and let up. 
Move the cursor to x: 63.45uS, y: 71 4.3mV. 
Press the LEFT mouse button to end the line segment. 
Press the RIGHT mouse button to redraw the screen. 

I) Select the Display menu function Zoom Out. 

m) Select the Display menu function Zoom In to magnify the 
5-Riser staircase region just created (from approximately 
x: 42uS, y: 800mV, to x: 63uS, y: -200mV). 

It should appear as shown in Figure 4-1 7. 

Figure 4- 1 7. 
)Riserstaircase. 

n) Select the Display menu function Zoom Out to return to the 
original display. 

Step 11 : 
Save the waveform as an ADlF file 

a) Select the File menu function Save. 

The Save dialog box appears. 
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Note that the name you entered, lesson2, shows up as the 
default for the Save File Nameedit box. 

b) Select the ADlFFile check box. 
Use the default extension of ADF. 
Deselect the Instrument Specific File check box. 
Deselect the Make Backup check box. 
Use the default Offsetof 0. 
Select OK. 

File LESSON2.ADF is now saved. 

Step 12: 
Load file NTC-7.ADF and 

compare results 

a) Select the File menu function Open. 

b) Double-click on the NTC-7.ADF entry in the Files In list box. 

The waveform is loaded into Wavewritermemory and be- 
comes the current waveform. This waveform is our solution 
to the above steps and should closely match yours, if you've 
followed all the steps correctly. 

Lesson 3: 
Working with an 
AFG 5101/5501 

Arbitrary 
Function Generator 

Overview This lesson illustrates the Acquire and Send functions for the 
AFG 510115501. You will load a waveform from disk, change the 
clock rate, and send the waveform to Bank 1 of the AFG. You will 
then acquire the same waveform back to show you that it got there 
correctly. 

Step 1 : 
Clear all waveforms from 

WaveWritermemory, if any exist 

a) Select the Edit menu function Clear Waveform(s) 

The Clear Waveform(s) dialog box appears. 
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b) Select the All Waveforms command button. 

Note Clear Waveform(s) is grayed and unavailable if there are no 
waveforms in memory. If there are waveforms in memory which 
have been altered and not saved, you are given the option to save 
them before deleting them. 

Step 2: 
Change the target instrument 

to the AFG 510115501 

a) Select the Transfer menu function ConfigureIChange 
Instrument. 

The ConfigureIChange Instrument dialog box appears. 

b) Double-click on the Configuration list box entry for 
WAFG5101 .DRV. 

c) Select OK. 

d) If you are warned that the current system clock rate is invalid 
for the newly selected target instrument, select YES to 
accept the clock rate offered. 

Note that the Wavewritertitle bar displays AFG5101 as the 
target instrument. 

Step 3: 
Change the clock rate to 2uS 

a) Select the Display menu function Change Clock Rate. 

The Change Clock Rate dialog box for the AFG 51 0115501 is 
displayed. 

b) Enter "2u" in the Time per Point edit box. 

c) Select OK. 

The clock rate display just below the menu bar at the far right 
is updated to show the new system clock rate. 
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Step 4: 

Open file SAMPLE-ADF 

a) Select the File menu function Open. 

The Open dialog box is displayed. 

b) Select the SAMPLE.ADF entry from the Files In list box by 
double-clicking on it. 

The waveform is loaded from disk into WaveWritermemory 
and becomes the current waveform, as noted in the title bar. 

Step 5: 
Scale the waveform to utilize the 

maximum bit resolution based on 
the waveform amplitude 

a) Select the Display menu function Autoscale Current 
Waveform. 

Note the change in the vertical and horizontal axis scales. 

The waveform should appear as shown in Figure 4-18. 

Figure 4- 18. 
SAMPLE ADF Display 

Step 6: 
Send the waveform to the 

AFG 510115501 

a) Select the Transfer menu function Send. 

The Send AFG 510115501 dialog box appears, as shown in 
Figure 4-19. The instrument was first polled to get the current 
bank number and beginning address as defaults. The 
WaveWritersystem clock rate, axis amplitude, and remem- 
bered offset are also displayed as defaults. 

Note: If the AFG 5105 is not at the GPlB address shown in the configura- 
tion dialog box, a warning stating that the AFG 51 05 was not found 
is displayed. Select the "Search" option to have Wave Writersearch 
all addresses for the AFG 5105. 
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Figure 4- 19. 
Send A FG 51 0 1/5501 Dialog Box. 

...-. " .... "... *."" ...... ."...."..."..".., I @/send .... ................ Waveform! 
m..- ................... ..# 

0 Send Waveform Between Markers I ,  
Bank Number: 

Begin BOOR: 10 1 - 
F i l t e r :  

Output Amplitude: 17.451 U ( 5 0  Ohms) 

Offset:  1 1  I U 

Time per  P o i n t :  IZu I S - 

b) Select OK to accept the defaults shown. 

The waveform is sent to the selected bank number, begin- 
ning at the address specified. 

Step 7: 
Acquire the same waveform back 

from the AFG 510115501 

a) Select the Transfer menu function Acquire. 

The Acquire dialog box appears with a list box of all instru- 
ments previously configured. 

b) Select the AFG 51 01 by double-clicking on it. 

The Acquire AFG 51 01l5501 dialog box now appears. The 
Begin ADDR and Bank Numberselected in the Send dialog 
box appear as the defaults. 

c) Select the Create New Waveform option button. 

d) Enter lesson3 in the WaveformName edit box. 

The dialog box should now appear as shown in Figure 4-20. 
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Figure 4-20. 
Acquire AFG 5101/5501 Dialog Box. 

o l e p l a c e  Cur ren t  Waveform 

@ Create  Hew Waveform 

Wapeform Name: 7 1  

e) Select OK. 

The waveform is then acquired from the selected bank and 
becomes the current waveform. Note that the waveforms are 
identical in the WaveformDisplayArea. 

Lesson 4: 
Working with a 2400 

Series Digital Storage 
Oscilloscope 

Overview This lesson shows how to create an envelope waveform by 
tolerancing a non-envelope waveform. The newly created envelope 
and the original normal waveform are then sent to reference 
memory in the scope. 

Step 1 : 
Clear all waveforms from 

Wave Writer memory, if any exist 

a) Select the Edit menu function Clear Waveform(s). 

The Clear Waveform(s) dialog box appears. 
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b) Select the All Waveforms command button. 

Note Clear Waveform(s) is grayed and unavailable if there are no 
waveforms in memory. If there are waveforms in memory which 
have been altered and not saved, you are given the option to save 
them before deleting them. 

Step 2: 
Change the target instrument to 

the 2400 Series DSO 

a) Select the Transfer menu function ConfigureIChange 
Instrument 

The ConfigureIChange Instrument dialog box appears. 

b) Double-click on the Configuration list box entry for 
W2400DSO.DRV. 

c) Select OK. 

d) If you are warned that the current system clock rate is invalid 
for the newly selected target instrument, select OK to accept 
the clock rate offered. 

The Wavewritertitle bar displays DS02400 as the target in- 
strument. 

Step 3: 
Change the clock rate to 2mSldiv 

a) Select the Display menu function Change Clock Rate . 

The Change Clock Rate dialog box for the 2400 DSO is dis- 
played. 

b) Enter "2m" in the Time per Division edit box. 

c) To see the corres~ondina Time Per Point and Freauencv 
' values, enter either jTF&(or . These edit bbxes' 
will be updated with the equivalent values. 

d) If the ExternalClockcheck box is selected, then deselect. 

The dialog box should now appear as shown in Figure 4-21. 
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2400 Series DSO Change Clock 

Rate Dialog Box- 

Step 4: 
Set up the axis to display 

the desired amplitude and 
record length 

) Enter  ONE o f  t h e  f o l l o w i n g :  1 
I 

Tine Per ~ i v i s i o n :  -1 S - 

Tfme per  p o i n t :  1 4nu 1 S 

Frequency: -1 P o i n t s  / Second - 

0 E x t e r n a l  Clock 

e) Select OK. 

The clock rate display just below the menu bar at the far right 
is updated to show the new system clock rate. It shows the 
clock rate in both timetpoint and timeldiv. 

a) Select the Display menu function Set Axis Ranges. 

The Set Axis Ranges dialog box appears. 

b) Enter "1 " in the Amplitude edit box. 

c) Select the Points option button. 

d) Enter "0" in the Startedit box. 

e) Enter "1 023" in the Stop edit box. 

f)  Select OK. 

The vertical and horizontal axis scales are updated to reflect 
your responses. The horizontal axis, markers and coor- 
dinates readouts are in points. 
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Step 5: 
Open file SQUARE.ADF 

Figure 4-22. 
SOUAREAOF Display. 

a) Select the File menu function Open. 

The Open dialog box is displayed. 

b) Double-click on the SQUARE.ADF entry in the Files In list 
box. 

The waveform is loaded from disk into WaveWritermemory 
and becomes the current waveform, as noted in the title bar. 

The Waveform DisplayAreashould now appear as shown in 
Figure4-22. 

-0.4-: 
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0 200 400 600 800 100 
e: 191 Points 

Step 6: 
Create an envelope waveform 

using SQUARE.ADF as the base 

a) Select the Create menu function EnvelopeTolerance. 

Fill out the dialog box as shown in Figure 4-23. 
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Figure 4-23. 
Envekoe Tolerance Dialoa Box. 

Displayed Waveforms 

Output Envelope: 

Figure 4-24. 
SQUARE.ADF and 

ENVELOPE.ADF 

'Vertical Tolerance 

0 Voltage Value 
@Percentage (Peak to Peak) 

0 Percentage (User Defined) 

0 Digitizing Level 

tlari~un Tolerance: [TI % 

Minimum Tolerance: -1 Z - 

Processing Region 
@Entire Uaveforn 

Horizontal Tolerance 

1 m : ;:;;fl 

b) Select OK. 

WaveWritercomputes the waveform maximum and mini- 
mum values and then creates the upper limit of the waveform 
using a 10% vertical tolerance, and the lower limit using a 
15% vertical tolerance. For the horizontal tolerance, each 
waveform point will be shifted left and right by 5 points, creat- 
ing a band 10 points wide. ENVELOPE.ADF becomes the cur- 
rent waveform. 

The Wveform Display Area should now appear as shown in 
Figure4-24. 
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Step 7: 
Send the envelope to 
reference memory 1 

a) Select the Transfer menu function Send. 

The Send 2400 Series DSO dialog box is displayed. 

b) Fill out the dialog box as shown in Figure 4-25. 

Figure 4-25. 
Send 2400 Series Dialog Box. 

@ Send ~aveform 

0 Send Waveform Between garkers 

Location 
@ 0 REF2 ............ Y 

0 REF1 0 REF4 17 
-Vertical  Posit ion 

n S e t  WaveWriter Screen 0 . 0  v o l t s  t o  
Oscilloscope center grat icule .  

Enter v e r t i c a l  posit ion @ Volts 
of ground reference: 10 0 ~ i v i s i o n s  

(7) (-1 (Help) 

c) Select OK. 

The envelope waveform is then sent to reference memory 
location 1. 

Step 8: 
Send the original waveform to 

reference memory 2 

a) Bring up the Waveform List by double-clicking on the 
WaveformList icon at the bottom of the screen. 

b) Select SQUARE.ADF as the current waveform by clicking on 
it. 
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c) Select the Transfer menu function Send. 

The Send 2400 Series DSO dialog box appears. 

d) Select theREF2 option button. 

e) Select OK. 

The original waveform is sent to reference memory location 2. 

Lesson 5: 
Working with the 
VX5790 Arbitrary 

Waveform Generator 

Overview This lesson familiarizes you with the Sequence Editor. You will load 
and send three waveforms from disk and build and send a se- 
quence using them. You will then modify the sequence, save it, and 
send it to the VX5790 AWG. 

Step 1 : 
Clear all waveforms from 

WaveWriter memory, if any exist 

a) Select the Edit menu function Clear Waveform(s). 

The Clear Waveform(s) dialog box appears. 

b) Select the All Waveforms command button. 

Note Clear Waveform(s) is grayed and unavailable if there are no 
waveforms in memory. If there are waveforms in memory which 
have been altered and not saved, you are given the option to save 
them before deleting them. 

Step 2: 
Change the target instrument to 

the VXI VX5790 AWG 

a) Select the Transfer menu function ConfigureIChange 
Instrument. 

The ConfigureEhange Instrument dialog box appears. 

b) Double-click on the Configuration list box entry for 
WVX5790.DRV. 
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c) Select OK. 

d) If you are warned that the current system clock rate is invalid 
for the newly selected target instrument, select OK to accept 
the clock rate offered. 

The Wavewritertitle bar displays VX5790 as the target instru- 
ment. 

Step 3: 
Change the clock rate to 1.28uS 

a) Select the Display menu function Change Clock Rate. 

The Change Clock Rate dialog box for the VX5790 AWG is 
displayed. 

b) Click on the 1 . 2 8 ~  entry in the Time/Point list box. 

The dialog box should now appear as shown in Figure 4-26. 

Figure 4-26. 
VX5790 Change Clock Rate 

Dialog Box. 

'Master Clock 

@ I n t e r n a l :  1 0  nSec 

0 E x t e r n a l :  -1 Sec 

0c;e # t ? ~  f x t  Ratr? 

Se lec ted  Sec/Point: 1.28uS 
Se lec ted  Frequency: 781.25KHt 

8 1 . 9 2 ~  lil (7) (-) (K) 

c) Select OK. 

The clock rate display just below the menu bar at the far right 
is updated to show the new system clock rate. 

Step 4: 
Set the horizontal and 

vertical axis scales 

a) Select the Display menu function Set Axis Ranges. 

The Set Axis Ranges dialog box is displayed. 
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b) Enter "1 0" in the Amplitude edit box. 

c) Select the Points option button. 

d) Enter "0" in the Start edit box. 

e) Enter "999" in the Stop edit box. 

f) Select OK. 

Step 5: 
Open files PULSE.ADF, SINE.ADF, 

and TRIANGLE.ADF 

a) Select the File menu function Open. 

The Open dialog box is displayed. 

b) Enter PULSE.ADF in the Open File Name edit box. 

c) Select OK. 

The pulse waveform is loaded, displayed, and becomes the 
current waveform. 

d) To load the second file, select File - Open, and double-click 
on file SINE.ADF. 

The sine waveform is loaded, displayed, and becomes the 
current waveform. 

e) To load the third file, select File - Open, and double-click on 
file TRIANGLE.ADF. 

You are warned that the clock rate of file TRIANGLE.ADF 
does not match the system clock rate. The VX5790 AWG re- 
quires all waveforms to have the same clock rate. We will 
modify the waveform to decimate data points so that it will 
conform to the system clock rate. 

f) Select the Massage Incoming Waveform to Maintain Timing 
option button and select OK. 

You are prompted for the transform method to use. The 
default option of nearest related point works well for this tri- 
anglewave. 

g) Select the Nearest Related Point option button and select 
OK. 

The waveform is then decimated to maintain the same timing 
relationship. 
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The WaveformDisplayArea should now appear as shown in 
Figure4-27. 

Figure 4-27. 
Sine, Pulse, and Triangle 

Waveforms. 

'Start: I Clock: 1.28uS 

-4 : 

0 200 ' ' ' '4A0 6d0 8i0 1 C 

e 187 Points 

Step 6: 
Save the massaged triangle wave 

so that it can be used with the 
Sequence Editor 

a) Select the File menu function Save. 

The Save dialog box appears. 

Note that the current waveform name, Triangle, shows up as 
the default for the SaveFile Name edit box. 

b) Enter TRl in the Save File Name edit box. 
Select the ADlFFile check box. 
Use the default extension of ADF. 
Deselect the Instrument Specific File check box, if it's 
checked. 
Deselect the Make Backup check box, if it's checked. 
Use the default Offset of 0. 
Select OK. 

File TRI.ADF is now saved. 

c) Select the Edit menu function Clear Waveform(s). 
Select TRIANGLE.ADFfromthe list box. 
Select OK. 

File TRIANGLE.ADF is now cleared from WaveWriter 
memory. 
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d) Select the File menu selection Open. 
Double-click on TRI.ADF to open it. 

Note that this time you are not warned that the clock rate is 
different since we changed it. 

Step 7: This step is not necessary, but it does show you how to send 
Send the waveforms to the a single waveform to the VX5790. If you wish you may skip to 

VXI VX5790 AWG step 8. 

a) Select the Transfer menu function Send. 

The VX5790 Waveform SaveISend dialog box is displayed, 
as shown in Figure 4-28. 

Dialog Box O ~ e t w e e n  Markers -. 
- -  . 

a ~ n t i r e  Waveform 

0 ~ i n a r y  Format 
Hexadecimal Format 

Not D i v  by E i g h t  

0 Us<+ t .rc?xt.  &.it r.gt?r. 

[X l lnc lude  Imbedded nddresses 

O ~ o w n l o a d  Packet and Execute ...... ~ .................................... .... ...... . ......, 
@ 2!ownl.~?ad .... Pack.eti 

Packet  Index: 113 1 

Offset: I o u 

Select "Download Packet" radio button. 

Accept the defaults to send the entire waveform in hexa- 
decimal format with imbedded addresses included to the 
next available packet index. The Not Div by Eight group box 
is displayed because the waveform is not divisible by eight (a 
VX5790 hardware requirement). Use next Smaller is the only 
option since you are sending the entire waveform. The last 
few points of the waveform will not be sent. 

b) Select OK. 

Note: 'Ynclude Imbedded Addresses" is hidden if you are running Wave 
Writer on a M530/35 or W530/35. 
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Step 8: 
Build the sequence of waveforms 

a) Select the Create menu function Sequence. 

The Sequence dialog box is displayed (see below). 

b) Double-click on PULSE.ADF in the WaveformFiles list box. 

This brings the waveform name into the Edit Area with a 
default repetition count of 1. The clock rate for the waveform 
is also displayed in the Edit Wfm Clock group box. 

c) Enter "3" in the Reps edit box to change the repetition count 
to 3. 

d) Select the Append command button to append the informa- 
tion in the EditArea into the Sequence List. 

e) To make the next entry in the Sequence List box: 
Double-click on SINE.ADF in the Waveform Files list box. 
Enter " 4  in the Reps edit box. 
Select the Append command button. 

f) To make the next entry in the Sequence List box: 
Double-click on PULSE.ADF in the Waveform Files list box. 
Enter " 6  in the Reps edit box. 
Select the Append command button. 

g) To make the next entry in the Sequence List box: 
Double-click on TRI.ADF in the Waveform Files list box. 
Enter 2 in the Reps edit box. 
Select the Append command button. 

Note that you are selecting TRI.ADF and not TRIANGLE.ADF 
because all waveforms specified in the sequence must have 
the same clock rate. Otherwise you would be warned when 
you tried to save or send the sequence that one or more file 
had different clock rates. 
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h) To make the next entry in the Sequence List box: 
Double-click on SINE.ADF in the Waveform Files list box. 
Select the Append command button. 

The dialog box should now appear as shown in Figure 4-29. 

Figure 4-29. 
Sequence Editor Dialog Box. 

Step 9: 
Save the sequence you created 

and send it to the instrument 

Seauence L i s t :  

Sequence Parameters 

' E d i t  Brea Reps: 
Clock: 

781.25K Hz 
D:\UU\SINE.RDF 1.2811 Sec 

- 

a) Select the sequence editor File menu function Save. 

The Save dialog appears. 

b) Enter "lesson5" in the Save File Name edit box. 

c) Select the check box for WaveWriterFormat. 
Deselect the check box for Instrument Specific File. 
Deselect the check box for Make Backup. 
Select OK. 

The sequence file is then saved. 

d) Select Send. 

The VX5790 Sequence SaveISend dialog box is displayed, 
as shown in Figure 4-30. 
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Figure 4-30. 
VX5790 Sequence Save/Send 

Dialog Box. 
O ~ i n a r y  Format 
e ~ e x a d e c i m a l  Format 

Sequence Index: 101 
H l n c l u d e  Imbedded Addresses 

[ X I ~ e n d  Execute  Command 
................................................................................................... ., 

misend Sequence and Packets!  
.......................................................................... ....................... 

O ~ e n d  Sequence Only 

I(?) [(Cancel) (Yelp) 

e) Select "Send Sequence and Packetsn-Select OK. 

Each packet is read from the disk and sent to the AWG. 

The sequence is then sent to the default sequence index loca- 
tion and the sequence is executed. If you have the AWG con- 
nected to a scope, you will see the resulting waveform. 

Step 10: 
Modify the sequence 

previouslycreated 

a) Move TRI.ADF to the top of the Sequence List and change 
the repetition count to 3 using the following steps: 

Click on TRI.ADF in the Sequence List. 
Select the Cut command button. 

This brings TRI.ADF into the Edit Area and removes it from 
the Sequence List. 

Enter "3" in the Reps edit box. 
Click on PULSE.ADF at the top of the Sequence List. 
Select the Insert command button. 
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b) Change the repetition count for the first PULSE.ADF in the 
Sequence List to 2. 

Click on the first PULSE.ADF in the Sequence List. 
Select the Copy command button. 

This copies the PULSE.ADF entry into the Edit Area. 

Enter "2" in the Reps edit box. 
Select the Replace command button. 

This replaces the PULSE.ADF entry with the new information 
in the Edit Area. 

c) Remove the last entry in the Sequence List. 

Click on the bottom SINE.ADF. 
Select the Cut command button. 

This removes the entry from the Sequence List. 

The Sequence Editor dialog box should now appear as 
shown in Figure 4-31. 

Figure 4-31. 
Sequence Editor Dialog Box. 

Sequence Parameters 
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Step 11 : 
Save the new sequence and 

send it to the instrument 

a) Select the sequence editor File menu function Save. 

The Save dialog appears. 

b) Enter "lesson5b in the Save File Name edit box. 

c) Accept the previous defaults and select OK. 

The sequence file is then saved. 

d) Select Send. 

The VX5790 Sequence SavefSend dialog box is displayed. 

e) Enter "1 " in the Sequence index edit box.. 

f) Select "Send Sequence Only" and select OK. 

The sequence is then sent to sequence index 1 and the se- 
quence is executed. Notice the difference in the waveform 
generated. 

Note: The packets have already been send to the A WG and don't have to 
be sent again. 

g) Select CANCEL to exit the Sequence Editor. 

Wave Writer USERGUIDE 



I Tutorial 

4-46 Wavewriter USERGUIDE 



Section 5 
How to use FILE OPERATIONS 

What the File Menu The File menu accesses commands that: 

Does 
Create and open waveform files in memory: New and Open. 

H Store waveform files on disk: Save. 

H Output the current waveform display to a printing device: 
Hardcopy. 

H End the WaveWriter session: Exit. 

Identify the installed version of WaveWriterAbout. 
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New New is used when you need to design a waveformor envelope using 
the drawing tools in the Draw menu. When New is selected the dialog 
box in Figure 5-1 appears. 

Figure 5- 1. 
New 

Dialog Box. 

@ ~ o r n a l  gaueform 

(7) (rclp) 

Waveform Name In this edit box, enter a name for the waveform about to be created. 
The 8 character filename and a 3 character extension can be any com- 
bination of characters that is acceptable to the DOS system. A file 
name extension is not necessary, since it will be automatically ap- 
pended when the waveform is saved to a disk file. If you choose to add 
a file name extension at this time, there are some things to consider. Al- 
though you are free to use any three DOS-acceptable characters for 
the extension, there are some combinations (see Save for descrip- 
tions) that we recommend be used. 

Record Length In this edit box, enter the length of the waveform. You can specify 
either Pointsor Seconds. The minimum length is two points, and the 
maximum length is dependent on available memory, however, Wave 
Writer can display only up to 32767 points. If Seconds is selected, the 
number of points is based on the current system clock rate. 

Type This group box lets you select the basic file type to create. You can 
create a Normal waveform or an Envelope waveform. 

Normal Waveform A "normal" waveform, as far as Wavewriter is concerned, is any non- 
envelope waveform. 

EnvelopeWaveform An envelope waveform is a waveform that simultaneously defines the 
upper and lower limits that another waveform needs to adhere to in 
both the vertical and horizontal direction. 
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OK Select the OK command button to create the new waveform which be- 
comes the current waveform. For normal waveforms, all the points of 
the new waveform are initialized at zero. For envelope waveforms, the 
maximum (upper limit) waveform is set to the maximum value of the 
WaveformDisplayArea; the minimum (lower limit) waveform is set to 
the minimum value of the work area. Envelopes are filled with a 
crosshatch pattern. 

Cancel Select the Cancel command button to abort this function and return 
you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the New dialog box, select the Control-menu box 
and then select Close. 

- 
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Open The Open command retrieves an existing waveform disk file and loads 
it as the current waveform. You can open a file that was created by 
WaveWriter- either in ADlF or instrument-specific format. You can 
also open files created by other systems that use a compatible version 
(.99) of the ADlF format. When Open is selected, the dialog box in Fig- 
ure 5-2 is displayed. 

Figure 5-2. 
Open 

Dialog Box. 

File Name In this edit box, enter the name of the stored waveform to be read. 
You can also use this edit box to specify a subdirectory name and 
thereby change the directory. If you want to limit the size of the list that 
appears in the Files In list box, you can use a ''wild card" entry to 
specify a particular group of files. For example, to list only files having 
a ".WAVW extension, enter: 

I U l lbl  Ul llV I l lC3 II I LI IC U . \ V V M V  DUUUIIGLLUI V Ll Id1 DLdlL WILI I U d l  l U  . -. - I - -  
- . -  - -  , 

have an extension that ends in "R", enter: 

A carriage return accepts your entry and modifies the list box 
accordingly. 
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Files In [path] This list box displays the files in the current directory, or a modified list 
if you have specified a narrower range by using the File Name edit 
box. Highlight the desired file (or drive or subdirectory) in the list. 
Select the OK command button to implement your selection. 

OK The OK command button loads the selected waveform file as the cur- 
rent waveform or updates the list box if a wild card entry was made. If, 
in the FileName edit box, you have specified a non-existent file, you 
are warned and returned to the File Name edit box. If the specified 
filename is the same as a filename already in WaveWritermemory, 
you are given the option of replacing the file in memory or creating a 
file with a different name. 

Data Non-conformance If the parameters of the waveform you are attempting to load don't 
match the target instrument, several things may occur: 

Vertical- If the waveform amplitude exceeds the current axis 
amplitude, the waveform display will be clipped. However, no data is 
lost - use the Autoscalecurrent Waveform command in the Dis- 
play menu to rescale the display. If the waveform amplitude also ex- 
ceeds the range of the target instrument, Autoscalecurrent 
Waveformwill set the vertical axis to the maximum instrument range 
and the portion of the waveform beyond that will be shown clipped. 

Horizontal- If the time per point of the incoming waveform doesn't 
match the system clock rate, you are warned that the clock rates don't 
match and you can choose one of the following solutions: 

H Change the clock rate of the incoming waveform to the 
system clock rate. 

Massage (expand or compress) the incoming waveform 
to maintain a timing match. (See Horizontal Resolution, 
Section 6.) 

Change the system clock rate to match the incoming waveform. 
Note, however, that if there are other waveforms loaded (dis- 
played), their clock rates will be changed, as well (see Change 
Clock Rate, Section 7). If the incoming clock rate is not valid for 
the selected target instrument, this option is grayed and 
unavailable. 

H Cancel the Open command. 
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Offset Offset values externally associated with a waveform are displayed with 
the waveform filename in the WaveformList, but are not used when dis- 
playing the waveform in the WaveformDisplayArea. Displayed 
waveforms are referenced to zero Volts. 

Cancel Select the Cancel command button to abort the Open function and 
return to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the New dialog box, select the Control-menu box 
and then select Close. 

Save The Save command stores the current waveform to the disk file. The 
Savecommand also gives you the means to save the current 
waveform as a different file. 

When Save is selected, the dialog box in Figure 5-3 is displayed. 

Figure 5-3. 
Save 

Dialog Box. 

Save 

Save File Name: c:\wave 3 0 

tt I 
Extension: Format: 

lADrI 0 ADlF 0.99 
ADIF File @ ADlF 1.0 

instrument Specific File VI 

Mukf? Suck3q., 

offset: V 
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File Name In this edit box, enter a new or existing name for the waveform, The 
eight-character filename can be any combination of characters that is 
acceptable to the DOS system. A filename extension is not allowed 
here, since an extension will be automatically appended when the 
waveform is saved to a disk file. (See Extension). If you include a direc- 
tory path as part of the filename, the path will be remembered the next 
time Save is selected. 

File Formats You can choose either or both of two file formats when saving 
waveforms - ADlF and/or Instrument aecif ic File. Select one or both 
of the two check boxes. 

ADlF File The Analog Data Interchange Format (ADIF) is a signal definition for- 
mat that is under development at Tektronix. It is intended to provide a 
common signal storage format that can be read and used by various 
Tektronix instruments. This format will be supported by future 
Tektronix software products and microprocessor controlled instru- 
ments. 

ADlF Format Select either the older ADlF format 0.99 or the newer format 1.0 

TekTMStIPGversion2.0 requires 0.99 

Instrument Specific File This selection saves data in a form that can be read directly by a 
specified instrument. The actual file format varies according to the tar- 
get instrument selected in the Transfer,Configure/Change 
Instrument menu. 

See Appendix C for file format descriptions. 

Extension The default extension for the indicated file type is displayed in an edit 
box. The initial WaveWriterdefaults for these extensions are: 

W .ADF is appended to files written in the ADlF format. 

.ISF is appended to files written in Instrument Specific 
Format. 

If you choose to enter your own filename extension, it will be ac- 
cepted. However, you should note that any implied significance to a 
set of characters is ignored. The format of a file is determined by the 
check box selected, not the extension you append to the File Name. 
For example, you could add the extension ".ADFW to a filename (and 
override a ".ISF" default) - but, il the waveform was saved with the In- 
strument Specific File check box selected, the file will be formatted in 
instrument specific format. 

When you change extension characters, they become the default for 
that file type until you choose to change them again. If you 
create waveforms for different instruments, it would be wise to store 
them in different subdirectories or use different extensions for each in- 
strument. 
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Make Backup With this check box, you choose if backup files are to be kept when a 
waveform is saved (see OK, below). If it is a new waveform, this option 
is grayed. 

Odd~ef Enter the offset value you want to be used externally with this 
waveform. The offset parameter is only used when saving or sending 
data, and doesn't affect the Waveform DisplayArea. The off set you 
specify will be added to the saved file in each of the selected formats: 

ADlF Files - The offset parameter is included in the parameter 
list. 

Instrument Specific Files - Data saved to a file is the same 
data as would be sent to an instrument with the Send command 
in the Transfer menu. 

Remember, offset values externally associated with a waveform are dis- 
played with the waveform filename in the WaveformList, but are not 
used when displaying the waveform in the WaveformDisplayArea. Dis- 
played waveforms are referenced to zero Volts. 

OK When the OK command button is selected, the file specified 
in the File Name edit box is created, written in the format(s) specified 
by check box selection. If the specified File Name already exists, and 
the Make Backup check box is not selected, you are prompted to 
choose if you want to overwrite the existing file(s). 

If the Make Backup check box is selected, existing files are retained, 
with a change to the file name extension. The first character of the 
filename extension becomes the tilde (-) character. The tilde is fol- 
lowed by the first two characters of the old extension. The current 
waveform is then written using the specified File Name. For example, 
the backup file for a file "WAVE2.ADFW is "WAVE2.-AD". 
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VX5790 Save If a VX5790 is the target instrument and the Instrument Specific File is 
selected, another dialog box (Figure 5-4) is displayed when OK is 
selected. 

Figure 5-4. 
VX5790 Wa veformSa ve/Send 

Dialog Box. @ E n t i r e  gave form 

0 ~ i n a r y  Format 
(O Hexadcoinal  Fornat  

m l n c l u d c  Imbedded Addresses  

Packet  Index,  1 1 3 1  

ProcessingRegion - Select how much of the length of the 
waveform is to be saved: 

Only the portion of the waveform between and including the 
markers 

H The entire waveform. 

If the number of points saved is 2048 or less, data is saved with the VXI 
SHAPE command. Otherwise, the CURVE command is used. Only 
waveforms less than or equal to 2048 points may be used in a se- 
quence. 

TransferFormat -Select whether the waveform is to be saved in Bi- 
naryor Hexadecimal format. Binary data is more compact, but is not 
directly viewable. 

Not Divisible by Eight -This group box is only displayed when the 
number of data points to be saved is not a number divisible by eight 
(this is a VX5790 hardware requirement). 

H If Between Markers has been selected, you can choose UseNext 
Largerto save the next larger size waveform that is  divisible by 
eight -or you can choose Use NextSmallerto save the next 
smaller size waveform divisible by eight. 

H If EntireWaveform has been selected, Use Nextsmaller is your 
only option - Use Next Larger is grayed and can't be selected. 



save 1 
Include Imbedded Addresses - When saving a waveform for a 
VX5790 using a VXI resource manager that understands imbedded ad- 
dressing (such as the Tektronix VX5520), select this check box and the 
logical address defined in the ConfigurelChangelnstrument com- 
mand is included in the parameters saved. If this check box is not 
selected, the waveform is saved without specifying the logical address. 

Packet Index - This edit box displays the packet index taken from 
the cross reference file. If you wish to override this default, enter a dif- 
ferent value. 

Sequencelndex -This edit box is normally hidden, but is displayed 
when the waveform size is larger than the maximum packet size (2048 
for the VX5790). These waveforms are partitioned into acceptable pack- 
et sizes and a sequence is automatically created that includes the 
packets used when the waveform was partitioned. 

Packets start at the specified Packetlndex and the sequence is built at 
the specified Sequence Index. 

OK- When OK is selected, the VX5790 waveform data is saved. 

Cancel -Select the Cancel command button to exit the Save com- 
mand and return to the main menu. 

Help - Select the Help command button to display informative text 
relating to this operation. Use the scroll bar, if present, to read the en- 
tire help text. To return to the Save dialog box, select the Control- 
menu box and then select Close. 

Cancel Select the Cancel command button to exit the Save command and 
return to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Save dialog box, select the Control-menu box 
and then select Close. 
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Hardcopy The Hardcopy command sends the current WaveformDisplayArea to 
a selected printer or plotter. When Hardcopy is selected, the dialog 
box in Figure 5-5 is displayed. 

Figure 5-5. 
Hardcopy 

Dialog Box. 

IHP P l o t t e r  I I 

IPRD f i l e  driver M 

Printers This list box displays the currently installed output device drivers. High- 
light and select an output device from this list. To install additional 
printers, see the Windows User Guide. 

Configure When this command button is selected, the WindowsControl Panel 
window is displayed. This window contains a Setup menu which per- 
mits selecting the printer and printer configuration. See your Microsoft 
Windows Users manual for more detailed information. 

OK When the OK command button is selected, the current WaveformDis- 
playArea is sent to the selected printer or plotter. While the data is 
being sent, a Cancel Print dialog box appears to let you terminate the 
print or plot before it is completed, if necessary. 

Cancel Select the Cancel command to abort the Hardcopy function and 
return to the main menu. 

Help Select the Help command button to display informative text 
relating to this operation. Use the scroll bar, if present, to read 
the entire help text. To return to the Hardcopy dialog box, select the 
Control-menu box and then select Close. 
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Exit 

Exi f The Exit command ends the Wavewritersession and returns you to 
the Windows MS-DOSExecutive screen display. If any data has been 
altered, you are prompted to save it before exiting. The current Wave 
Writer configuration is saved. 

About The About command displays a dialog box (Figure 5-6) that lists: 

The name of this program, WaveWriter 

Version number. 

Tektronix copyright. 

Available memory. 

When the About dialog box OK command is selected, you are 
returned to the main menu. 

Figure 5-6. 
About 

Dialog Box. 

WaveWriter CTM) 
Version 1.1 

Copyrisht  @ 1989. 1990 by Tcktronix.  

Memory A v a i l a b l e  143 Kbytes 

(X) 
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Section 6 
How to EDIT WAVEFORMS 

What the Edit When you need to make changes to the current waveform, you can 
often use Draw menu functions to alter the shape of a waveform. How- 

Menu Does ever, there are features of the Edit menu that can modify the content 
of a waveform without redrawing: 

H Undo - cancel the most recent change to the current waveform 
made by any of the menus. 

H Clear Waveform(s) - delete all or selected waveforms from 
memory and the WaveformList. 

Cut Between Markers - remove part of the current waveform; 
save the segment in the edit buffer. 

Copy Between Markers - copy part of the current waveform; 
save the segment in the edit buffer. 

H Delete Between Markers - delete part of the current waveform; 
do not save the segment. 

H Insert at Start Marker - insert a copy of the edit buffer into the 
current waveform. 

W Replace Between Markers - delete a part of the current 
waveform and insert a copy of the edit buffer in its place. 

Append to End of Waveform - insert a copy of the edit buffer 
at the end of the current waveform. 

H Flip Horizontal Between Markers - reverse current waveform 
time sequence. 

Flipvertical Between Markers - invert the current waveform 
with zero as the center. 

H HorizontalResolution - expand or compress the current 
waveform horizontally. 

VerticalResolution - modify waveform data to simulate a lower 
vertical resolution. 
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Undo The Undo function cancels the most recent change to the current 
waveform. The change could have been made by any of the other 
menus (Edit, Draw, Create, Acquire, etc.). If the current waveform has 
not been changed, the Undo command option is grayed in the menu. 
Undo toggles -you can undo an undo. 

Clear Waveform(s) The ClearWaveform(s) command removes specified waveforms from 
memory. This deletes unwanted waveforms from the display -either 
those that are no longer needed, or to unclutter a display that has too 
many background waveforms. When Clear Waveform(s) is selected, 
the dialog box in Figure 6-1 is displayed. 

Figure 6- 1. 
Clear Waveformfs) 

Dialog Box. 
S e l e c t  Waveforms t o  C l e a r  f r o m  Memory 

RNSWER1 .BDF 

CH1ENU.BDF 

SINE8192 .RDF 



I Clear Wave form(s) 

Select Waveforms to This list box displays all the currently loaded waveforms. 

Clear from Memory 
To clear one or more waveforms from the display: 

CAUTION: Cleared waveforms cannot be undone. Be sure to 
save changes you wish to keep before clearing. 

. .,. 

: ..,,. ... Press r(JFrl or loowN] to highlight a 
..A 

waveform to be cleared. Press 
I to clear the waveform from .'.'. ... ..... 

.i:i ..... memory. 
..... ..:. ..,.. ..... ..... .:.:. 

If you want to clear more than one 
waveform, press and hold the 

key while pressing or 
to highlight additional 

waveforms. Press the (SPACE- to 
unselect (or reselect) each additional 
waveform. 

Press [ENTEA1 to clear the selected 
waveforms from memory. 

Move the cursor to the name of the 
waveform to be cleared. Press the 
LEFT mouse button to select the 
entry. 

If you want to clear one or more 
additional waveforms, move the 
cursor to additional entries and 
press and hold the [SFmr] key 
while pressing the LEFT mouse 
button to accept each additional 
waveform without unselecting pre- 
vious choices. 

. . ... ... ... . . 

... . . ... Click the OK button to clear ... 
. . .  . . .  ... ... . . .  ... ... . . .  ... ... . . .  selected waveforms. 

Double clicking the LEFT mouse 
button while selecting a waveform 
name is the same as following the 
selection with the OK command 

All Waveforms When AllWaveforms is selected, all waveforms are removed from the 
display and cleared from memory. If any altered waveforms have not 
been saved, you are given the option to save them and the Save 
dialog box is displayed. 

OK When the OK command button is selected, highlighted waveforms are 
removed from the display and cleared from memory. If any altered 
waveforms have not been saved, you are given the option to save 
them and the Save dialog box is displayed. 
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Cut Between Markers I 
Cancel Select the Cancel command button to abort the Clear Waveform@) 

function and return to the main menu. 

Help Select the Help command button to display informative text 
relating to this operation. Use the scroll bar, if present, to read 
the entire help text. To return to the Clear Waveform(s) dialog box, 
select the Control-menu box and then select Close. 

Cut Between When cut Between Markers is selected, the region of the 
current waveform between and including the Startand Stopmarkers is 

Markers removed and stored in the edit buffer. The Stop Marker, and the data 
to its right, is shifted to the left to align with the StartMarkerposition. 

The Edit Buffer Information in the edit buffer can be pasted into another waveform by 
selecting a different current waveform and using Insert at Start 
Marker, Replace Between Markers, or Append to End of Waveform. 
The edit buffer data is available for multiple insert, replace, and append 
operations, but is replaced when another cut or copy command is 
selected. 

COPY Between When Copy Between Markers is selected, the region of the current 
waveform between and including the Startand Stop markers is copied 

Markers to the edit buffer for later use. The current waveform is not changed. 

Delete Between When Delete Between Markers is selected, the region of the current 
waveform between and including the Startand Stopmarkers is 

Markers removed~ The deleted waveform segment is not saved in the edit buff- 
er. The Stop Marker, and the data to its right, is shifted to the left to 
align with the StartMarker position. 

Insert at Start When Insert at Start Marker is selected. a copy of the waveform data 
in the edit buffer is inserted into the current waveform at the Start 

Marker Marker location. Waveform data at the StartMarker, and to the right, is 
moved to align with the end of the inserted data. This may extend the 
current waveform beyond its originally defined length. 
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Replace Between Markers 

The distance between the markers can't exceed the maximum record 
length of the target instrument. If the length of the edit 
buffer being inserted would cause the Stop Marker to go beyond this 
limit, the Stop Marker is moved only to the maximum 
distance allowed. 

Replace Between When Replace Between Markers is selected, a copy of the waveform 
data in the edit buffer replaces the current waveform between and in- 

Markers cluding the Start and Sop markers. If the edit buffer data is longer 
than the segment being replaced, the current waveform will extend 
beyond its originally defined length. If the edit buffer data is shorter 
than the segment being replaced, the current waveform is shortened. 

The distance between the markers can't exceed the maximum record 
length of the target instrument. If the length of the edit buffer would 
cause the Stop Marker to go beyond this limit, the Stop Marker is 
moved only to the maximum distance allowed. 

Append to End of When Append to End of Waveform is selected, a copy of the 
waveform data in the edit buffer is appended to the end of the 

Waveform current waveform after the last data point. This extends the 
current waveform beyond its originally defined length. 

Flip Horizontal When Flip Horizontal Between Markers is selected, the timing of the 
current waveform between and including the Start and Stop markers 

Between Markers is reversed. What was the start of the waveform segment is now the 
end, and what was the end is now the beginning. 

Fl i D Vertical When Flip Vertical Between Markers is selected. the ~ l a r i t y  of the 
current waveform between and including the Start and Stop markers 

Between Markers is inverted around zero Volts. 
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Horizontal Resolution 

HOrlzOnfal  The portion of the current waveform in the processing region can be 
expanded or compressed along the horizontal axis. When Horizontal 

Resol' jon Resolutionis selected, the dialog box in Figure 6-2 appears. 

Figure 6-2. 
HorizontalResolution 

Dialog Box. 

I n t e r u a l  Betueen Markers: Stop - S t a r t  = 

ww l n t e r u a l :  -IO - 
Points  

Transform Method: O r i g i n a l  Data t o  New Data 

O S h o r t  Function: General Purpose 

@ y e s  (Where l u a i l a b l e )  

[nr] Hrlp] 

Processing Region In this group box, you select how much of the length of the waveform 
is to be affected by the horizontal resolution change: 

The entire waveform. 

Only the portion of the waveform between and including 
the markers. 

CU rrenf Le ng t h When EntireWaveform is selected, the Current Length of Waveform dis- 
of Waveform play shows, in points and seconds, the total length of the current 

waveform. 
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I Horizontal Resolution 

CU rrent Interval When Between Markers is selected, the Current IntewalBetween 
Bemeen Markers Markers display shows, in points and seconds, the length of the cur- 

rent waveform segment between and including the markers. 

New Interval In this edit box, enter the new length you need either the entire 
waveform or the marked segment to be. Select either Points or 
Seconds. 

Transform Method There are three methods to choose from when you redefine the 
horizontal interval - Nearest Related Point, Short Function, and 
Longer Function. Figure 6-3 approximates what happens when a 
sinewave is transformed with each of these methods. 

Figure 6-3. 
Three Results of a 

Sinewa veTransforma tion. 

A B C 

Nearest Short Longer 
Related Point Function Function 

Nearest Related Point This is the fastest method of redefining the horizontal interval. Each 
newly assigned point is given the value of the original point that was 
closest to it horizontally. This method preserves steps in the original 
waveform. Figure 6-3A shows where data points may be selected from 
using this transform method. 

Short Function This is the standard speed, general-purpose method. The Short Func- 
tion calculates each new point using a weighted average of original 
points to either side. The weighting function shape is triangular, linearly 
decreasing as you move away from the new point location. When a 
waveform interval is increased (i.e., more points) the Short Function 
translates to linear (straight line) interpolation. In other words, the new 
point is located on a straight line between two original points (as 
shown in Figure 6-38). When the new interval is decreased, or 
decimated, (i.e., fewer points) the triangularweighted average spans 
four or more original points to calculate each new point. Greater 
decimation ratios require wider averaging functions. 
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Horizontal Resolution I 
LongerFunction This method is much slower than the other two methods, but it 

is the most accurate for smoother, band limited signals (i.e., sine 
waves). Like the Short Function, this method calculates each new 
point with a weighted average of original points to either side. This 
weighting function is up to five times as wide as the triangular Short 
Function. When increasing intervals (interpolating), the weighted 
average spans ten points, five on each side. When decreasing intervals 
(decimating), the point span of the average is ten times the ratio of 
original to new interval lengths. The weighting function shape sinc func- 
tion (s in (~) /x )~  has been windowedb to limit its length. Sine waves with 
at least four points per cycle can be accurately interpolated using the 
Longer Function (as shown in Figure 6-3C), with errors less than O.lO/o. 
Similarly, reducing a sine wave interval down to as few as four samples 
per cycle results in errors less than 0.1%. 

Use Data Beyond When LongerFunction is selected (and also Short Function when 
Markers compressing a waveform) - to minimize distortion at the end points 

of the waveform, the transformation calculation needs data points out- 
side the limits of the Start and Stop markers. This is allowed when you 
select the Yesoption button. If the markers are at the ends of the 
waveform, extrapolated data points will be calculated. If you don't wish 
external data points to be used, select the No option button. This 
group box is grayed (not available for selection) when Nearest Re- 
lated Point is selected. 

OK When the OK command button is selected, the Processing Region is 
resized to the new length. The overall current waveform will lengthen 
or shorten accordingly. 

Cancel Select Cancel to abort the HorizontalResolution command and 
return to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the HorizontalResolution dialog box, select the 
Control-menu box and then select Close. 

NOTE Changing horizontal resolution does not change 
clock rate. 

'The sinc is the ideal interpolation function for sampled band limited (non-aliased) signals. 

b~ 3-term (-67dB) Blackman-HarrisC window spanning the fifth zero crossing on either side of the main sinc lobe. 

'Harris, F. J., On the Use of Windows for Harmonic Analysis with the Discrete Fourier Transform, Proceedings of the IEEE, 
Vol. 66, No. 1, Jan 1978. 
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Vertical Resolution 

Vertical Resolution The current waveform data can be adjusted to simulate a lower num- 
ber bit level in the vertical axis. When VerticalResolution is selected, 
the dialog box in Figure 6-4 appears. 

Simulated Step Resolut ion:  [I B i t s  - 

Figure 6-4. 
VerticaiResolution 

Dialog Box. 

processing Region 

@ E n t i r e  Waveform 

OBetween Markers 

Current  Wauef orm Step Resolution: 12  B i t s  

Current Waveform The Current WaveformStepResolution display shows, in bits, the cur- 
Step Resolution rent waveform step resolution. 

Simulated In this edit box, enter the new vertical resolution you need the 
Step Resolution current waveform data to have. This number has to be less than the bit 

resolution of the current waveform. 

NOTE Once the bit level has been changed, it can't be 
returned to a higher level resolution. The previous 
waveform data can P be recovered. Always save the 
higher bit level waveform if the data needs to be 
retained. 
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Vertical Resolution 

P ~ O C ~ S S ~  ng Region In this group box, you select how much of the length of the waveform 
is to be affected by the vertical resolution change: 

W The entire waveform. 

Only the portion of the waveform between and including the 
markers. 

OK When the OK command button is selected, the Processing Region is 
rescaled to the new bit levels. 

Cancel Select Cancel to abort the VerticalResolution command and return 
to the main menu. 

Help Select the Help command button to display informative text 
relating to this operation. Use the scroll bar, if present, to read 
the entire help text. To return to the VerticalResolution dialog box, 
select the Control-menu box and then select Close. 



Section 7 
How to DISPLAY WAVEFORMS 

What the Display YOU use the Display menu to set the attributes of the screen presenta- 

Menu Does tion: 

W You can display waveforms in either dot or vector format. 

You can magnify a portion of the WaveformDisplayArea with 
the Zoom In feature. 

W With the Set AxisRanges command, you can control how much 
of the current and background waveforms is visible. 

You can Autoscale the WaveformDisplayArea to fit the current 
waveform. 

H Change Clock Rate. Allows you to change the system clock rate. 

You can select a different waveform with Change Current 
Waveform 

H You can select the screen cursor to be displayed as either a 
small cross or as full-screen crosshairs. 

You can modify various features of the screen display with the 
Set Colors and Line Styles command. 
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Displa yForma ts 

Display FO t'm ats Waveforms can be displayed in either dot or vector format. 

Redraw Dot When Redraw Dot is selected, all displayed waveforms are 
redrawn in dot format - each dot represents a data point of the 
waveform. 

Redraw Vector When Redrawvector is selected, all displayed waveforms are 
displayed in vector format - all points are connected with the 
currently selected line style. 

The Zoom FU ncti0n A portion of the display can be magnified in the waveform workspace. 

Zoom In allows you to define a rectangular region that will be enlarged 
to the full display size. You can Zoom In again to expand the wave- 
form even farther. Use Zoom Out to return to the standard view. 
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I The Zoom Function 

 ZOO^ In When Zoom In is selected, you can define a rectangular area that 
delimits the portion of the display to be magnified: 

Use the direction keys to position the 
cursor at the upper left corner of the 
rectangular area to be magnified. 

. .,. . . .. :. . . .  When the cursor is at the correct start- ... ... ,.:. 
id .  ... ing point, press either ..... I:::: 

-or-. 
..:.: 
.::j: 
3;:; ..:. ... :. .... 
. . .  

With the direction keys, position the ..... ..... ... 
.:.:. .... 

cursor at the lower right corner of the 
..A, 

rectangular area. .... . :. 
. :. ..... 
/. ... 

..... ..... ..... ..... To set the dimensions and magnify ..... ..... ..... .... 

..... the selected portion of the display, ..... ..... ..... ..... 

..... ..... 
press either .... ..:. ..> 

Move the cursor to the upper left 
corner of the rectangular area to 
be magnified. 

:.... 

Press and hold the LEFT mouse ..,.. 
.A:. ..... ..I:. 

.::.: ..:. 
button and drag the cursor to the i: ..... ... :. 
lower right comer of the rectan- .::.: ..:. ::::: ..:. ..:. 
gular area. ... .:.:. .:.:. 

:.: .>:. ..... 
:.::. 

To set the dimensions and magnify r:. 
.. the selected region, release the :. 
.:.I ... 
..... .:.: 

LEFT mouse button. ..:.: .:.: 
... ..... ..... ..... . . .  ..... 

 ZOO^ Out Selecting Zoom Out restores the display to the unmagnified waveform 
- the view as defined by the Set Axis Rangescommand. 
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Set Axis Ranges 

Set Axis Ranges set ~ x i s ~ a n g e s  sets the ranges for the vertical and horizontal axis 
scales of the waveform display. This selects a portion of the 
overall waveform to be displayed. Parts of waveforms outside the 
WaveformDisplayArea are clipped, not lost, and can be restored by 
setting a wider range in the Set Axis Ranges dialog box. 

When Set Axis Ranges is selected, the dialog box in Figure 7-1 ap- 
pears. 

Figure 7- 1. 
Set Axis Ranges 

Dialog Box. 

Verfical Vertical units (amplitude) is entered in peak-to-peak Volts. For 
example, if you enter "5" the vertical scale will read from -2.5 Volts to 
+2.5 Volts. This number must be less than or equal to the maximum 
peak-to-peak amplitude allowed by the target instrument. This range is 
mapped to the full vertical resolution of the target instrument. 

Uert ical  

A ~ l i t ~ d e :  
(Pk-pk) 

Horizontal Horizontal units can be either Seconds or Points. Figure 7-1 shows the 
"Point$' option button selected. The Startand Stopedit boxes define 
the horizontal limits of the portion of the Waveform DisplayArea to be 
displayed. Since Pointsis selected in Figure 7-1, the units describing 
the edit boxes is "Pts". If Seconds was selected, "Secn would be dis- 
played. 

-Horizontal 

0 Seconds 

@ e o i n t s  

Sfop: rTii--1 P t *  

The units you select with this group box (Seconds or Points) 
affects the horizontal axis label, the Startand Stopmarker readouts, 
and the X coordinate readout. 
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I Autoscale Current Waveform 

OK When OK is selected, the vertical and horizontal axis scales are reset 
to the ranges you have specified. 

Cancel Select the Cancel command button to abort the Set AxisRanges 
command and return to the main menu. 

Help Select the Help command button to display informative text 
relating to this operation. Use the scroll bar, if present, to read 
the entire help text. To return to the Set AxisRanges dialog box, 
select the Control-menu box and then select Close. 

AU toscale Current When YOU select ~utoscalecurrent waveform. it automatically ad- 
justs the horizontal and vertical axis scales on the WaveformDisplay 

Waveform Areato match the amplitude and the length of the current waveform. 
See Figures 7-2 and 7-3. 

If the largest peak amplitude of the waveform exceeds the maximum 
amplitude of the target instrument, the vertical axis scale is set to the 
maximum peak-to-peak amplitude of the target instrument; waveform 
data will be clipped on the display, but not lost. 

Figure 7-2. 
Waveform Before Autoscaling. 

Figure 7-3, 
Waveform A fterAutoscaling. 
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Change Clock Rate I 

Change Clock Rate This command is used to change the system clock rate. AII waveforms 
in memory have the same clock rate - changing the clock rate affects 
all waveforms. The waveform shape or size (number of points) is not 
changed by this command -only the time per point and the 
WaveformDisplayArea axis labels are changed. The clock rate 
selected must be valid for the target instrument. 

When Change Clock Rate is selected, the dialog box that 
appears depends on the selected target instrument. Figures 7-4 
through 7-6 show the dialog boxes for the currently supported 
instruments. 

When the new clock rate is entered and OK is selected, the Clock dis- 
play above the WaveformDisplayArea is updated to show the new 
clock rate. If the horizontal axis is displayed in seconds, the labels are 
updated to reflect the new clock rate. 



Change Clock Rate 

AFG 51 01 15501 When Change Clock Rate is selected and an AFG 51 0115501 is 
Clock Rate selected as the target instrument, the dialog box in Figure 7-4 

appears. 

Figure 7 4  
AFG 5101/5501 

Change Clock Rate 
Dialog Box. 

1 - Time p e r  Point :  (1 S 

Time per Point Enter Time in seconds. The valid range is 100 nanoseconds to 999.9 
seconds. 

Frequency Enter Frequencyin Hz. The valid range is 10 MHz to 1 mHz. 

OK When the new clock rate is entered and OK is selected, the Clock dis- 
play above the WaveformDisplayArea is updated with the new clock 
rate. If the horizontal axis scale is displayed in seconds, this also will 
be updated. 

Cancel Select cancel to retain the previous clock rate and return to the main 
menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Change Clock Rate dialog box, select the Con- 
trol-menu box and then select Close. 



Change Clock Rafe I 
2400 Series DSO When Change Clock Rate is selected and a 2400 Series digital 

Clock Rate storage oscilloscope is selected as the target instrument, the dialog 
box in Figure 7-5 appears. 

Figure 7-5 
2400 Series DSO 

Change Clock Rate 
Dialog Box. 

Enter  ONE o f  t h e  f o l l o w i n g :  

Time Per D i v i s i o n :  

T j m p  p e r  p o i n t  : T I  s 

1-1 P o i n t s  / Second 

0 E x t e r n a l  Clock 

Time per Division Enter time in seconds. If no external clock is present, the valid values 
are (in a l , 2 , 5  sequence): 

2440 only: 5 seconds to 2 nanoseconds. 

All other 2400 Series DSOs: 5 seconds to 5 nanoseconds. 

If an external clock is present, the valid values are: 

50 microseconds to 500 nanoseconds. 

Time per Point Enter time in seconds. If no external clock is present, the valid values 
are (in a 1 , 2 , 5  sequence): 

2440 only: 100 milliseconds to 40 picoseconds. 

All other 2400 Series DSOs: 100 milliseconds to 
100 picoseconds. 

If an external clock is present, the valid values are: 

1 microsecond to 10 nanoseconds. 
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I Change Clock Rate 

Frequency Enter the number of points per second. If no external clock is present, 
the valid values are (in a 1 ,2 ,5  sequence): 

2440 only: 10 pointdsecond to 25 gigapoints/second. 

All other 2400 Series DSOs: 10 pointdsecond to 
10 gigapointsfsecond. 

If an external clock is present, the valid values are: 

External Clock In this check box, select if the scope is using an external clock. 

OK When the new clock rate has been entered and OK is selected, the 
clock rate is checked to see if it is within appropriate limits. 
If you are not using an external clock, and the selected clock 
rate is not a "1,2,5" sequence value, you are offered a choice be- 
tween the next higher and lower valid values. When a valid value is 
entered, the Clock display is updated with the new clock rate in both 
timeldivision and timetpoint. If the horizontal axis scale is displayed in 
seconds, its range is updated to reflect the new clock rate. 

Cancel Select Cancel to return to the main menu without changing the clock 
rate. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Change Clock Rate dialog box, select the Con- 
trol-menu box and then select Close. 
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Change Clock Rate 

VX5790 Clock Rate When Change Clock Rate is selected and a VX5790 is selected as the 
target instrument, the dialog box in Figure 7-6 appears. 

Figure 7-6 
VX5790 

Change Clock Rate 
Dialog box. 

-Master Clock 

O l n t e r n a l :  10 nSec 

0 E x t e r n a l :  71 Sec 

Nea fixf: Rate  

Selected SecIPoint :  1 . 2 8 ~  s 
Selected Frequency: 781.25K Hz 

TimeIPoint This is a list of available clock rates for the internal master 
system clock, either internal or external. 

Master Clock Either the internal master clock can be selected or an external clock. 
INTERNAL: A fixed time per point of 10 nanoseconds. 
EXTERNAL: Enter the time per point of the external clock. 

Use New Ext Rate When the external clock rate is changed, this command button is 
selected to recalculate the valid clock rates in the TimeIPoint list box. 
This selection is grayed if Internal is selected. 

Selected SecIPoint Selected clock rate expressed as seconds per point. 

Selected Frequency Selected clock rate expressed as frequency. 
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I Change Current Waveform 

Change CU rren t Displays the WaveformLht. This is handy when the Wavewriter 
window is maximized and you can't easily get to the WaveformList 

Waveform icon. See WaveformList, Section 3, for more information. 

Show C~OSS ha i r~ The screen cursor can be displayed either as a small cross or as a full- 
screen crosshair. Selecting ShowCrosshalrs alternately displays a 
small cross or crosshairs. In the menu display, a check mark indicates 
that the crosshairs are currently being displayed. 

The location of the intersection of the crosshairs is shown in the coor- 
dinate readouts, the same way the small cross position is defined. 

Set Colors and Line When there are several waveforms displayed on the screen 

Styles at the same time, it can be difficult to differentiate one waveform from 
another. Various elements of the display can be assigned different 
attributes to help you separate data items and minimize confusion on 
the screen: 

Waveforms in memory can each be assigned a color and a line 
style which are used when the waveform is not current. 

The current waveform can be assigned a color and a line style. 
This temporarily overrides any attributes assigned to an in- 
dividual waveform in memory. 

A color and a line style can be assigned to all background 
waveforms in general. Default attributes are used until you assign 
specific attributes to a waveform. 

Labels and units on the waveform workspace can be 
assigned a color. 

The graph background color can be assigned. 

W The window background can be assigned a color. 

NOTE Select colors with care. If the element or waveform 
color is the same as the background color, it won't be 
visible. If this happens, reselect one or both colors. 
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Set Colors and Line Styles I 
When Set Colors and Line Styles is selected, the dialog box in Fig- 
ure 7-7 appears. 

Figure 7-7. 
S t  Colors and Line Styles 

Dialog Box. 

Colors and S t y l e s  

Select ions 

Current Wauef o r n  

Labels h U n i t s  .:.:. 

Graph Background . . . . . . 
Background .:.:. ..... 

.:.:. 
.... . . . 

I__- ,.-1L.- 

L . - I  

sec 

The Sample display shows attributes as they are selected in the Line 
Style and Color group boxes. These changes don't take place in the 
selected item (from the Selections list box) until the OK command but- 
ton is selected. 

Select ions The Selections list box displays what can currently be modified. In ad- 
dition to the currently loaded waveform names, there are several other 
elements of the display to which you can assign attributes: 

Current Waveform 

Background Waveforms 

Labels & Units (color only) 

H Graph Background (color only) 

H Background ( Wave Writer window - color only) 

From the list, select a highlighted item to be modified. 
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I Sef Colors and Line Styles 

Line Styles Select one of the displayed line styles. The selected style is indicated 
with a heavier black border around it. The line style may not be ap- 
parent if there isn't a large enough interval between points. Line style is 
only visible in vector mode. 

C O ~ O ~ S  Select one of the displayed colors. The selected color is indicated with 
a heavier black border around it. 

OK After setting the attributes of each of the entries you want to change in 
the Selections list box, select the OK command to make all your 
changes effective and to return to the main menu. 

Cancel Select the Cancel command to retain your original settings and return 
to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Set Colors and Line Styles dialog box, select 
the Control-menu box and then select Close. 
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Set Colors and LIne Styles 
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Section 8 
How to DRAW WAVEFORMS 

at the Draw The Draw command gives you tools to modify an existing waveform. 
The waveform could have been new, opened, acquired, or created. 

Menu Does The tools are simple to use and can help you create precise and 
repeatable waveform segments. Selections in the Draw menu are: 

Nodraw- the initial state. 

Freehand - a waveform segment is defined by all movement of 
the cursor. 

Horizontal- similar to Freehand, except that a line segment 
can only be defined in a horizontal direction from its start point. 

Vertical- similar to Freehand, except that a point can only be 
moved in a vertical direction from its start point. 

Autoline- a waveform segment is defined by start and stop 
points. 

Envelope Max Don't Care - similar to Horizontal; defines upper 
limit "don't care" voltage acceptance range. 
(Envelope waveforms only.) 

Envelope Min Don't Care - similar to Horizontal; defines lower 
limit "don't care" voltage acceptance range. 
(Envelope waveforms only.) 

Envelope Max -specifies the waveform envelope upper limit to 
be drawn. (Envelope waveforms only.) 

Envelope Min - specifies the waveform envelope lower limit to 
be drawn. (Envelope waveforms only.) 

Only one of the above modes can be selected at a time except that, if 
you're working with a waveform envelope, either Envelope Max or En- 
velope Min are also specified to define the portion of the envelope to 
be operated on. Choosing a mode different than the current mode in- 
itiates the new selection immediately. 
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Starting OU t With a waveform in memory, select the Draw menu. 

Drawing Segments Except for Nodraw, each of the Draw modes works almost the same 
way. You can use either the keyboard or a mouse to draw waveform 
segments. If you use the keyboard - to activate a Draw mode cursor 
arrow, press t h e m  key until the Waveform List is displayed. Then 
p r e s s m  one more time. 

To access the waveform for drawing, the cursor must be within the 
limits of the Waveform DisplayArea. 

CONTROL Kev When moving the cursor with direction keys, pressing the 
1-1 +-~-l keys moves the cursor faster. 

Coordinates Coordinates are continually updated as the cursor moves so you can 
accurately position the cursor. Vertical changes in cursor position 
show as a change in voltage. Horizontal changes in cursor position 
show as a change in time or in points (whichever is selected). 

Screen Redraw When in a drawing mode, to redraw the screen press the RIGHT 
mouse button. 

Nod raw Nodraw tums off the current drawing mode. Nodraw is automatically 
selected when you choose an operation from any other menu. 
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Freehand 

Freehand In this mode, while drawing is enabled, all movement of the cursor is 
tracked for the waveform definition. 

To draw a waveform Freehand: 

... ... 
+; ... TO activate a Draw mode cursor, 
; press the key until the ...... ... 
i3 ... WaveformList is displayed. Then ... ... 
.;c ... ... . . .  press pJ one more time. ... ... ... ...... ... ...... ..,.. 

Use the direction keys to position the 
starting point for the line to be drawn. 

..... . : :. ..:.. ... 

ii:iii . . .  ... ... When the cursor is in the correct start- ... . . .  ... 
: ... ... ... ing point, press either ... 

m o r l - .  ... ... ... ... ... ... ... ... ... ... ... ... ..... ... 
iiiiii ...... ... Press direction keys to extend the .:.:. .:.:. ... 

:.:.: ...... ..... line segment in the desired direction. ... ..... ..... ... ..... .... ..... . . .  ... . . . . .  ... .(. 
. . .  ... ,.. ... ... ...:. ... 

To end the line segment and disable 
drawing, press either 

ISPACEBARlorlENtERI. 

Move the cursor to the desired 
start point for the line segment. 
Press and hold the LEFT mouse 
button to enable drawing. 

. .: ... ... ... ... ...... ...... . . .  . . .  
... . . .  

Move the mouse in the desired 
... ... ... ... ... ... ... 

direction and a line segment fol- 
... ..... ... . . .  ... ... ... ... ... 

lows from the start point to 
... ...... ... ... ... ... ... ... ... ... ... ... 

wherever the cursor moves. 
... ... ... ... ... ... ... ... ... .... ... . .,. When the cursor is at the desired . ,,,,, :( 

:<.: 
end point, release the LEFT mouse 9 ..... 
button to end the line segment and ij. ... ... ... 
disable drawing. ... .... ... 
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Horizontal 

Horizontal This mode is the same as Freehand, except that while drawing is 
enabled, vertical movement of the mouse or direction keys is ignored. 

To draw a horizontal Ilne: 

... .. .., 
i:iiii . . . . . . . . To activate a Draw mode cursor, 
. . . 
iiX ... ... . . . press the key until the ... ... 
iiiiii ...... ... WaveformList is displayed. Then 
3; . . . . . . press one more time. 
. . . 
, :.. . . ., 
. . . . . . ..... ..... 
i;.i Use the direction keys to position the . . . 
. . . 

..... 
. . . . . . ...,. ..... ...,. 

ii;i starting point for the line to be drawn. ...,. ...,, 

. . . . . . 
. .., 

. . . . 
. . . . . ... . . . . . ... ...,. ...., ... 
, '  When the cursor is in the correct start- ..... . ... . ... . ... 

ing point, press either 
-1 or [ENTETrl to enable 
drawing. 

Press direction keys to extend the 
line segment in the desired direction. 
The line only draws in a horizontal 
direction originating from the start 
point. 

To end the line segment, press either 

F ? ! E s E l o r m -  
. . . ... ... . . . 
i:.iii ... . .... Repeat for additional line segments. ... . . . ... . . . ... ::..: 
. . . . . . . . . 
. . . ..... 
. . . . . . .:... 
. . . . . . ... 
. . . . . . :.::: 
. . . ..... 
... .A,. 

.... , . . . . ... 
..I: 

Move the cursor to the desired 
start point for the line segment. 
Press and hold the LEFT mouse 
button to enable drawing. 

Move the mouse in the desired 
direction and a horizontal line seg- 
ment extends from the start point 
to the horizontal position of the cur- 
sor. 

When the cursor is at the desired 
end point, release the LEFT mouse 
button to end the line segment. 

Repeat for additional line seg- 
ments. 



Vertical 

Vertical This mode is the same as Freehand, except that while drawing is 
enabled, horizontal movement of the mouse or direction keys is 
ignored. 

To draw a vertical line: 

.(.: ..:. ..:. ..:. 
$2: :.:.. To activate a Draw mode cursor, 

press the key until the ..... ..... 

2, ..... WaveformList is displayed. Then 
3: ..... press one more time. 
..... ..... ..... ..... ..... .:.:. 

Use the direction keys to position the 
cursor at the point you want to 
change to a different level. 

iji:j ... Press either -1 
j:. 

$, ... or (ENTER to enable movement. 
. . .  ... ... ... ... ... 
;; .... Press direction keys to move the 
:; point in the desired direction. ... 
... ... ... 

To fix the point in the new position, 
press either vq or 
lENrERl 

. ,.. . . .  
Move the cursor to the desired .:. ... 

... ... ... ... 
point to be moved. Press and hold ; ... 
the LEFT mouse button to enable 3 ... ... ... movement. ... ... ... 

... ... .:.:. ..... ... ..... ... . . .  ... . . .  ... ... ... ... ... ... Move the mouse in the desired ..... .:.:. 

... .... ... . . 

... ... . . .  ... 
... ... 

direction and the selected point fol- iiij 
... ... ..... ..... lows the cursor in a vertical direc- 

... 

... ... When the cursor is at the desired gf . . ... ... 
location for the selected point, ... ... 

... 
release the LEFT mouse button. ... 

..... 

... 
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Autoline 

Autoline Autolineis a way to draw a sequence of line segments where the end 
point of a line is the start point of the next line to be drawn (if a con- 
tinuation is desired). Line segments can be drawn at any angle. 

To use Autoline: 

... ..... ... ... 
2 To activate a Draw mode cursor, 
... 

:iiii: ... 
press t h e m  key until the 

;$. WaveformList is displayed. Then 
.:(.: 

ia. ... ... p r e s s m  one more time. 
... ... ... .... 

... .... . . .  ... 
. ... Use the direction keys to position the ... ... ... ... ... 
2. starting point for the line to be drawn. ... 

.:.. 
.... ... .:(. ... ... 

:. . . .  . . .  ... . . .  ... 
... ... ... ... ... 

; When the cursor is in the correct start- ... .:.:. 
..... ... 
2 ... ing point, press either 1-1 ... 
iiii ... or lENTER to enable drawing. 
... ... 

Press direction keys to extend the 
line segment in the desired direction. 

At the end of a line segment, press 
pX€€EKK o r v q .  The end of 
this line is now the start point for the 
next line. If desired, you can create 
additional lines with the cursor keys ... 

iiiii :.:.:. and t h e w 1  or 
... 
;ijii 1-7 keys. 
. . .  ... . . .  
: :.:. ..... 

TQ complete the series of line incre- 
ments and disable drawing, press 

. . 
>..: .:.:. . . .  

Move the cursor to the desired ::::. ... ... ... 
start point for the line. Click (but ... ... ... ... 

do NOT hold) the LEFT mouse but- ... ;$ ... 
ton to enable drawing. .... .... .... ... 

.:.:. :.:.: ... ... 
Move the mouse in the desired ..... ... ... 

... ... ... direction and a line extends from ... ... ... 

.... . . 
the start point to the cursor. ... .. :. ..... ... ... 

... ... 

When the cursor is at the desired 
end point of the line, click the LEFT 
mouse button to end the line. The 
end point of this line is now the 
start point for the next line. If 
desired, move the mouse in addi- 
tional directions and continue click- 
ing the LEFT mouse button to 
define additional segments or in- 
crements of a waveform. 

..... ... ... ... When the cursor is at the desired j:: ... 
end point for a completed series of $; .,. . ..... ... line segments, click the RIGHT ..... ... ... ... 

... 
mouse button to accept the series i':i ... 
and disable drawing. . . .  

... . . .  

-- 
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I Envelope Max Don't Care I 

Envelope Max This command is similar to the Horizontalcommand and allows you 
to draw the "don't care" acceptance range for the upper limit of the 

Don't Care waveform envelope. The "don't care" bit level is determined by the tar- 
get instrument at the time the waveform was created; it is the maxi- 
mum bit level the instrument supports. 

To activate a Draw mode cursor, 
press the pJ key until the 
WaveformList is displayed. Then 
press pJ one more time. 

Use the direction keys to position the . ... ... . . . 
... starting point for the line to be drawn. ..... ... ..... ... ... ... 

When the cursor is in the correct start- 
ing point, press either - 
or IErJTERto enable drawing. 

Press direction keys to extend the 
line segment in the desired direction. 
The line only draws in a horizontal 
direction originating from the start 
point. 

To end the line segment, press either 

y s P A C E s n R l o r m .  

Repeat for additional line segments. 

... ..Q ... Move the cursor to the desired .:.:. ..< .... ..... ... start point for the line segment. ..... ..... ... 

... ... Press and hold the LEFT mouse ... ... ... ... 

... button to enable drawing. . . .  ... ... 

... ... ... ... ... .... ... 

... Move the mouse in the desired ... 
direction and a horizontal line seg- 8; . . 
ment extends from the start point ;; 
to the horizontal position of the cur- $ ... ... ... sor. ... . . ... .... ... 

... ... ... (... ... When the cursor is at the desired ""' . ... :. 

end point, release the LEFT mouse ${ ... ... ... button to end the line segment. ... ... ... ... 
... ... 
... ... 

Repeat for additional line seg- .: ... ... .. 
... 

ments. ... 

... ... 
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Envelope Min Don't Care 

Envelope Mi n Don't This command is similar to the ~orirontal command and allows you 
to draw the "don't care" acceptance range for the lower limit of the 

Care waveform  envelope^ The "don*t care" bit level is determined by the tar- 
get instrument at the time the waveform was created; it is the minimum 
bit level the instrument supports. 

... ... ... ... ... ... ..... ... 
.:.:. :_:.: 
... ... 

To activate a Draw mode cursor, ..... .:.:. ... 

press the [TAB] key until the 
WaveformList is displayed. Then 

.. .  press [TAB] one more time. ... ... ... 

... ... ... . . .  Use the direction keys to position the ... ... ... ... 

... ... 
starting point for the line to be drawn. ... ... :.:. ... ..... 

>:.: 

... ... When the cursor is in the correct start- ... ... ... 

... ... 
ing point, press either -1 ... ... ... ... ... ...  
or enable drawing. . . .  ... 

.:.:: ... ... ... ... 

Press direction keys to extend the 
line segment in the desired direction. 
The line only draws in a horizontal 
direction originating from the start 
point. 

... 

.:.:. 

... To end the line segment, press either . . . .  . ... 

I o r  Or- ...  ... 
... ... 
... .:.:. ..... ... ... ... 

Repeat for additional line segments. ... ... ... ... 
.:... ... ... ... .:.:. 
.j.. .... 

Move the cursor to the desired 
start point for the line segment. 
Press and hold the LEFT mouse 
button to enable drawing. 

..... 
Move the mouse in the desired .:.:. ..,.. ... ... 

.:.:. 
direction and a horizontal line seg- ;: ... 
ment extends from the start point $j ... 
to the horizontal position of the cur- j'iii .... ... 
SOT. . . .,. .,. ... 

When the cursor IS at the desired 
end point, release the LEFT mouse 
button to end the line segment. 

... ... 

..... ..... 
.:.:. ... 
... Repeat for additional line seg- ... 
... . . .  ... 

ments. . . .  . . .  ... ... ... ... . . 
..... ... :.: ... ... ... ... ... 
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Envelope Max 

Envelope Max When Envelope  ax is selected, you can select a Draw menu com- 
mand to use to modify the upper limit of the currently selected en- 
velope. Select this option first, then select a drawing mode. 

V ~ O  pe Mi n When Envelope Min is selected, you can select a Draw menu com- 
mand to use to modify the lower limit of the currently selected en- 
velope. Select this option first, then select a drawing mode. 

NOTE When creating envelopes, Max values should be 
greater than Min values. Otherwise, the signal 
waveform will always fail. 
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Envelope Min 
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Section 9 - How to CREATE 
WAVEFORMS and SEQUENCES 

What the Create This menu selection is roughly equivalent to a multi-function signal gen- 

Menu Does erator. Several waveform types can be produced: 

Normal Waveforms 

Sine, triangle, pulse, and square. 

W A waveform can also be defined by a mathematical expression, 
using the Equation selection. 

W Envelopes 

Upper and lower waveform test limits. 

W Sequences 

Specify a concatenation of waveforms. 

As on a signal generator, the characteristics of a waveform can be ad- 
justed: 

W Amplitude and offset (can also be specifed as Maximum and Mini- 
mum levels) 

W Cycles 

W Phase 

W Start and Stop points 

W Rise type, fall type, risetime, falltime 

W Delay, pulse width 

W Duty cycle 
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Setting Waveform Characteristics 

Setting Waveform Waveform characteristics are defined by setting or modifying 
parameters in dialog boxes that appear when a waveform type is 

Characterist jcs selected from the Create menu. 

Units of Measure Wherever it's appropriate, units of measure are appended to an edit 
box at its right side. Modifiers to those units are included as part of the 
data within the edit box. For example, a value of 230 milliseconds is 
displayed as: 

The modifiers that are recognized by Wavewriterare these 
Systemelnternationale (SI) characters. Case is significant: 

G = giga u = micro 
M = mega n = nano 
K = kilo p = pieo 
m = milli 

Except for the Equationedit box in the Equationselection, values can 
be expressed in points or seconds. Non-integer numeric values can be 
expressed in scientific (exponential) notation. Scientific notation uses 
a mantissa (a decimal number) followed by an exponent The form for 
this type of number is: 

-n.nn E-nn 
The signs can be omitted for positive values. 

The earlier 230 millisecond example could also be entered as any of 
the following: 

Choice of Units Some parameters can be expressed in different units of measure. 
Horizontal units can be either Seconds or Points. Phase angle can be 
Degrees or Radians. (Vertical units are always Volts.) 

Units of measure are selected with option buttons. When a different 
unit of measure is chosen, the current edit box value is converted to 
the new units. 
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I Parameter Definitions 

Parameter M O S ~  of the tollowing definitions apply to all waveforms -others that 

Definitions are only used with a specific waveform type are identified as such. 

Amplitude Peak-to-peak magnitude of the waveform. 

Offset Deviation of the waveform zero-level from a reference level. Also called 
baseline offset. This parameter is built into the data. 

Max, Min The highest and lowest voltage levels of a waveform. If Max and Min 
are entered, Offset is calculated as the level halfway between Max 
and Min and Amplitude is set to Max minus Min. 

FrequencyIPeriod Calculated based on defined points in a waveform and specified clock 
rate. You can also select if calculation is to be based on StartPoint, 
Stop Point, and the number of Cycles. 

Pulse Width The time interval that a pulse is at 5OoA or more of its peak amplitude. 
Calculation is based on StartPoint, Stop Point, and Cycles. See Figure 
9-1. [Pulse] 

Cycles The number of waveform alternations. Calculation is based on Start 
Point, Stop Point, and Frequency. 

Phase Specifies waveform starting point expressed as an angular deviation 
from a reference point. Can be expressed in Degrees or Radians. 

Sfan Point The position, in time or points, in which the waveform starts. Calcula- 
tion is based on Stop Point, Frequency, and Cycles. This point is dif- 
ferent from, and doesn't necessarily coincide with the StartMarker. 

Stop Point The position, in time or points, in which the waveform stops. Calcula- 
tion is based on StartPoint, Frequency, and Cycles. This point is dif- 
ferent from, and doesn't necessarily coincide with the Stop Marker. 
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I Parameter Definitions I 

Figure 9- I. 
Timing Parameters. 

Wise/Fall Type Positive going and negative going transitions can be defined as either 
Ramp or SineSquared. See Figure 9-2. If Ramp is selected, the com- 
plete transition time is 1.25 times the entered transition time. If Sine 
Squared is selected, the complete transition time is 2.073878 times 
the entered transition time. [Pulse, Square] 

I PULSE WIDTH c 

Figure 9-2. 
Ramp vs. Sine Squared. 

RISE 
TIME --t 

f Ramp f Sine Squared 

RiselFall Time Transition times are defined as the period between 10 percent and 90 
percent of the amplitude. See Figure 9-1. [Pulse, Square] 

7644- 1 

/9o0h 1 0% 

Duty Cycle The ratio of the pulse duration to the period, expressed in percent. 
[Square] 

- 4 

Delay The difference between the start of a waveform and the start of a pulse 
wave transition. Can be specified in points or time. Delay can't be a 
point or a time beyond the length of the waveform. [Pulse] 

FALL - TlME 

NOTE Some combinations of parameters may result in an 
"Invalid number" error message. For example, the 
Start Point can not be a negative value. 
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Equation 

Eq u ati o n Waveforms can be created mathematically by entering an equation 
that defines the characteristics of the waveform. These equations can 
be saved in a library (see Add Equation to Library) and recalled for fu- 
ture use (see Library). When Equation is selected, the dialog box in 
Figure 9-3 appears. 

Figure 9-3. 
Equation Dialog Box, 

kquation: 

1.5+2.8-sin(2+pi*lOQO*t) 

Horizontal 

SLOP Point : 71 0 
@Mu Waueforn 

(npd Equation to ~ i b r a r y )  (Librlry) [?I [x) [T) 

Equation The equation edit box is where you enter a mathematical expression 
defining a waveform. 

The following operators are supported: 

( ) parenthesis + addition 
- subtraction * multiplication 
I division A exponentiation 

The following functions are supported: 

sqrt ( ) square root sin ( ) or sine ( ) sine 
cos ( ) cosine tan ( ) tangent 
asin ( ) arcsine acos ( ) arccosine 
atan ( ) arctangent sinh ( ) hyperbolic sine 
cosh ( ) hyperbolic cosine tanh ( ) hyperbolic tangent 
abs ( ) absolute value ceil ( ) ceiling 
floor ( ) floor loglo ( ) log base10 

log ( ) natural log rand random noise 

exp ( ) exponentiation, base e 

The characters "pi" can be substituted for the numeric value of the 
symbol x. 
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EquationDefinitions The following elements need to be considered and set when creating 
an equation: 

StartIStopPoints -The Start and Stop Points define the range 
of time (t) describing the beginning and end of the waveform seg- 
ment. You may enter the values in either points or seconds, but 
points are converted to time when the calculation is done. 

Time (t) - Time is the running variable represented in the equa- 
tion by the character t. When creating an equation, t is initially the 
time at the Start Point and, in the calculation, is incremented to 
the time at the Stop Point. This is true for all actions except 
'insert'. In this case, time is initially 0 and increments to time = 
stop - start. 

Clock Rate -The system clock rate. 

Frequency- Frequency can be defined as: 
1 I (points/cycle * clock rate) 

Amplitude- The amplitude of the waveform. 

Offset- The dc offset of the waveform. 

Horizontal The Startpoint and Stop Point for the equation can be set in either 
Points or Seconds. Note that the equation start and stop points are 
not the same as the StartMarker and Stop Marker. The values entered 
in these edit boxes define the range of the time variable (t) when the 
waveform is calculated. 

Action Specifies where the newly defined waveform will be placed: 

Replace Writes over the current waveform between and including the 
Equation Start and Stop points. It calculates the waveform at time = 
start to time = stop. 

Insert Inserts the newly defined equation waveform into the current waveform 
starting at the Equation Startpoint. The previously defined portion of 
the current waveform (after and including the Equation Start Point ) is 
shifted to follow the end of the inserted waveform. It calculates the 
waveform at time = 0 to time = stop - start. 

Add Arithmetically adds the newly defined equation waveform to the cur- 
rent waveform between and including the EquationStart and Stop 
points. (See Section 10.) 

New Waveform Creates a new waveform. You are prompted to enter a new waveform 
name. If EquationStart is not defined as zero, all data points preced- 
ing EquationStart are set to zero Volts. Equation Stop defines the end 
of the waveform. 
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Equation 

Waveform Name This edit box is only displayed if NewWaveform is selected. Enter a 
name for the new waveform. 

Equation Example To produce a single cycle of a 1 KHz sine wave with a 2 Volt peak-to- 
peak amplitude and a + 1.5 Volt dc offset for the AFG 51 01, enter the 
following parameters: 

Start point = 0 

Stop point = 999 

Clock = 1 ps (Use the Change Clock Rate command) 

The equation shown follows the basic form for trigonometric functions, 
where: 

A = dc offset. 

B = peak amplitude. 

F = desired frequency of waveform. 

f = function. e.g. sin, cos, tan. 

For the equation: 

A + B * f ( 2 * p i * F * t  ) 
Calculate the signal frequency 

[l/(points/cycle * clock rate)] 
F = 11(1000 (1 104 1) = 1000 

substitute the values for this example and enter in the Equation edit 
box: 

1.5 + 2.0 *sin ( 2  * pi * 1000* t )  

When OK is selected, the waveform will be created. After the waveform 
is drawn on the screen, select Autoscalecurrent Waveform to see its 
full amplitude. 

The waveform in Figure 9-4 should be displayed in the WaveformDis- 
play Area. 

Figure 9-4. 
Equation Example. 

I ~ + a r t s  0 clocks lus 
stom I 0 

v 

I " " ' ~ ~ ~ ~ I ~ ~ ' ~ ~ ~ " ' l 1 ~ ~ ~ ' ~ ' ~ ' I " ' " ' ~ ~ ~  

0 200 400 600 800 10 
Points 
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Equation 1 
Add Equation to Library To add the newly created equation to the equation library, select the 

Add Equation to Library command button. You are prompted for a 
name to identify the waveform. The name can be any combination of 
up to eight ASCII alphanumeric characters. Select OK to accept the 
name. If you choose not to identify a waveform, just select OK without 
entering text. If you choose to have names that are not unique, that is 
also legal. Names and waveform equations are not tested for duplica- 
tion. 

-- -- 
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Figure 9-5. 
Add Equation to Library 

Dialog Box. 
Equat ion  Name: D 



Equation 

Library When Libraryis selected, a dialog box such as Figure 9-6 appears. In 
addition to the command buttons, there is a list box that lists the equa- 
tions and their identifiers. You can highlight and select an existing 
equation from this list. 

Figure 9-6, 
Library 

Dialog Box. 

Library o f  Eauations 

@emove ~ausrion) 7) C tanccl ') ( MelD ) 

Remove Equation Removes a highlighted equation from the library list. 

OK (Library) Accepts deletions, if any, and returns to the Equationdialog box. The 
selected equation will be placed in the equation edit box. 

Cancel (Library) Ignores deletions and returns to the Equation dialog box. 

OK (Equation) When all parameters are set the way you want them, select the OK 
command button to initiate the selected Action 

Cancel (Equation) Select the Cancel command button to abort the Equation function 
and return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Equation dialog box, select the Control-menu 
box and then select Close. 

Wave Writer USER GUIDE 9-9 



Equation I 
Samp lie Equations To help in using the equation feature, here are some sample equations 

along with a brief description. The following equations can be found in 
the library section of the EquationDialog box. But first, the basic trig 
function equation format is: 

A s B  * f ( 2 * p i *  F * t )  

where: 

A = DC offset 

B = Peak Amplitude in volts 

f = trigonometric function, e.g., sin, cos, tan. 

F = Frequency of waveform [ I  / (pointslcycle clock rate)] 

t = Time. Running variable initialized at start point and incre- 
mented to stop point. 

pi = 3.14159265 (internal constant) 

Example Equations: 
I .  A 1 OKHz sine wave with a 1 OV peak-to-peak amplitude and no DC of- 
fset. 

Figure 9-6A. 
5VSine. 

Start point = 0 pts. 

Stop point = 999 pts. 

Clock = 100ns 

Cycles = 1 

In the equation: 

5 * sin(2 * pi * 1 0A4 * t) 
The 5 represents the peak amplitude. The sine function returns a value 
between 1 and -1. Multiplying by 5 adjusts the amplitude to be be- 
tween 5 and -5. The frequency of the equation is calculated based on 
the clockrate and points/cycle of the waveform. The formula is: 

F = 1I((pointslcycle) * clock) or 111 000*l OOns which is 1 OKhz 
(10A4 in equation). 
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Equation 

So, if you were to change the clock rate to 10ns and wanted to main- 
tain the same number of cycles, you would have to change the fre- 
quency to 1/(1000*10ns) = 100kHz. The new equation would be: 

2. Same sine wave as in example 1 above except with 5V dc offset. 

Figure 9-6B 
SVSine with Offset. 

Figure 9-6C 
Exponentially Decaying Sine wave. 

Equation: 

5 + 5 * sin(2* pi * 10A4 * t) 
3. A 1 KHz sine wave with a 1 OV peak-to-peak amplitude, with exponen- 
tial decay with 1 Oms time constant. 

I " " " " ' I " " " " ' I 1 " " . " ' I " " " " '  

0 200 400 600 800 10 
Points 

Start = 0 pts. 

Stop = 999 pts. 

Cycles = 100 

Equation: 

The 5 represents the amplitude. The frequency is calculated based on 
the clockrate and the points per cycle to be 1/(1000 ptsIl00 cycles * 
100us) = 1 KHz or 1 0A3. 

The exponential function starts at 1 and decays to 0 which, when multi- 
plied by the sine function, changes the amplitude from full scale to 
zero. 



Equation 1 
4. A sinc curve centered around 1 OOuS with a frequency of 1 OOkHz. 

Figure 9-60 
Sinc Waveform. 

Figure 9-6E 
Exponential Decay Waveform. 

Clock = 200ns 

Start = 0 s 

Cycles = 20 

Equation: 

(sin(2 * pi * 1 0A5 (t - 1 0A-4)) + 10"-10) / ((2* pi * 10A5 * (t 
- 10A-4)) + 10"-10) 

The 10" -10 terms are included to eliminate divide by 0 plus provide 
the correct value at the singularity point t = 100us. The frequency is 
calculated to be 1/(1000 pts / 20 cycles) * 200ns = 100Khz. Since the 
time variable ' t ' begins at t = 0s and goes to t = 199.8us, the starting 
time is reduced by 100us in the equation (t - 10"-4) to provide the cor- 
rect value at the singularity point t = 100us. 

5. Exponential decay with time constant of 1 Oms, starting at 500mS. 

Start = Clock = 1 ms 

Stop = 1s (assuming 1000 point waveform) 

Equation: 

exp(-(t - 0.5) 1 10"-2) 

The (t - 0.5) calculates the waveform with reference to zero 
(start -500ms) but it will be placed starting at 500ms (Start Point) in the 
waveform. 
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Equation 

6. A DSX-2 Isolated pulse template for telecommunications. The equa- 
tions defining this and other telecom templates may be normalized. 
So, assume a normalized equation such as: 

v(T) = 0.5(l+sin(pi/2 * (1 + T10.36))) 

where 0.72 < = T < = 0.2 

First translate the variable T into the variable t which starts at 0 and in- 
creases. 

-0.72<=T<=0.2 O<=(T+0.72)<=0.92 
Let t=T+0.72. Thus 0<=t<=0.92 

Substitute t-0.72 = T to get: 

v(t-0.72) = 0.5(l+sin(pi/2 * (1+ (t-0.72) 1 0.36))) 

The variable T is normalized to the period of the signal 

Assume the signal of interest is 6.312 MHz, the clock frequency for a 
DS2 digital communication system. The period is 158.4ns. To trans- 
form the variable t into a normalized form, simply divide all occurren- 
ces of t by the signal period or 158.4ns for this example. 

The final equation is: 

This equation can now be used to generate a waveform by calculating 
appropriate start and stop points. Select Create Equation menu and 
choose the New Waveform action button. Then enter the following 
parameters: 

Start = T = -0.72 ==> (tl158.4ns) = 0 ==> t = 0 

Stop = T = 0.2 ==> (W158.4ns) = 0.92 ==> t = 145.8ns 

Use clock = 1 ns 

This will give you the first half of the maximum waveform defining the 
DSX-2 Pulse Template. The following equations define the rest of the 
template. 

2nd half of the Maximum Waveform: 

With the 1 st half of the DSX-2 pulse template as the current waveform, 
Select Create Equation and choose Replaceas the action. Then 
enter the following values: 

Equation : 

0.1 +0.72 * exp((-2.13 * ((W158.4*1OA-9))-0.92))) 

Start = 147ns 

Stop = 350ns 
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Equation 

To generate the minimum waveform of the template a new waveform 
will need to be created consisting of the following two parts: 

1 st half of the Minimum Waveform: 

Select the Create Equation menu item. Then, choose the New 
Waveform action button and enter in the following parameters: 

Equation: 

0.5*(1 +sin(pi/2 *(1 +((U158.4 *loA-9))-0.72)/0.205))) 

Start = 50ns 

Stop = 150ns 

Clock = 1 ns 

2nd half of the Minimum Waveform: 

Select the Create Equation Dialog Box again, and choose the 
Replace action button. Then enter the following parameters: 

Equation: 

0.331 * exp((-1.9*((t/158.4*10A-9)) - 1.02))) 

Start = 151 ns 

Stop = 350ns 

Now use Envelopecouple to combine these two waveform and cre- 
ate your DSX-2 Template (see Envelope Couple later in this section). 
These equations can be found in the equation library distributed with 
Wavewriter See Fig. 9-6F for the resultant template. 

Figure 9-6F 
DSX-2 Isolated Pulse Template 

9-1 4 Wavewriter USER GUIDE 



I Sine 

Sine When Sine is selected, the dialog box in Figure 9-7 appears. 

Figure 9-7. 
Sine Dialog Box. 

V e r t i c a l  - H o r i z o n t a l  
@ Points  0 Seconds 

A w l i t u d e :  [I U 
f t a r t  po in t :  ptS 

(pk-pk) stop p o i n t :  1-1 ~ t s  

Freguer,cy: 7 1  1112 

Act ion IZJ cycles:  17 
C a l c u l a t e  frequency 

Phase: 
0 Radians 

- @ Degrees 

wayeforn tiane: I] 

Verf ical You can specify the vertical parameters in either Max/Min or 
Amplitude/Offset pairs. 

MaxIMin Enter the desired highest and lowest voltage levels for the waveform. 
Values should not be greater than allowed by the target instrument. 

AmplitudeIOffset Enter the peak-to-peak voltage in the Amplitude edit box. Enter the of- 
fset voltage in the Offset edit box. For example a waveform with 4 V 
peak-to-peak amplitude and a 1 V offset would vary from -1 V to 3 V. 

NOTE The offset value specified here is independent of the 
offset specified when a waveform is sent to the instru- 
ment. The offset here is a part of the data, whereas 
the offset specified during output is not a part of the 
data, but is an instrument setting that affects every 
waveform output from the instrument. 
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I Sine I 

Horizontal Start and Stop Points, Frequency, and Cycles can be specified. 
There is a check box associated with each of these four items. Any 
one value can be calculated if the other three values are known. In this 
dialog box a check box is unselected, rather than selected with the 
mouse or keyboard. One of the four check boxes is always in an un- 
selected state (no "Xu in it). 

NOTE Clock rate is a fundamental parameter used in cal- 
culating waveforms. Use the Change Clock Rate 
command in the Displaymenu to set the system 
clock rate. 

Calculate The Calculate command button is connected to the parameter to be 
calculated (empty check box). If you wish to preview the parameter, 
select the Calculate command button. However, the calculation is 
done automatically when the OK command button is selected. In Fig- 
ure 9-7, StartPoint, Stop Point, and Cycles were entered, and Fre- 
quency was calculated. 

PointsISeconds Specifies the units for the StartPoint and Stop Point parameters. 

Start Point Enter (or calculate) the horizontal location where the sine wave is to 
start. The StartPoint location should not be confused with the Start 
Marker position - it is not necessarily the same point. 

Stop Point Enter (or calculate) the horizontal location where the sine wave is to 
stop. The Stop Point location should not be confused with the Stop 
Marker position - it is not necessarily the same point. 

Frequency Enter (or calculate) the frequency of the waveform. 

Cycles Enter (or calculate) the number of cycles to be created. 

Phase Enter the phase for the beginning of the waveform. 

RadiansIDegrees Specifies the units of the Phase parameter. 
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Sine 

Action Specifies where the newly defined waveform will be placed: 

Replace Writes over the current waveform between and including the Start and 
Stop Points. 

Insert Inserts the newly defined sine waveform into the current waveform 
starting at the StartPoint. The previously defined portion of the current 
waveform (after and including the StartPoint) is shifted to follow the 
end of the inserted waveform. 

Add Arithmetically adds the newly defined sine waveform to the current 
waveform between and including the Start and Stop points. (See Sec- 
tion 10.) 

New Waveform Creates a new waveform. You are prompted to enter a new waveform 
name. If Start is not defined as zero, all data points preceding Start 
are set to zero Volts. Stop defines the end of the waveform. 

Waveform Name This edit box is displayed only when NewWaveform is selected in the 
Action group box. Enter an 8 character (or less) filename and a 3 char- 
acter (or less) extension that is acceptable to the DOS system. A 
filename extension is not necessary, since it can be appended when 
the waveform is saved to a disk file. 

OK When all parameters are set the way you want them, select the OK 
command button. 

Cancel Select the Cancel command button to abort the Sine function and 
return to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Sine dialog box, select the Control-menu box 
and then select Close. 
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Triangle I 

Triangle When Triangle is selected, the dialog box in Figure 9-8 appears. 

Figure 9-8. 
Triangle Dialog Box. 

IX] S t o p  Point: 

Vertical You can specify the vertical parameters in either Max/Min or 
Amplitude/Offset pairs 

MaxlMin Enter the desired highest and lowest voltage levels for the waveform. 
Values should not be greater than allowed by the target instrument. 

Amplitude/Offset Enter the peak-to-peak voltage in the Amplitude edit box. Enter the of- 
fset voltage in the Offset edit box. For example a waveform with 4 V 
peak-to-peak amplitude and a 1 V offset would vary from -1 V to 3 V. 

NOTE The offset value specified here is independent of the 
offset specified when a waveform is sent to the instru- 
ment. The offset here is a part of the data, whereas 
the offset specified during output is not a part of the 
data, but is an instrument setting that affects every 
waveform output from the instrument. 
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Triangle 

Horizontal Start and Sop Points, Frequency, and Cycles can be specified. 
There is a check box associated with each of these four items. Any 
one value can be calculated if the other three values are known. In this 
dialog box a check box is unselected, rather than selected with the 
mouse or keyboard. One of the four check boxes is always in an un- 
selected state (no "X" in it). 

NOTE Clock rate is a fundamental parameter used in cal- 
culating waveforms. Use the Change Clock Rate 
command in the Display menu to set the system 
clock rate. 

Calculate The Calculate command button is connected to the parameter to be 
calculated (empty check box). If you wish to preview the parameter, 
select the Calculate command button. However, the calculation is 
done automatically when the OK command bunon is selected. In Fig- 
ure 9-8, Start Point, Stop Point, and Cycles were entered, and Fre- 
quency was calculated. 

PointslSeconds Specifies the units for the StartPoint and Stop Point parameters. 

Start Point Enter (or calculate) the horizontal location where the triangle wave is 
to start. The StartPoint location should not be confused with the Sart 
Marker position - it is not necessarily the same point. 

Stop Point Enter (or calculate) the horizontal location where the triangle wave is 
to stop. The Stop Point location should not be confused with the Sop 
Marker position - it is not necessarily the same point. 

Frequency Enter (or calculate) the frequency of the waveform. 

Cycles Enter (or calculate) the number of cycles to be created. 

Phase Enter the phase for the beginning of the waveform. 

RadiansIDegrees Specifies the units of the Phase parameter. 
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Triangle 

Action Specifies where the newly defined waveform will be placed: 

Replace Writes over the current waveform between and including the Start and 
Stop Points. 

Insert Inserts the newly defined triangle waveform i n t ~  the current waveform 
starting at the StartPoint. The previously defined portion of the current 
waveform (after and including the StartPoint) is shifted to follow the 
end of the inserted waveform. 

Add Arithmetically adds the newly defined triangle waveform to the current 
waveform between and including the Start and Stop points. (See Sec- 
tion 10.) 

New Waveform Creates a new waveform. You are prompted to enter a new waveform 
name. If Start is not defined as zero, all data points preceding Start 
are set to zero Volts. Stop defines the end of the waveform. 

Waveform Name This edit box is displayed only when NewWaveform is selected in the 
Action group box. Enter an 8 character (or less) filename and a 3 char- 
acter (or less) extension that is acceptable to the DOS system. A 
filename extension is not necessary, since it can be appended when 
the waveform is saved to a disk file. 

OK When all parameters are set the way you want them, select the OK 
command button. 

Cancel Select the Cancel command button to abort the Triangle function and 
return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Triangle dialog box, select the Control-menu 
box and then select Close. 



I Pulse 

PU  IS^ When Pulse is selected, the dialog box in Figure 9-9 appears, 

Figure 9-9. 
Pulse Dialog Box. 

U e r t i c a l  - H o r i z o n t a l  
0 Seconds @ P o i n t s  

uaxinun:  u f t a r t  p o i n t :  p t s  

Mininun: 1-2.51 u [XI s t o p  P o i n t :  1 1  p t s  

[XI P e r i o d :  7 1  P t s  

f i c t ion  cyc:1 C!S : 
0 Replace  

0 l n s e r  t 

~ e l a y :  1 7  p t s  
@Mu Waueforn 

P u l s e  width (502):  [ T l p t s  

Risgtile: F a l l t i l e :  

(Cancel) 

Verf ical Sets the vertical pulse parameter. 

Maximum/Minimum Enter the desired highest and lowest voltage levels for the waveform. 
Values should not be greater than allowed by the target instrument. 

Figure 9- 10. 
Pulse Timing Parameters. 
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FALL 
4 -TIME 
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VIME 

7644-3 
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Pulse 

Horizontal Start and Stop Points, Period, and Cycles can be specified. There is 
a check box associated with each of these four items. Any one value 
can be calculated if the other three values are known. In this dialog 
box a check box is unselected, rather than selected with the mouse or 
keyboard. One of the four check boxes is always in an unselected 
state (no "X" in it). 

NOTE Clock rate is a fundamental parameter used in cal- 
culating waveforms. Use the Change Clock Rafe 
command in the Display menu to set the system 
clock rate. 

Calculate The Calculate command button is connected to the parameter to be 
calculated (empty check box). If you wish to preview the parameter, 
select the Calculate command button. However, the calculation is 
done automatically when the OK command button is selected. In Fig- 
ure 9-9, StartPoint, Stop Point, and Period were entered and Cycles 
was calculated. 

PointsISeconds Selects the units for the StartPoint and Stop Point parameters. 

Stanpoint Enter (or calculate) the horizontal location where the pulse wave is to 
start. The StartPoint location should not be confused with the Start 
Marker position - it is not necessarily the same point. 

Stop Point Enter (or calculate) the horizontal location where the pulse wave is to 
stop. The Stop Point location should not be confused with the Stop 
Marker position - it is not necessarily the same point. 

Period Enter (or calculate) the period of the waveform. 

Cycles Enter (or calculate) the number of cycles to be created. 

Delay Enter the delay before the first transition. 

Pulsewidth Enter the width of the pulse at 50% of the peak- to-peak amplitude. 
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I Pulse 

Transitions Enter Risetimeand Falltime. 

PulseDirection Select whether the leading edge of the pulse is Positive going or Nega- 
tive going. 

Risetime Enter the horizontal distance required for the leading edge of a pulse 
to go from 10% to 90% of its amplitude. (Amplitude is the difference be- 
tween the Maximum and Minimum values entered.) 

Falltime Enter the horizontal distance required for the trailing edge of a pulse to 
go from 90% to 10% of its amplitude. (Amplitude is the difference be- 
tween the Maximum and Minimum values entered.) 

~ a m ~ l ~ i n e ~  Rise type and Fall type can be independently set to either Ramp or 
Sine Squared. See Figure 9-1 1. If Ramp is selected, the contribution of 
the transition time to the period is 1.25 times the entered transition 
time. If Sine Squared is selected, the contribution of the transition time 
to the period is 2.073878 times the entered transition time. 

Figure 9- 1 1. 
Ramp vs. Sine Squared. 

f Ramp f Sine Squared 



Pulse I 
Action Specifies where the newly defined waveform will be placed: 

Replace Writes over the current waveform between and including the Start and 
Stop Points. 

Insert Inserts the newly defined pulse waveform into the current waveform 
starting at the StartPoint. The previously defined portion of the current 
waveform (after and including the StartPoint) is shifted to follow the 
end of the inserted waveform. 

Add Arithmetically adds the newly defined pulse waveform to the current 
waveform between and including the Start and Stop points. (See Sec- 
tion 10.) 

New Waveform Creates a new waveform. You are prompted to enter a new waveform 
name. If Start is not defined as zero, all data points preceding Start 
are set to zero Volts. Stop defines the end of the waveform. 

Wavef 0rm Name This edit box is displayed only when New Waveform is selected in the 
Action group box. Enter an 8 character (or less) filename and a 3 char- 
acter (or less) extension that is acceptable to the DOS system. A 
filename extension is not necessary, since it can be appended when 
the waveform is saved to a disk file. 

OK When all parameters are set the way you want them, select the OK 
command button to initiate the selected Action 

Cancel Select the Cancel command button to abort the Pulse function and 
return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Pulse dialog box, select the Control-menu box 
and then select Close. 
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I Square 

Square When Square is selected, the dialog box in Figure 9-12 appears. 

Figure 4 12. 
Square Dialog Box. 

Vertical You can specify the vertical parameters in either Max/Min or 
Amplitude/Offset pairs. 

V e r t i c a l  
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MaxIMin Enter the desired highest and lowest voltage levels for the waveform. 
Values should not be greater than allowed by the target instrument. 

- Hor izonta l  
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S t a r t  Point:  I T l ~ t s  

AmplitudeIOffset Enter ttie peak-to-peak voltage in the Amplitude edit box. Enter the of- 
fset voltage in the Offset edit box. For example a waveform with 4 V 
peak-to-peak amplitude and a 1 V offset would vary from -1 V to 3 V. 
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Figure 4 13. 
Square Timing Parameters. 
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Square 

NOTE The offset value specified here is independent of the 
offset specified when a waveform is sent to the instru- 
ment. The offset here is a part of the data, whereas 
the offset specified during output is not a part of the 
data, but is an instrument setting that affects every 
waveform output from the instrument. 

W~l'k~ilfal Startand Stop Points, Frequency, and Cycles can be specified. There 
is a check box associated with each of these four items. Any one value 
can be calculated if the other three values are known. In this dialog 
box a check box is unselected, rather than selected with the mouse or 
keyboard. One of the four check boxes is always in an unselected 
state (no " X  in it). 

NOTE Clock rate is a fundamental parameter used in cal- 
culating waveforms. Use the Change Clock Rate 
command in the Displaymenu to set the system 
clock rate. 

Calculate The Calculate command button is connected to the parameter to be 
calculated (empty check box). If you wish to preview the parameter, 
select the Calculate command button. However, the calculation is 
done automatically when the OK command button is selected. In Fig- 
ure 9-1 2, Start Point, Stop Point, and Frequency were entered and 
Cycles was calculated. 

PointsISeconds Specifies the units for StartPoint and Stop Point parameters. 

Start Point Enter (or calculate) the horizontal location where the square wave is to 
start. The StartPoint location should not be confused with the Start 
Marker position - it is not necessarily the same point. 

Stop Point Enter (or calculate) the horizontal location where the square wave is to 
stop. The Stop Point location should not be confused with the Stop 
Marker position - it is not necessarily the same point. 

Frequency Enter (or calculate) the frequency of the waveform. 

Cycles Enter (or calculate) the number of cycles to be created. 

Phase Enter the phase for the beginning of the waveform. 

RadiansIDegrees Select if Phase is to be defined in Radians or Degrees. 

Duty Cycle The time between 50°/o of the rise and 50% of the fall divided by the 
period (50% of the rise to 50% of the next rise). Duty cycle is ex- 
pressed in percent. See Figure 9-13. 



I Square 

Transitions Enter Rise time and Fall time for the square wave. 

Risetime Enter the horizontal distance required for the leading edge of a square 
wave to go from 10% to 90% of its amplitude or the difference between 
the Maximum and Minimum values entered. 

Falltime Enter the horizontal distance required for the trailing edge of a square 
wave to go from 90% to 1 Ooh of its amplitude or the difference between 
the Maximum and Minimum values entered. 

RamplSine Squared Rise type and Fall type can be independently set to either Ramp or 
Sine Squared. See Figure 9-14. If Ramp is selected, the contribution of 
the transition time to the period is 1.25 times the entered transition 
time. If Sine Squared is selected, the contribution of the transition time 
to the period is 2.073878 times the entered transition time. 

Figure 9- 14. 
Ramp vs. Sine Squared. 

Ramp Sine Squared 
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Action Specifies where the newly defined waveform will be placed: 

Replace Writes over the current waveform between and including the Start and 
Stop Points. 

Insert Inserts the newly defined square wave waveform into the current 
waveform starting at the StartPoint. The previously defined portion of 
the current waveform (after and including the StartPoint) is shifted to 
follow the end of the inserted waveform. 

Add Arithmetically adds the newly defined square wave waveform to the 
current waveform between and including the Startand Stop points. 
(See Section 10.) 

New Waveform Creates a new waveform. You are prompted to enter a new waveform 
name. If Start is not defined as zero, all data points preceding Start 
are set to zero Volts. Stopdefines the end of the waveform. 

Waveform Name This edit box is displayed only when NewWaveform is selected in the 
Action group box. Enter an 8 character (or less) filename and a 3 char- 
acter (or less) extension that is acceptable to the DOS system. A 
filename extension is not necessary, since it can be appended when 
the waveform is saved to a disk file. 

OK When all parameters are set the way you want them, select the OK 
command button. 

Cancel Select the Cancel command button to abort the Square function and 
return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Square dialog box, select the Control-menu box 
and then select Close. 
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Envelope Tolerance 

Envelope Tolerance YOU can define an envelope waveform by adding vertical and/or 
horizontal tolerances to an existing normal or envelope waveform. If 
you are modifying an envelope waveform, the tolerances are ac- 
cumulative. When EnvelopeTolerance is selected, the dialog box in 
Figure 9-1 5 appears. 

Figure 9- 15. 
Envelope Tolerance 

Dialog Box. 

- U e r t i c a l  Tolerance 
Processing Region 

O y o l t a g e  Ualue 

O P e r c e n t a g e  ( teak t o  Peak) OBetween Markers 

O P e r c e n t a g e  (User Def ined)  

O D i g i t i z i n g  l e u e l  

Maximum Tolerance: 

Jjinimum Tolerance: 7 1  U 

NOTE Double clicking a waveform in the Displayed 
Waveforms list will cause it to be entered into the bold 
edit box. 

Displayed W a ~ e f ~ r m ~  A list box of available waveforms currently in memory. 

lnpllt Waveform Enter or select a waveform from the Displayed Waveform list to which 
apply a tolerance. 

Ollf~l l f  Envelope In this edit box, enter a name for the envelope waveform to be output. 
Any combination of ASCII alphanumeric characters can be entered for 
the 8 filename and 3 extension characters. Unique names should be 
chosen. If an existing envelope name is entered (or chosen from the 
DisplayedWaveforms List), the current version will replace the pre- 
vious one. 



Vertical Tolerance The tolerance can be defined as voltages, percentages, or digitizing 
levels. Maximum and minimum tolerances must be specified. You can 
reduce the tolerance of an existing envelope by using a negative value. 

Voltage Value The specified Maximum Tolerance in Volts is added to the waveform or 
the upper limit of the envelope. The specified Minimum Tolerance in 
Volts is subtracted from the waveform or the lower limit of the en- 
velope. 

Percentage (User Defined) To calculate percentage values, Wavewriter needs to know what 
values you consider to be 0% and 100%. When Percentage (User 
Defined) is specified and the tolerances are entered, select the OK 
command. A dialog box is displayed requesting that you enter a 0% 
level. Note that, for this operation, the Waveform DisplayArea cursor 
automatically changes to a crosshair indicator. 

Move the horizontal crosshair vertically to the desired 0% level. Then, 
either presslENTER] or press the LEFT mouse button to enter the 
value. 

The next dialog box requests a 100% level to be entered. Use the 
same procedure as for the 0% level to enter the 100°/~ level. When the 
100% level is entered, the envelope is calculated and displayed. 

Percentage (Peak-to-Peak) Calculates the maximum and minimum tolerances as percentages of 
the peak-to-peak amplitude of the waveform. 

Digitizing Level The specified Maximum Tolerance in digitizing levels is added to the 
waveform or the upper limit of the envelope. The specified Minimum 
Tolerance in digitizing levels is subtracted from the waveform or the 
lower limit of the envelope. 

Maximum Tolerance Maximum vertical tolerance is added to the waveform or the envelope 
upper limit. The value entered depends on whether Voltage, Percent- 
age, or DQitizing Level was selected. 

MinimumTolerance Minimum vertical tolerance is subtracted from the waveform or the en- 
velope lower limit. The value entered depends on whether Voltage, Per- 
centage, or Digitizing Level was selected. 

- - 
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Envelope Tolerance 

Horizontal Tolerance The tolerance can be specified in Seconds or in Points. Each 
waveform point in the Processing Region will be shifted left and right 
by this amount, creating a band twice the specified amount. 

Pr~cessing Region Select how much of the waveform is to be affected -either the entire 
waveform or only the area between and including the markers. 

OK When all parameters are set the way you want them, select the OK 
command button to create the envelope waveform. 

Cancel Select the Cancel command button to abort the EnvelopeTolerance 
function and return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the EnvelopeTolerance dialog box, select the Con- 
trol-menu box and then select Close. 
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Envelope Couple 

Envelope COU pie YOU can use two waveforms to define the upper and lower boundaries 
of an envelope. When Envelope Couple is selected, the dialog box in 
Figure 9-1 6 appears. 

Figure 9- 16. 
Envelope Couple 

Dialog Box. 

Min Uaueform: DSX-2MIN.LDF - I 
Envelope Uavef orm: - 

Displayed Waveforms In this list box are the waveforms currently in memory. From this list 
box, you can select the upper limit (Max) waveform, the lower limit 
(Min) waveform, and (optionally) the EnvelopeWaveform, which stores 
the envelope waveform data created by this command. 

Select a waveform (by pointing at the entry and double-clicking the 
LEFT mouse button or by highlighting an entry with the direction keys 
and pressing p q ) .  This enters the name in the bold edit box ( M a  
Waveform Min Waveform, or Envelope Waveform). If, after entering En- 
velope Waveform, you want to change one of your choices, choose 
another waveform -the next selection will be entered in Max 
Waveform and the cycle starts over. 

Max/Min Waveforms An input waveform (MaxWaveform or Min Waveform) must be one of 
the waveforms in the DisplayedWaveforms list box. You can either 
select an item in the list box or move the text cursor to one of the input 
waveform edit boxes (using or clicking the mouse) and enter the 
name from the keyboard. In either case, both of the selections must be 
non-envelopewaveforms. 
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I Envelope Couple 

Envelope Waveform If you don't want to choose an existing waveform name to store the 
modified waveform, move the text cursor to EnvelopeWaveform and 
enter a new name from the keyboard. 

The output waveform (Envelope Waveform) can be the same as one 
of the input waveforms - in which case, the original data is lost when 
the selected operation is done. 

OK When all parameters are set the way you want them, select the OK 
command button to create the envelope waveform. The output en- 
velope waveform is created by using the MaxWaveform to create the 
upper boundary and the Min Waveform to create the lower boundary. 
The newly created waveform becomes the current waveform. 

Cancel Select the Cancel command button to abort the EnvelopeCouple 
function and return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the EnvelopeCouple dialog box, select the Control- 
menu box and then select Close. 
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Envelope Decouple 

Envelope Decou pie An existing envelope waveform can be separated into two uncoupled 
waveforms -one defined by the upper boundary of the envelope, and 
the other defined by the lower boundary. When EnvelopeDecouple is 
selected, the dialog box in Figure 9-17 appears. 

Figure 9- 1 7. 
Envelope Decouple Dialog Box. 

Envelope Uavef orn: 7 1  - 
k g  Output Uaveform: -1 

- 

- "in o u t p u t  Uaveforn: -1 
- 

(7) (-1 HclP) 

Displayed Waveforms In this list box are all the waveforms in the Waveform List. From this list 
box, you can select the EnvelopeWaveform, from which two 
non-envelope waveforms will be created. 

Select a waveform (by pointing at the entry and double-clicking the 
LEFT mouse button or by highlighting an entry with the direction keys 
and pressing-). This enters the name in the bold edit box 
(Envelope Waveform, MaxOutput Waveform, or Min Output 
Waveform). If, after entering all three waveforms you want to change 
one of your choices, choose another waveform -the next selection 
will be entered in EnvelopeWaveform, and the cycle starts over. 

Envelope Waveform In this edit box enter (or select from the DisplayedWaveforms list) the 
waveform to be decoupled. It must be an envelope waveform. 
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Envelope Decouple 

Max Output Waveform You can either select an item in the DisplayedWaveforms list box or 
move the text cursor ( u s i n g m  or clicking the mouse) to the Max 
OutputWaveform edit box and enter the name from the keyboard. 

Min Output Waveform You can either select an item in the DisplayedWaveforms list box or 
move the text cursor ( u s i n g m  or clicking the mouse) to the Min 
OutputWaveform edit box and enter the name from the keyboard. 

OK When all parameters are set the way you want them, select the OK 
command button to create the two non-envelope waveforms. The Max 
OutputWaveform is created by using the upper boundary of the en- 
velope and the Min Output Waveform is created by using the lower 
boundary of the envelope. The MaxOutput Waveform becomes the 
current waveform. 

Note: The original envelope waveform is not replaced when 
it is decoupled. 

Cancel Select the Cancel command button to abort the Envelope Decouple 
function and retum you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the EnvelopeDecouple dialog box, select the Con- 
trol-menu box and then select Close. 
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The Sequence Editor I 

Thesequence 
Editor 

Pntroduction Sequences are used in various instruments. For packet oriented ar- 
bitrary waveform generators, like the VX5790, sequences are an in- 
tegral part of the instrument architecture. However, for waveform 
oriented AWGs, like the AFG 51 01, sequences are a foreign concept. 
For this type of AWG, the sequence must be converted into a com- 
posite waveform. 

Packet Oriented AWG The packet oriented AWG is designed to output waveforms from a 
series of packets in its memory. A packet is just a portion of the 
waveform. For example, one cycle of a 10 KHz sine wave could be 
stored in a packet. Each packet in the series can be repeated before 
outputting the next packet. For example, the packet could be repeated 
100 times which would output 100 cycles of a 10 KHz sine wave, yet 
only one cycle is actually stored in the instrument. 

Waveform Oriented AWG The waveform oriented AWG must have the complete waveform that it 
will output in memory. Usually, its waveform memory is larger than the 
packet size for a packet oriented AWG. However, the total amount of 
memory available for packets in a packet oriented AWG is comparable 
to the amount of memory for a single waveform in a waveform oriented 
AWG. 

What is a Sequence? A sequence is a list of waveforms that are to be output in a specified 
order. In addition, a repetition count is specified for each waveform. 
The repetition count indicates how many times its associated 
waveform is to be output before starting the next waveform in the se- 
quence. 

VX5790 Filenames When creating files for the VX5790, be aware that filename extensions 
are ignored. Therefore, filenames in a sequence must be unique 
without regard to their extensions. If not, the same packet number will 
be assigned to two different waveforms. 
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The Sequence Editor 

Starting the Sequence When Sequence is selected from the Create menu, the dialog box in 
Editor Figure 9-18 is displayed. 

Figure 9- 18. 
Sequence Editor 

Dialog Box. 

Seauence L i s t :  

Creating New Sequences The name of the sequence to be worked on is displayed in the title bar 
at the top of the dialog box. The Sequence Editor starts with 
"UNTITLED.SEQ" as the sequence name. This name is used as the 
name of a new sequence until it is saved (See Save in the File menu) 
at which time the name can be changed. 

Select a waveform from the entries in the WaveformFiles list box by 
double-clicking with the mouse. This places the selected entry in the 
B i t  Area where you enter the Repetition count. Append is selected 
to place the entry at the bottom of the Sequence List box. 

All normal sequence editing features are available when creating a new 
sequence. For more details, see the following discussions of specific 
controls. 

Editing Saved Sequence files are read with the Open command in the File menu. The 
SequenceFiles names of the files that make up the specified sequence are displayed 

in the Sequence List box. The items can be rearranged, the repetition 
count changed, entries deleted, and entries added. 



The Sequence Editor 

Dialog Box 
Control Definitions 

WaveformDirectory This area displays the current directory path. If you need to specify a 
directory other than the one displayed, see the following discussion. 

Files with ext The characters in the extension edit box determine which files are 
shown in the list box. Only files with the extension shown are listed. 
Wildcard characters ("*", "?") are permitted within the extension. 

The list box shows the waveform files available on the disk. Only ADIF 
formatted waveforms can be used to create sequences. Attempts to 
use other files will cause an error. A size limit exists for waveforms in- 
cluded in a sequence. If the selected waveform size exceeds this limit, 
an error is displayed. 

The list box also shows subdirectories and drives. These allows you to 
go to any diskldirectory to get to your waveform directory. However, 
once a waveform file is entered into the Sequence List box, the ability 
to move to other drives/directories is removed. This forces all 
waveforms and their associated sequences must be in the same direc- 
tory. 

-- - - 
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The Sequence Editor 

Sequence List Box The Sequence List box shows the waveforms and repetition numbers 
in the order they will be executed in the sequence. This is where the ac- 
tual sequence is built or modified. 

With the keyboard, to the Sequence List box and then use the 
and -1 cursor keys to highlight a particular entry. Or, with 

the mouse, point to an entry and click the LEFT mouse button. 

Edit Area To modify a sequence, the Sequence List entry to be moved or 
modified must be placed in the Edit Area. The Edit Area is a temporary 
holding area in which the repetition number is added or changed for a 
sequence entry. The editing keys, Cut, Copy, Insert, Replace, and Ap 
pend, use the EditArea for their operations. 

There are fourways to get entries into the EditArea: 

Selecting an entry in the WaveformList box places that 
waveform in the Edit Area and initializes the Repetitions count 
to one. 

Selecting an entry in the Sequence List places that entry into the 
Edit Area. 

Highlighting an entry in the Sequence List and selecting the 
Copy command places that entry in the EditArea. 

Highlighting an entry in the Sequence List and selecting the Cut com- 
mand places that entry in the EditArea and removes the entry from 
the list. 

Edit Area Clock The Edit Area Clock group box shows the clock rate of the waveform 
in the EditArea. Most AWGs use the same clock rate for all waveforms 
in a sequence and, therefore, to accurately represent the waveforms 
created with Wavewriteron the target instrument, all waveforms in 
the sequence must have the same clock rate. You need to fix any dis- 
crepancy in clock rates (if the AWG uses a fixed clock rate) before at- 
tempting to use the sequence and waveforms. 

Repetition Number This edit box specifies the number of times the waveform shown in the 
Edit Area is repeated before proceeding to the next waveform in the 
sequence. If a number is entered that exceeds the limits of the target 
instrument, an error message is displayed and the last digit is removed. 

Sequence Parameters This group box contains the parameters for the sequence. These 
parameters override any conflicting parameters in the packet files. 

Amplitude This is the peak-to-peak amplitude setting for the sequence. This set- 
ting is used when saving instrument specific sequence files (.SIS files) 
and when sending the sequence to the instrument. 



The Sequence Editor 

Offset This is the offset voltage for the sequence. This setting is used when 
saving instrument specific sequence files and when sending the se- 
quence to the instrument. 

Clock The clock rate that is used when saving an instrument specific se- 
quence file and when sending a sequence. The clock rate can be 
changed by clicking the Change Clock Button. 

Change Clock The pushbutton causes the Change Clockrate dialog box to appear 
(see Figure 7-6). Select the appropriate clock rate for the sequence. 
The Wavewriter clock rate is not changed. 

Copy This command button brings a highlighted entry from the Sequence 
List box into the Mi tkea .  The current entry in the M i t  Area is over- 
written. If the Sequence List is empty, this control is grayed and in- 
operative. 

Cut This command button removes the highlighted entry from the S e  
quence List box and places it in the M i t  Area. The current entry in the 
EditArea is overwritten. If the Sequence List box is empty, this con- 
trol is grayed and inoperative. 

Insert This command button inserts the entry in the EditArea into the Se- 
quence List above the highlighted entry. If the M i t  Area is empty, this 
control is grayed and inoperative. 

Replace This command button replaces a highlighted entry in the Sequence 
List box with the entry in the H i t  Area. If the Sequence List is empty 
or the EditArea is empty, this control is grayed and inoperative. 

Append This command button adds the entry in the EditArea to the end of the 
sequence. The Sequence List box is updated to show the result of 
this operation. If the EditArea is empty, this control is grayed and in- 
operative. 

Send When all sequences are set the way you want them, select the SEND 
command button to display the Send Dialog box, see Figure 9-21. 

Cancel The Cancel command button aborts the SequenceEditor and returns 
you to the main menu. Unsaved changes are abandoned. 

Help Select the Help command button to display informative text 
relating to this operation. Use the scroll bar, if present, to read 
the entire help text. To return to the SequenceEditor dialog box, 
select the Control-menu box and then select Close. 
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Seq ue rice Ed itor The sequence ~di tor  has Flle and ~ransfer menus. The commands 
in the File menu are New, Open, and Save. The only command in the 

Men Transfer menu is Send. 

File Menu File menu functions perform disk inpuffoutput and initialize the editor 
when starting a new sequence. 

New This command clears any previous entries from the Sequence List 
box so a new sequence can be defined. If the old sequence has not 
been saved, a warning message is displayed to allow you to save the 
sequence. 

Open This command reads a previously saved sequence file. A dialog box is 
displayed for you to pick the sequence file you want to look at or 
modify. Only sequence files can be opened and an error message is 
displayed if your selection isn't a valid sequence file. (See the Open 
command in the main File menu for more details.) If the old sequence 
has not been saved, a warning message is displayed to allow you to 
save the sequence. 

The Sequence List box displays the waveforms listed in the opened 
file. 

Save This command displays the dialog box in Figure 9-19. 

Figure 9- 19. 
Sequence Save 

Dialog Box. 

Save F i l e  Name: C:\UW 

urrrtnmrj 1 
Extension:  

(XlyaueWriter Format lsEpl 
instrument S p e c i f i c  F i l e  

nmke Backup 

This dialog box is like the Save dialog box in the main File menu. If In- 
strument Specific File for the VX5790 is selected then the dialog box in 
Figure 9-20 is displayed when OK is selected, 
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I Sequence Index: l o  I 

Figure 9-20. 
Sequence Save 

Dialog Box. 

I a l n o l u d e  Imbedded Addresses I 

0 Binary Format 
@ Hexadecimal Format 

Format - Choose the formats in which the sequence is sent - either 
Binaryor Hexadecimal. Binary is compact, hexadecimal is readable. 

Sequencelndex - This edit box accepts the internal instrument se- 
quence index. This must be a positive number less than 1000. 

lncludelmbedded Addresses - When sending a sequence 
to a VX5790 using a VXI resource manager that understands 
imbedded addressing (such as the Tektronix VX5520), select 
this check box and the logical address defined in the Configure- 
/Change Instrument command is included in the parameters sent. If 
this check box is not selected, the sequence is sent without specifying 
the logical address. 

Send Execute Command - If this check box is selected, the 
EXECUTE command is appended to the end of the sequence. 

Exit Select the Exit command to leave the SequenceEditor and return to 
the main menu. 

Transfer Menu 

Send This command displays the dialog box in Figure 9-21 in which you 
enter instrument specific information for sending the sequence. 

Format - Choose the formats in which the sequence is sent - either 
Binaryor Hexadecimal. Binary is compact, hexadecimal is readable. 

Sequencelndex - This edit box accepts the internal instrument se- 
quence index. This must be a positive number less than 20. 

lncludelmbedded Addresses - When sending a sequence to a 
VX5790 using a VXI resource manager that understands imbedded ad- 
dressing (such as the Tektronix VX5520), select this check box and the 
logical address defined in the Configure/Changelnstrument com- 
mand is included in the parameters sent. If this check box is not 
selected, the sequence is sent without specifying the logical address. 
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Figure 9-21. 
Transfer Menu Dialog Box 

0 ~ i n a r y  Format 
@ Hexadecimal Format 

1 Sequence Index: 1 0  I 
I BI-nclude Imbedded Addresses I 
I [XI Send Execute Command 

....................-....................a. ................................................. . ......, 
@ ;sen cl.... .?csunc .... .~?.~4~~~.Eack.~t~s1 
O ~ e n d  Sequence Only 

I 1 

Send Execute Command - If this check box is selected, the 
EXECUTE command is appended to the end of the sequence. This 
causes the generated waveform to be output on the VX5790. 

Send Sequence and Packets -This will cause associated packets to 
be sent to the VX5790 as well as the sequence. 

Send Sequence Only - This will send only the sequence information 
to the VX5790. It is assumed that the required packet data is already in 
the instrument. 

See the Transfermenu, Section 11, for details on how Send works for 
your instrument. 
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Section 10 
How to PROCESS WAVEFORMS 

Mod i fy i ng Any waveform can be modified either with a constant value or with 
another waveform by using the Sig Proc (Signal Processing) menu. 

Waveforms Your options for modifying waveforms are: 
Arithmetically 

I A A A  q rnnrtqnt tn nalrh nnint n f  a sara\,nfnrm nr  ma lltinl\~ narh = nuu a b u t  t a k a s  11 i w  Gab1 I ~ W I I  11 UI a v w a v G l w t  I I I  UI I I I U ~ L I ~ I J  G ~ U I  I 

point by a constant value. 

A waveform can be added to or subtracted from another 
waveform. 

A waveform can be multiplied by or divided by another waveform. 

Scalar values When using a constant scalar value, each point of the current 
waveform in the selected Processing Region is modified by the scalar 
value. You can either add the scalar value to the current waveform, or 
multiply the current waveform by the scalar value. When one of the 
Scalar options is selected, the dialog box in Figure 10-1 appears. The 
dialog box is the same for either of the Scalaroptions, except for the 
1.1,- L - _  _ I  .L I _ _ _  _ _ _ I  IL  - _I.. L- . .  I-L _ I  IiIie Dar ar rne rop ana rne earr mx laoel. 

Processing Region 

@ Entire Waveform 

0 ~ e t w e e n  Markers 

Figure 10- 1. 
Scalar Signal Processing 

Dialog Box. 
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Scalar values 

The Scalar Value Addscalar adds a scalar value to each point of the current waveform 
in the Processing Region. The scalar value can be either positive or 
negative. 

Multiply by Scalar changes the amplitude of the current waveform in 
the Processing Region. For an increase in amplitude (multiplication), 
enter a value greater than one. For a decrease in amplitude (division), 
enter a decimal value less than one. 

Pt'0cessing Region Each of the operations in this menu can be done on the entire current 
waveform or a selected portion. 

EntireWaveform When this option button is selected, signal processing operations are 
done on the entire length of the waveform. 

BetweenMarkers When this option button is selected, signal processing operations are 
done on only the portion of the waveform(s) between and including 
the Start and Stop markers. 

OK When the OK command button is selected, the selected factor is ap- 
plied to each point of the current waveform in the Processing Region. 

Cancel Select the Cancel command button to abort the function and return 
you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the previous dialog box, select the Control-menu 
box and then select Close. 

-- 
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Processing Two Waveforms 

Processing Two 
Waveforms 

Figure 10-2. 
Add, Subtract, Mu/tiply, 
and Divide Dialog Box. 

When using two waveforms to create a third waveform, each point of 
the first waveform is modified by the corresponding time point of the 
second waveform. There are several ways to do this: 

Add the second waveform to the first waveform. 

Subtractthe second waveform from the first waveform. 

Multiplythe first waveform by the second waveform. 

Divide the first waveform by the second waveform. 

When Add, Subtract Multiply, or DivideWaveforms is selected, the 
dialog box in Figure 10-2 appears. Except for the title bar at the top of 
the dialog box and the arithmetic operator displayed between 
Waveform1 and Waveform2, the display is the same for each of these 
menu options. 

Displayed Waueforns - 

Processing Region 

@ ~ n t i r e  Waueforn 

0 Between Markers 

WFn 1: W F ~  1: Wfn 3: 

Displayed Waveforms From this list box, you can select the first waveform, the second 
waveform, and the output waveform that stores the modified data. 
Select a waveform (by pointing at an entry and double-clicking the 
LEFT mouse button or by highlighting an entry with the direction keys 
and pressing-). This enters the name in the next available text 
box ( Waveform 1, Waveform2, or Waveform 3 ) . After entering 
Waveform3, you may want to change one of your choices. Choose 
another waveform -the next selection will be entered in Waveforml, 
and the cycle starts over. 
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Processing Two Waveforms I 
Pr~ceSSing Region Each of the operations in this menu can be done on the entire 

waveform or a selected portion. 

EntireWaveform When this option button is selected, signal processing operations are 
done on the entire length of the waveform. 

Between Markers When this option button is selected, signal processing operations are 
done on only the portion of the waveform(s) between and including 
the Start and Stop markers. 

Input Waveforms An input waveform (Waveform1 or Waveform2) must be one of the 
waveforms in the DisplayedWaveforms list box. You can either select 
an item in the list box or move the text cursor to one of the input 
waveform edit boxes and enter the name from the keyboard. 

O U ~ P U ~  Wavef0rm If you don't want to choose an existing waveform name to store the 
modified waveform, move the text cursor to Waveform3 and enter a 
new name from the keyboard. 

The output waveform (Waveform3) can be the same as one of the 
input waveforms - in which case, the original data is lost when the 
selected operation is done. 

OK When the OK command button is selected, the operation is done at 
each point of the input waveforms in the Processing Region. The 
result of the operation is stored in Waveform3, which becomes the cur- 
rent waveform. If Between Markers was selected and Mveform 3 is 
new, timing is maintained and zeros are assigned to the undefined 
points between the zero time reference and the StarfMarker- the 
new waveform ends at the Stop Marker. However, if EntireWaveform 
was selected as the Processing Region, the output waveform is the 
length of the longer of the two input waveforms. 

NOTE If the calculation result exceeds the internal system 
limit, you are warned that waveform data has been 
clipped at this limit. 

Cancel Select the Cancel command button to abort the function and return 
you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the previous dialog box, select the Control-menu 
box and then select Close. 
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Section I I 
How fo TRANSFER WAEFORMS 

What the Transfer With the ~ rans fe r  menu, you can select a target instrument. YOU can 
set up communication parameters, between your computer and the 

Menu Does target instrument, with the ConfigurelChangelnrtrurnent option. 
Once the parameters are set, you use the Acquireand Send com- 
mands to transfer waveforms. You can Acquirea waveform from a 
specific instrument and Send a waveform to the target instrument. 

Configurelchange Thiscommand isusedfortwopurposes: 

lnstrument 
To configure new instruments on the bus. 

W To select the target instrument. 

When Configure/Changelnstrument is selected, the dialog box in 
Figure 11 -1 appears. 

Figure 1 1 - 1. 
Con figure/Change Instrument 

Dialog Box. 
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I ConfigureXhange Instrument 

Configuration List This list displays the current instrument configurations. It shows the 
name, the driver, the communication port, and the communication ad- 
dress assigned to each intrument. 

An entry can be modified by selecting the instrument from the list. 
Selecting an entry highlights it and places the parameters in the ap- 
propriate edit boxes below the list box. Changes are made in these 
edit boxes and the "Change" button. This makes the changes a per- 
manent part sf the configuration list. 

There are two special symbols that may be displayed to the left of the 
instrument name. The "'>'symbol identifies which instrument is cur- 
rently the target instrument. The "*" symbol identifies an intrument as 
"acquistion-only". An "acquisition-only" instrument cannot be selected 
as the target instrument, and a warning is displayed if you try to do so. 

Acquisitiononly lntruments "Acquisition-only" intruments can only be used to acquire a waveform 
into WaveWriter "Acquisition-only" instruments cannot be made the 
target intrument. They can be configured the same as any other instru- 
ment and will appear in the Acquire dialog box. 

Selecting aTarget lnstrument To select the target instrument, either point to the entry with the mouse 
and double-click the left mouse button, or, with the keyboard, highlight 
the entry with the arrow keys and press -II When an instrument 
is selected, the parameters associated with that instrument are dis- 
played in the editing area below the Configuration List. 

Configuration List 
Parameters 

Configuration Name This edit box is for creating or modifying names that uniquely identify 
each instrument and its configuration. You can enter up to 12 al- 
phanumeric characters for each name. When an entry has been 
selected from the Configuration List, this edit box displays the con- 
figuration name - you can accept it or modify it. 

Driver Name This list box shows the software device drivers that are available to sup- 
port various instruments. Highlight an entry from this list to select a 
driver. 

Port Name This list box shows the hardware ports or (busses) available for trans- 
ferring data. Highlight an entry from this list to select a port. 

DeviceAddress This group box has edit boxes for defining different parts of a specific 
instrument address. The labels that define the edit box contents 
change, depending on the requirements for the bus selected in the 
Ports list box. If a GPIB Bus is selected, enter in the Primary and 
Secondary addresses as a number between 0-31. If a VXI bus is 
selected, enter in the Primary address as a number between 0-31 
(GPIB VXI only), and the Logical address as defined by the resource 
manager (e.g, dev00). 

- 
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Configure/Change Instrument 

Action Buttons 

Add When Add is selected, the configuration specified in the lower edit and 
list boxes is added as a new entry in the Configuration List box. 

Change When Change is selected, the configuration specified in the lower edit 
and list boxes replaces the parameters of the currently highlighted 
entry in the Configuration List box. 

Delete When Delete is selected, the currently highlighted entry is removed 
from the Configuration List box. Note, however, that you can not 
delete the current target instrument. 

OK When the Configuration List is the way you want it set, select the OK 
command button. If you have just created a new configuration, or if 
you have modified an existing configuration, and Add or Change have 
not been selected, you are asked if you want to save the configuration. 
After your reply, you are returned to the main menu. 

If the target instrument has been changed, the program checks to in- 
sure that the clock rate is valid. if it is not, you are prompted for the 
nearest available clock rate. If none of the options is acceptable, use 
the Change Clock Rate command in the Display menu to select an 
appropriate rate. 

If the amplitude of the current waveform exceeds limits dictated by the 
newly selected target instrument, the vertical axis scale may be ad- 
justed. - 

Cancel The Cancel command button aborts the Configure function and 
returns you to the main menu. All changes are abandoned. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Configure/Changelnstrument dialog box, 
select the Control-menu box and then select Close. 
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The Acquire Command I 

The Acquire 
Command 

l n ~ f  ~lJtYlenf List When Acquire is selected, a list of configured instruments similar to 
the one in Figure 11 -2 is displayed. Only instruments that have been 
configured with the Configure/Changelnstrument option appear in 
this list. If only one instrument has been configured, this dialog box is 
bypassed and only the instrument-specific dialog box is displayed. 

If the dialog box in Figure 11-2 is displayed, select an instrument from 
the list by highlighting the entry and selecting the OK command but- 
ton. An instrument-specific dialog box is then displayed and you are 
prompted for specific instrument parameters. To see the correct dialog 
box for an instrument, find the instrument-specific description later in 
this section. 

Figure 11 -2. 
Acquire 

Dialog Box. 
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I AFG 51 01/5501 Arbitrary Function Generator 

AFG 51 0115501 
Arbitrary Function 

Generator 

Acquire You can acquire a waveform from either Bank 1 or Bank 2 of the 
AFG 5101/5501. Each bank can store a waveform of up to 8192 points. 
The dialog box shows the current settings of the instrument. When you 
modify parameters in the Acquiredialog box, those settings are 
changed at the instrument when OK is selected. When this instrument 
is selected, the dialog box in Figure 1 1-3 appears. 

Figure 11 -3. 
AFG 5101/5501 

Acquire Dialog Box. 

Begin Iddr: 101 - 
End Iddr: 181911 

Bank Number: 

0 Replace Current Uavef orm 
@ Create New Waveform 

Uaxeform Name: -1 
[ T I  (-1 (H.lp) 

Begin Address This is the beginning address of the waveform to acquire. The valid 
range is from 0 to 8191. 

End Address This is the ending address of the waveform to acquire. The valid range 
is from 0 to 8191. 

Bank Number You can acquire data from either Bank 1 or Bank 2. 



AFG 51 01/550 1 Arbitrary Function Generator 1 
Destination When the waveform is acquired, you have a choice of how to store it: 

E Replace the current waveform - The current waveform is over- 
written by the acquired waveform. The acquired waveform record 
length is the new current record length. 

E Create a new waveform - You are prompted for a new 
waveform name. The acquired waveform becomes the current 
waveform. The previous current waveform is now a background 
waveform. 

C ~ n f ~ r m a I ' l ~ e  to Target If the acquired waveform data doesn't conform to system parameters 
set for the target instrument, voltage data and timing data are affected. 

Voltage If the acquired waveform amplitude exceeds the display window limits, 
the waveform is clipped on the display. Data is not lost. 

Clock Rate If the clock rate doesn't match, a warning is displayed and you are 
prompted to choose one of the following solutions: 

Change the clock rate for the incoming waveform to match the 
system clock rate. 

E Massage (expand or compress) the incoming waveform to main- 
tain a timing match. (See HorizontalResolution, Section 6.) 

Change the system clock rate to match the incoming waveform. 
Note that if there are other waveforms loaded (displayed), their 
clock rate is changed as well. (See Change Clock Rate, Sec- 
tion 7.) If the incoming clock rate is not valid for the selected tar- 
get instrument, this option is grayed and unavailable. 

E Cancel the acquisition. 

OK When OK is selected, the waveform is acquired, loaded in memory, 
and displayed as the current waveform. 

Cancel Select Cancel to abort this function and return to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Acquiredialog box, select the Control-menu 
box and then select Close. 



2200 Series Digital Storage Oscilloscope 

2200 Series Digital 
Storage 

Oscilloscope 

Acquire When this instrument is selected, you are prompted to select one of 
the sources: ACQ or REFl through REF4. If the Create New 
Waveform option button is selected, an edit box appears with the 
name of the selected source as the default. If you want a different 
name, edit this text. 

Figure 1 1-4. 
2200 Series Digital 

Storage Oscilloscope 
Acquire Dialog Box. 

0 Rr?j>X.iir:cr Cur.~.c?<\t. #ihvc?4:ox.~*, 

@ c r e a t e  f l e w  Waveform 

Name: I CICQ I 

L O C ~ ~  ion In the Location group box you select which waveform in the 2200 you 
want to acquire. If a source in the group box is grayed it means there 
is no waveform in that memory location. If you select ACQ it will ac- 
quire from the acquisition memory. If you select REFl through REF4 it 
will acquire from the corresponding reference memory. If your instru- 
ment only has one reference memory available, then only one Refer- 
ence choice is available. 

Destination When the waveform is acquired, you have a choice of how to store it: 

Replace the current waveform - The current waveform is over- 
written by the acquired waveform. The acquired waveform record 
length is the new current record length. 

H Create a new waveform - You are prompted for a new 
waveform name. The acquired waveform becomes the current 
waveform. The previous current waveform is now a background 
waveform. 
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Name Enter a valid name for the waveform to be acquired. 

C ~ n f ~ r m a n ~ e  to Target l f  the acquired waveform data doesn't conform to system parameters 
set for the target instrument, voltage data and timing data are affected. 

Voltage If the acquired waveform amplitude exceeds the display window limits, 
the waveform is clipped on the display. Data is not lost. 

Clock Rate If the clock sate doesn't match, a warning is displayed and you are 
prompted to choose one of the following solutions: 

Change the clock rate for the incoming waveform to match the 
system clock rate. 

Massage (expand or compress) the incoming waveform to main- 
tain a timing match. (See HorizontalResolution, Section 6.) 

Change the system clock rate to match the incoming waveform. 
Note that if there are other waveforms loaded (displayed), their 
clock rate is changed as well. (See Change Clock Rate, Sec- 
tion 7.) If the incoming clock rate is not valid for the selected tar- 
get instrument, this option is grayed and unavailable. 

Cancel the acquisition. 

OK When OK is selected, the waveform is acquired, loaded in memory, 
and displayed as the current waveform. 

Cancel Select Cancel to abort this function and return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Acquiredialog box, select the Control-menu 
box and then select Close. 



2400 Series Digital Storage Oscilloscope 

2400 Series Digital 
Storage 

Oscilloscope 

Acquire When this instrument is selected, you are prompted to select one of 
the sources: CHI, CH2, ADD, MULT; or REF1 through REF4 If the C r e  
ate New Waveform option button is selected, an edit box appears 
with the name of the selected source as the default. If you want a dif- 
ferent name, edit this text. 

Figure 11 -5. 
2400 Series Digital 

Storage Oscilloscope 
Acquire Dialog Box. 

Locarion 

0 CHZ 0 REEZ 

0 ADD 0 REF3 

I 0 Beplace Current  uaueforn  I I @ c r e a t e  Hew Waueform 

O l d j u s t  g a v e w r i t e r  l m p l i t u d e  t o  
F u l l  Scope Range 

Destination When the waveform is acquired, you have a choice of how to store it: 

H Replace the current waveform - The current waveform is over- 
written by the acquired waveform. The acquired waveform record 
length is the new current record length. 

Create a new waveform - You are prompted for a new 
waveform name. The acquired waveform becomes the current 
waveform. The previous current waveform is now a background 
waveform. 



2400 Series Digital Storage Oscilloscope I 
Name Enter a valid name for the waveform to be acquired. 

Adjust Amplitude to Full If this check box is selected (unselected is the default), the Waveform 
Scope Range DisplayArea will be scaled to the full range of the oscilloscope display 

(1 0.1 2 divisions) at its current Volts/division setting. 

C~tIformance to Target If the acquired waveform data doesn't conform to system parameters 
set for the target instrument, voltage data and timing data are affected. 

Voltage If the acquired waveform amplitude exceeds the display window limits, 
the waveform is clipped on the display. Data is not lost. 

Clock Rate If the clock rate doesn't match, a warning is displayed and you are 
prompted to choose one of the following solutions: 

W Change the clock rate for the incoming waveform to match the 
system clock rate. 

Massage (expand or compress) the incoming waveform to main- 
tain a timing match. (See Horizontal Resolution, Section 6.) 

W Change the system clock rate to match the incoming waveform. 
Note that if there are other waveforms loaded (displayed), their 
clock rate is changed as well. (See Change Clock Rate, Sec- 
tion 7.) If the incoming clock rate is not valid for the selected tar- 
get instrument, this option is grayed and unavailable. 

W Cancel the acquisition. 

OK When OK is selected, the waveform is acquired, loaded in memory, 
and displayed as the current waveform. 

Cancel Select Cancel to abort this function and return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Acquiredialog box, select the Control-menu 
box and then select Close. 
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1 1000 Series Oscilloscopes 

1 1000 Series 
Oscilloscopes 

Acquire When this instrument is selected, the following dialog box appears 
from which is selected the source and destination of the waveform. 
Two types of waveforms are available, trace waveforms and stored 
waveforms. The waveform description that was stored with the 
waveform is also displayed to help the user identify the waveform. 

Figure 1 1-6 
11000 Series Digital 

Storage Oscilloscope 
Acquire Dialog Box 

T r a c e  S t o r e d  
U a u e f  o r m  U a u e f  o r m  

O 5 e p l a c e  C u r r e n t  W a v e f o r m  

@ C r e a t e  y e w  U a u c f o r m  

Nan.: klqa 1 
t l d j u r t  H a u r U r i t e r  A m o l i t u d e  
t o  F u l l  S c o p e  

Source TheTraceWaveform list box displays the active traces currently dis- 
played on the scope. If there are no active traces available, then a mes- 
sage EMPTY is displayed in the listbox. 

The StoredWaveform list box displays the list of stored waveforms in 
the scope. If there are no stored waveforms available, then a message 
EMPTY is displayed in the listbox. 

When you click once on one of the entries in the listbox, its trace 
description appears in the TraceIStoredDescription scroll box and 
the waveform name is displayed in the Source Name Edit box. The 
name may be changed by editing the contents of the edit box. 

Clicking on the GVPN selection in the list box displays the message 
"No Traces Defined" in theTrace1Stored Description Edit box and the 
OK button is grayed. 
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Double clicking on the EMPNselection or the "white space" of the 
listbox causes an Error dialog box to appear with the message 
"INVALID SOURCE SELECTED". 

Note: If there are no Traces defined on the scope and there 
are no stored waveforms available in the scope then 
an error message is displayed with "No Valid Sources 
Availablen, and the 11000 Series Acquisition dialog 
box is not displayed. 

Trace 1 Stored This scroll box displays the waveform description that is stored with 
Description the waveform. It automatically updates when you select a source from 

the Trace Waveform or Stored Waveform listboxes. 

Note: The contents of the box may be changed, but the 
changes are ignored and have no effect. 

Destination When the waveform is acquired, you have a choice of how to store it: 

Replace the current waveform - The current waveform is over- 
written by the acquired waveform. The acquired waveform record 
length becomes the new current record length. 

Create a new waveform - You are prompted for a new 
waveform name. The acquired waveform becomes the current 
waveform. 

Name Whenthe NEW is selected, the SOURCE NAME edit box appears. 
The name of the selected source becomes the default name, but this 
name may be changed to any valid MS DOS file name. If you select 
OK and that name already exists, an error message is displayed. If the 
name is unique and valid, a new WaveWriterwaveform is created and 
the waveform list is updated with the current name. 

Adjust Wavewriter If this check box is selected (unselected is the default), the Waveform 
Amplitude to Full Scope Display Area will be scaled to the full range of the oscilloscope display 

Range at its current volts/division setting. 

C ~ n f ~ r m a n ~ e  to Target If the acquired waveform data doesn't conform to system parameters 
set for the target instrument, the data values and their timing relation- 
ship are affected. 
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Data Values If the acquired waveform amplitude exceeds the display window limits, 
the waveform is clipped on the display (assuming that Adjust 
Amplitude to Full Scope Range is not checked). However, the data is 
not lost and may be viewed by setting the AxisRanges appropriately. 
Note however that data clipped on the scope is clipped within Wave 
Writer. 

Clock Rate If the waveform clock rate doesn't match the system clock rate, a warn- 
ing is displayed and you are prompted to choose one of the following 
solutions. 

Change the clock rate for the incoming waveform to match the 
system clock rate. 

Massage (expand or compress) the incoming waveform to main- 
tain a timing match. (See Horizontal Resolution, Section 6) 

Change the system clock rate to match the incoming waveform. 
Note that if there are other waveforms loaded (displayed), their 
clock rate is changed as well. (See Change Cbck Rate, Sec- 
tion 7) If the incoming clock rate is not valid for the selected tar- 
get instrument, this option is grayed and unavailable. 

Cancel the acquisition. 

OK The OK push button is only enabled when a valid source is selected 
and a name has been typed into the SOURCE NAME edit box. If you 
double click on an invalid source, an error message is displayed: "ln- 
valid source selected". Once a valid source has been selected, a name 
is placed in the SOURCE NAME edit box, and the OK button is 
pressed, the 11 000 series waveform is transferred into WaveWriter 

Note: Wavewriter does not control the acquisition of the 
11000 Series oscilloscope. You must ensure that the 
waveform is completely acquired before transferring 
into Wave Writer For example, if the selected source 
is a 32K envelope, it is possible to transfer an incom- 
pleted envelope into Wave Writer. In this case, valid 
data cannot be guaranteed. 
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Note: It is a feature of the 11 000 series oscilloscope to 
transfer only that portion of the waveform that is on 
the scope screen. Any data off the leff end or off the 
ruht end of the scope screen is not transferred into 
Wave  write^ For example: You have acquired a 1 OK 
waveform on an 1 1403 and expanded the waveform to 
view only the falling edge of the pulse. Only that fall- 
ing edge will be transferred, not the entire 1 OK 
record- This is useful if you want to perform partial 
waveform transfers- To transfer the entire waveform 
record, you must have PAN/ZOOM OFF or magnifica- 
tion 1x selected. 

CANCEL Selecting the CANCEL button will remove the dialog box from view 
and cancel the transfer operation. No waveform will be transferred into 
Wave Writer 

HELP Selecting this button provides context sensitive help. A dialog will be 
displayed with helpful descriptions of each button in the 11 000 Series 
Acquisition Dialog Box. 
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VX5260 Digitizer 

A C ~ U  ire When the VX5260 is selected, the dialog box in Figure 11 -7 appears. 
This dialog box allows you to enter VX5260 parameters, read a VX5260 
record, and determine how the waveform is stored in WaveWriterAd- 
ditionally, you can display VX5260 record information and send com- 
mands to the VX5260 via a talkerllistener. 

Figure 11-7. VX5260 Digitizer Acquire 
Dialog Box 

5260 Parameters 

Record Coc: ............... 
............... 

Record I n f o r m a t i o n )  

T a l k e r Y L i s t e n e r  

O ~ e ~ l a c e  Current Uaueform olt ) 
@ C r e a t e  New Waveform 

Name : 
( - )  - C l j e l p )  

VX5260 Parameters These parameters allow you to select a VX5260 record, select which 
part of the record to transfer, display record information, and send 
commands to the VX5260. 

I Record Loc -This selects which VX5260 record location to 
read. Enter a number in the range 1 to 128. 

I EntireRecord -This causes an entire VX5260 record to be 
read. If the record length is greater than the current Wavewriter 
maximum (32767 points), then the record can only be read by 
selecting Partial and doing multiple reads. 

I Partial-This causes part of a VX5260 record to be read. When 
this control is selected, the Start and Count edit boxes appear. 

Start-This selects where in the record the transfer begins. 
Enter a number in the range 0 to 16382 (if 16K of VX5260 acquisi- 
tion memory), or 0 to 131070 (if 128K of acquisition memory). 

Count -This selects how many data points to transfer. Enter a 
number in the range 2 to 32767. A warning message will be dis- 
played if Start + Count exceeds the VX5260 record length. 
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Record Information-Displays VX5260 record information as 
shown in figure 11-8. If the record is empty, a warning message 
is displayed. 

TalkerIListener-Displays theVX5260 TalkerIListenerdialog 
box as shown in figure 11 -9. This dialog box allows you to send 
commands and/or queries to the VX5260. 

Destination 
Replace Current Waveform -The current Wavewriter 
waveform is replaced by the new waveform. The waveform 
length is adjusted to fit the new waveform. 

Create New Waveform -A new Wavewriter waveform is 
created. This waveform becomes the current waveform and the 
previous current waveform becomes a background waveform. 
The Name edit box is shown and a name must be entered before 
selecting OK. 

Name Enter a valid MS-DOS name for the waveform. This edit box is shown 
when Create New Waveform is selected. 

OK When OK is selected, the waveform is read, loaded in memory, and 
displayed as the current waveform. 

Cancel Select Cancel to abort this function and return you to the main menu. 

Help Select the Help button to display informative text relating to this opera- 
tion. Use the scroll bar, if present, to read the entire help text. To return 
to the Acquiredialog box, select the Control-Menu box and then 
select Close. 
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VX5260 Record 
Information 

Figure 1 1-8. VX5260 Record Informa- 
tion Dialog Box I Data:  N o r m a l  Rate: I OnS 

Length: 1024 Of fset :  0 U 

Clock: Internal Clmp: 10 U 

Data -The data type (Normal, Envelope, or 16-bit). 

Length- The record length (Number of points). 

W Clock -The sampling clock source (Internal or External). 

Rate -The sample rate in seconds (If internal clock). 

W Offset - The waveform offset in Volts. 

Amp -The waveform amplitude in Volts (Not displayed for 
averagedwaveforms). 
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VX5260 Digitizer 

VX5260 Tal kerlListener 

Figure 11-9. VX526Q Paker/Listener 
Dialog Box 

Command -Enter the VX5260 command or query. Up to 256 
characters can be entered. 

Response-The response to a VX5260 query command is dis- 
played here. Up to 2200 characters can be displayed. The scroll 
bar can be used to display text not in the Response box. If a 
response is longer than 2200 characters, then only the first 2200 
characters are displayed. 

Send -This button sends the command to the VX5260. Pressing 
the Enter key will also send the command to the VX5260. 

Quit -This button quits the dialog box. Pressing the Escape key 
will also quit the dialog box. 
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I The Send Command 

The Send With the Send command you can transfer, to the target instrument, all 
of the current waveform 'r a portion of it defined by the Staft and Stop 

Command mahers. 

When Send is selected, an instrument-specific dialog box appears. 
The actual dialog box displayed depends on the current target instru- 
ment (see Configure/Changelnstrurnent). 
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AFG 51 01 15501 
Arbitrary Function 

Generator 

Send You can send the current waveform to either Bank 1 or Bank 2 of the 
AFG 51 01/5501. Figure 11 -1 0 shows the AFG510115501 Send dialog 
box. 

Figure 1 1- 10. 
AFG5101/5501 

Send Dialog Box. 

...................................... - ............ , 
@:send .................... Wavef ormi 

II ............................ 
0 Send Waveform Between Markers  

Bank Number: 

Begin I D O R :  101 - 
F i l t e r :  

Output Anpl i tude:  14 ] U ( 5 0  Ohms 

Time per  Po in t :  [100n I S - 

I(T) (-1 (Help) I 

Pr~ceSSitlg Region You can select either the entire waveform or the portion between and 
including the markers. 

Bank Number You can send to either of 2 bank memories, Bank I or Bank 2 

Beginning Address This is the beginning address of the waveform at the selected bank. 
Enter an integer in the range 0 to 8191. 



r AFG 51 01/550 1 Arbitrary Function Generator 

Filter The waveform to be sent can be filtered. Select one of the following: 

0 = no filter. 

1 = 1 MHz low-pass. 

2 = 100 kHz low-pass. 

3 = 11 kHz low-pass. 

4 = 1.3 kHz low-pass 

Output Amplitude This sets the peak-to-peak output voltage (into 50 Ohms) to the value 
specified. The default value is the current amplitude as displayed. Valid 
values are in the range of 0.01 to 9.99 Volts. 

Offset This sets the offset voltage of the output signal. The default is the cur- 
rent off set value stored in the WaveformList, if any. The Output 
Amplitude and Offset must conform to the relationship: 

amplitude / 2 + offset = Absolute peak amplitude + offset 
(into 50 Ohms) 

AmplitudeRange Peak Amplitude + Resolution into50 
Absoluteoffset into Ohms 
50 Ohms 

Time per Point This sets the clock rate or internal trigger interval. The default is the 
system clock rate. Valid values are in the range of 100 nanoseconds to 
999.9 seconds. 

OK When OK is selected, the current waveform is transferred, and dis- 
played or regenerated on the target instrument. 

Cancel Select Cancel to abort this function and return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Send dialog box, select the Control-menu box 
and then select Close. 
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2400 Series Digital 
Storage 

Oscilloscope 

Send You can send the current waveform to a reference memory location in 
the 2400 Series DSO. When Send is selected, the dialog box in Figure 
1 1-1 1 is displayed. 

Figure 1 1- 1 1. 
2400 Series Digital 

Storage Oscilloscope 
Send Dialog Box. 

@ Send Havef  orm 

O ~ e n d  Uaveform Between Markers  

L o c a t i o n  

V e r t i c a l  P o s i t i o n  

n~et  U a v e U r i t e r  S c r e e n  0 . 0  v o l t s  t o  
O s c i l l o s c o p e  c e n t e r  g r a t i c u l e .  

E n t e r  v e r t i c a l  p o s i t i o n  @ V o l t s  
o f  ground r e f e r e n c e :  )D (-3 ~ i ~ i ~ i ~ ~ ~  

(7 (-3 (Yelp) 

Processing Region You can select either the entire waveform or the portion between and 
including the markers. 

Location Option buttons REF1 through REF4 to select destination memory loca- 
tion. 

PartialWaveform The next two choices only appear if Between Markers is selected and 
there are less than 1024 points in the Processing Region (or if the en- 
tire waveform has less than 1024 points.) 

Start At - Edit box to align waveform at desired horizontal point on 
the oscilloscope screen. 

Don't Care Fill-in - Check box sets envelope outside of the 
markers, to Minimum and Maximum I evels if the check box is 
selected. (Envelope waveforms only) 
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VerticalPosition Set WaveWriter Screen 0.0 Volts to Oscilloscope Center Graticule 
-Aligns the Waveform DisplayArea 0.0 Volt level with the vertical cen- 
ter of the oscilloscope graticule. 

Enter Vertical Position of Ground Reference - As an alternative to 
the previous choice, enter a ground reference in this edit box. Choose 
either Volts or Divisions with the option buttons. 

OK When OK is selected, the current waveform is transferred, and dis- 
played or regenerated on the target instrument. 

Cancel Select Cancel to abort this function and return you to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Send dialog box, select the Control-menu box 
and then select Close. 
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VX579OArbitrary Waveform Generator 1 

VX5790 Arbitrary When this instrument is selected you can send data from Wavewriter 

Waveform See the VXI Instruction Manual. 

Generator 

Send When Send Sequence is selected, the dialog box in Figure 11-12 is 
displayed. 

Figure 1 1 - 12. 
VX5790Send 
Dialog Box. 

O ~ e t w e e n  M a r k e r s  Not  D i v  by Eight 
@ E n t i r e  Waveform 0 {lag? t l t r x t  t . . ; h x . g < r r .  

0 g i n a r y  Format @ u s e  n e x t  S m a l l e r  
@Hexadecimal. Format 

m l n c l u d e  Imbedded Clddresses 

a ~ o w n l o a d  P a c k e t  and Execute  

O ~ o w n l o a d  P a c k e t  

P a c k e t  Index:  

Sequence Index:  

Processing Region Select how much of the length of the waveform is to be sent: If the 
number of points sent is 2048 or less, data is transferred with the VXI 
SHAPE command. Otherwise, the CURVE command is used. 

R Only the portion of the waveform between and including the 
markers 

R The entire waveform. 

Transfer Format: Select whether the waveform is to be sent in Binary or Hexadecimal 
format. Binary data is more compact, but is not directly viewable. 
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Not Divisible by Eight This group box is only displayed when the number of data points to be 
sent is not a number divisible by eight (this is a VX5790 hardware re- 
quirement). 

If Between Markers has been selected, you can choose Use Next 
Larger to transfer the next larger size waveform that is divisible by 
eight -or you can choose Use Nextsmaller to transfer the next 
smaller size waveform divisible by eight. 

If Entire Waveform has been selected, Use Next Smaller is your only 
option - Use Next Larger is grayed and can't be selected. 

Include Imbedded When saving a sequence for a VX5790 using a VXI resource manager 
Addresses that understands imbedded addressing (such as the Tektronix 

VX5520), select this check box and the logical address defined in the 
Configure/Changelnstrument command is included in the 
parameters saved. If this check box is not selected, the sequence is 
saved without specifying the logical address. 

Download Packet and This radio button causes the waveform data to be sent using the Curve 
Execute command which automatically packetizes the data and builds a se- 

quence. This sequence is then executed making the waveform avail- 
able at the VX5790 output connector. 

Download Packet This radio button causes only the packet data to be sent. The se- 
quence editor must be used to build a sequence containing this pack- 
et before it will be available at the VX5790 output connector. 

If the waveform length is greater than 2048, this radio button is grayed 
since the maximum single packet is 2048 points. 

Packet lndex This edit box displays the packet index taken from the cross reference 
file. If you wish to override this default, enter a different value. 

Sequence lndex This edit box appears whenever a sequence will be built, e.g., when 
the waveform size is larger than the maximum packet size (2048 for 
the VX5790), or Download and Execute Packet is selected. 

Packets start at the specified Packetlndex and the sequence is refer- 
enced by the Sequence Index. 

Offset Enter an external offset value associated with this waveform. 

Cross Reference File The Cross Reference File is automatically created and maintained by 
the VX5790 driver. The driver converts a sequence file (containing 
filenames and repetitions) to a VX5790 specific file by replacing 
filenames with packet numbers. See Appendix C. 
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As long as you build all your sequences with the same cross reference 
file, you don't need to be concerned about two packets using the 
same packet index or one packet being referenced by two different 
packet indexes. 

OK Select the OK command button to send the waveform data to the 
VX5790. 

Cancel Select the Cancel command button to abort the Send command and 
return to the main menu. 

Help Select the Help command button to display informative text relating to 
this operation. Use the scroll bar, if present, to read the entire help 
text. To return to the Send dialog box, select the Control-menu box 
and then select Close. 

wave Writer USER GUIDE 



Appendix A 
MENU MAP 

WawWiter Main Menus 

File 
New ... 
Open ... 
Save ... 
Hardcopy ... 
Exit 
About ... 

- 

Edit 
Undo 
ClearWaveform(s) ... 
Cut Between Markers 
Copy Between Markers 
Delete Between Markers 
Insert at Start Marker 
Replace Between Markers 
Append to End of Waveform 
Flip Horizontal Between Markers 
Flip Vertical Between Markers 
Horizontal Resolution ... 
VerticalResolution ... 

Display 
Redraw Dot 
Redraw Vector 
Zoom In 
Zoom Out 
Set Axis Ranges ... 
Autoscale Current Waveform 
Change Clock Rate ... 
Change Current Waveform 
Show Crosshairs 
Set Colors & Line Styles ... 

Draw 
Nodraw 
Freehand 
Horizontal 
Vertical 
Autoline 
Envelope Max Don't Care 
Envelope Min Don't Care 
Envelope Max 
Envelope Min 

Transfer 
ConfigureIChange Instrument ... 
Acquire ... 
Send ... 

Help 

Create 
Equation ... 
Sine ... 
Triangle ... 
Pulse ... 
Square ... 
EnvelopeTolerance ... 
Envelope Couple ... 
Envelope Decouple ... 
Sequence ... 

SigProc 
Add Scalar ... 
Multiply by Scalar ... 
Add Waveforms ... 
Subtract Waveforms ... 
Multiply Waveforms ... 
DivideWaveforms ... 
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I Quick Reference 

Appendix B 
QUICKREFERENCE 

The File Menu (Section 5) Disk input/output commands. lntitializes Wavewriterwhen 
starting a new waveform. 

New sets up for creation of normal or envelope waveform. 

@ Normal yaueforn 

(7) (-1 [Hclp) 



Quick Reference 

Open Retrieves and loads an existing waveform from disk. 
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Open F i l e  Name: 

[mi 

F i l e s  i n  C:\WW - 
1KSINENU.RDF 
fiNSWER1 .RDF 

2 

BONK1 .RDF 
CHI . RDF 
CHI ENU . RDF 
SINE .ODF (T) 
SINE8192.nDF 
[ - - I  (-1 
[HELP] 
[-R-1 
[ + - I  

[Help] 
1-c-I  
[-D-] 





Quick Reference 1 
Hardcopy Prints WaveformDisplayArea to printer or plotter. 

P r i n t e r s  

HP P l o t t e r  

( Conf i s u r e  - 0  k  ( - C a n c e l  - H e l p  

Exit Exits Wavewriterand returns to Wndows, prompting you to save 
waveforms which have been altered. Saves Wavewriterconfiguration. 

About Displays Wavewriterprogram information. Includes version number 
and available memory. 

U a v e U r i t e r  < T M )  
V e r s i o n  1.1 

C o p y r i g h t  Q 1 9 8 9 .  1 9 9 0  by T e k t r o n i x .  
Memory A v a i l a b l e  1 4 3  K b y t e s  

O K i  



Quick Reference 

The Edit Men U (Section 6) Modifies a waveform without redrawing. The ~ d i t  Buffer is 
available for multiple insert, replace, and append operations. Data is 
replaced by another cut or copy operation. 

Undo Cancels the most recent change to the current waveform. 

Clear Waveform(s) Removes specified waveforms from memory. 

Cut Between Markers Removes the region of the current waveform between and including 
the Start and Sop markers and stores it in the edit buffer. 

COPY Between Markers Copies the region of the current waveform between and including the 
Start and Sop markers and stores it in the edit buffer. Current 
waveform is not changed. 

Delete Between Markers Deletes the region of the current waveform between and including the 
Start and Stop markers. Deleted data is not saved in the edit buffer. 
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Quick Reference 

~.ssj~lr I i( I -71 i( r I IUIH~ nsjClr lncPrrc a rnnv nr rno pnlr nl lrrpr lnrn rnp rl lrrenr wavprnrm nprnrp rnp ... wrr. r rrr rrr-. r ...-. ..-. Illu-lru u vvr, v. .mmv "urn. uu..r. .... r ... r rr..r... ..-. " a " . . . .  -.-.-.- ..... 
Start Marker. 

Replace Between Markers Replaces the current waveform between and including the Start and 
Stop markers with a copy of the edit buffer. 

Append to End Appends a copy of the edit buffer to the end of the current waveform. 

of Waveform 

Flip Horizontal Between Reverses the timing of the current waveform between and including 
Markers the Start and Stop markers. 

Flip Vertical Inverts the current waveform between and including the Start and 
Between Markers Stop markers around 0 Volts. 

Horizontal Resolution Expands or compresses all or a portion of the current waveform along 
the horizontal axis. 

NOTE Changing horizontal resolution doesn't change clock 
rate. 

I [Processing Region I I 
O E n t i r e  Wfn @Between Markers 

Seconds Po in t s  
I n t e r v a l  Between Markers: Stop - S t a r t  = 300u 300 

k w  I n t e r v a l :  1 7  0 Seconds 

@-points 

Transforn tlethod: O r i g i n a l  Data t o  New Data 

@Nearest Be la ted Po in t :  Preserues Steps (Faster )  1 I I I O r h o r t  Function: General Purpose (Standard) I I 
I / 0J.onger Funct ion:  Preserues Sine Yaues (Slower) I / 

I r Use Data Beyond Markers For Hew Data Ca l cu la t i on  

@ y e s  (Where fluailable) 1 I 
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I Quick Reference 

Vertical Resolution Modifies waveform data to simulate a lower vertical resolution. 

NOTE Once the bit level has been changed, it can't be 
returned to a higher resolution. The previous 
waveform data can't be recovered. Always save the 
higher bit level waveform if the data needs to be 
retained. 

Current  Waveform Step Resolut ion:  12 B i t s  I 
Simulated Step Resolut ion:  11 B i t s  - 

Processing Region 

@ E n t i r e  Waueform 

O B e t w e e n  Markers 

I c a n c e l  1 
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Quick Reference 

I ne Ul Splay IVlen U (Section 7) Sets the attributes of the screen presentation. 

Redraw Dot Displays waveforms in dot format. 

Redraw Vector Displays waveforms in vector format. Uses currently selected line 
styles. Line styles will not be visible unless data points are far enough 
apart. 

 ZOO^ In Magnifies a portion of the WaveformDisplayArea. 

 ZOO^ Out Restores the display to that set by Set AxisRanges. 

Set Axis Ranges Sets the vertical and horizontal axis scales for the WaveformDisplay 
Area 

V e r t i c a l  - H o r i z o n t a l  

nnpl i tude:  w 0 Seconds 
(Pk-Pk) @ P o i n t s  

S t a r t :  1 7 1  s t 5  - 



I Quick Reference 

Autoscale Current Automatically adjusts the horizontal and vertical axis scales to match 
Waveform the current waveform within target instrument limits. 

Change Clock Rate Sets the system clock rate. Affects all waveforms in memory. Dialog 
box that appears depends on the target instrument. 

Time per  Point :  - 
( o r )  
Frequency: - 

) Enter ONE of the following: 1 
I Iim Per Division: 7 1  s 

Tine p e r  ~ o i n t : [ T I  S 

Erequency: -1 Points / Second 

I U E x t e r n a l  Clock 

// Selected  Sec/Point  : 1 .28uS 
... 

S e l e c t e d  Frequency: 781.25K Hz ..... 

4 On 
8  On ... // ... 
16 On : ... 
32 On ... 

@ I n t e r n a l :  1 8  nsec 

0 E x t e r n a l :  7 1  ~ e c  



Quick Reference 

Change Current Displays the WaveformList to change the current waveform. Double- 
Waveform clicking on the WaveformList icon also brings up the Mveform List. 

Show Crosshairs Toggles between a small cross hair cursor and full-screen crosshairs. 
Coordinates of the cursor or crosshairs are displayed at lower left of 
Waveform Display Area. 

St?% Colors & Sets the attributes of waveforms and various screen elements. 
Line Styles 

Colors and S ty les  

f e l e c t i o n s  

Current Waueforn 

Labels h U n i t s  
Graph Background .:.:. .:> 
Background ... ... 

.:.:. 

.:.:. . . . 

Sample 

Sec 

L i n e  S t y l e s  

- - - - - - - 

u m m  
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I Quick Reference 

The Draw Menu (Section 8) TOOIS to modify an existing waveform. The 
pN'llTKI key is a cursor speed control. The coordinate display is 
continually updated with cursor movement. The right mouse button 
redraws the screen when in a draw mode. 

Nodraw The initial state. Turns off the current drawing mode. 

Freehand While drawing is enabled, all cursor movement is tracked for the 
waveform definition. 

Horizontal Same as Freehand, except that, while drawing is enabled, vertical 
movement of the mouse or direction keys is ignored. 

Vertical Same as Freehand, except that, while drawing is enabled, horizontal 
movement of the mouse or direction keys is ignored. 

Autoline Draws a sequence of line segments where the end point of one line is 
the start of the next line to be drawn. 

Envelope Max Similar to Horizontal Defines the extent of the "don't care" region in 
Don't Care the horizontal direction for the upper limit of the waveform envelope. 

Envelope Min Similar to Horizontal Defines the "don't care" voltage region in the 
Don't Care horizontal direction for the lower limit of the waveform envelope. 

Envelope Max Used with another drawing command to modify the upper limit of an 
envelope. 

Envelope Min Used with another drawing command to modify the lower limit of an en- 
velope. 
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Quick Reference 

Equation Creates or modifies waveforms using an equation. Adds, retrieves, and 
deletes equations to and from the equation library. 

Operators: ( ) + - * / A 

Functions: sqrt(x), sin(x), sine(x), cos(x), tan(x), asin(x), acos(x), 
atan(x), sinh(x), wsh(x), tanh(x), abs(x), ceil(x), floor(x), log(x), In(x), 
rand, and exp(x). 

Definitions: Stan and Stop points define the range of time (t) describ- 
ing the beginning and end of the waveform segment. 

For example, to produce a single cycle of a 1 kHz sine wave with a 2 
Volt peak-to-peak amplitude and a +1.5 Volt dc offset, enter the follow- 
ing parameters: 

Start point = 0 
Stop point = 999 
Clock = 1 ps 

(Use the Change Clock Rate command) 

The equation shown below follows the basic form for trigonometric 
functions, where: 

A = dc offset 
B = peak-to-peak amplitude 
F =frequency 
f = function 

For the equation: 

substitute the values for this example and enter in the Equation edit 
box : 

1.5 2.0 sin (2 pi 1000 t) 
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Quick Reference 

Envelope Tolerance Creates an envelope by adding vertical andlor horizontal tolerances to 
an existing normal or envelope waveform. 

I n p u t  Waveform: 7 1  

- V e r t i c a l  Tolerance 
Processing Region 

O y o l t a g e  Ualue @ E n t i r e  Waveform 

O P e r c e n t a g e  (Peak t o  Peak) OBetween  Markers 

0 Percentage (user Def ined)  

0 D i g i t i z i n g  Leue l  

Envelope Couple Uses two normal waveforms to define upper and lower limits of an en- 
velope. 

P i a x  U a v e f  o r n a  1 DSX-ZM~IX. ROF 

Plin W a v e f o r n ~  1 D S X - 2 ~ 1 ~ .  n D F  ] - 

E n v e l o p e  U a v e f o r n ~  - I I 
(7) - C a n c e l  ) (  el^ ) 

- - 
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[ Quick Reference 

Envelope Decouple creates two normal waveforms from an envelope waveform. 

Envelope Wavef ormr LDSX-2 

nlx O U ~ P U ~  ~ a v e ~ o r m :  [DSX-ZMRX. ADF I 

Sequence Creates a composite waveform by using an ordered series of 
waveform files. 

Saue F i l e  Name: C:\WW 

UNNCICIED 

Extension:  

I X ) u a u e ~ r i t e r  Format 

instrument S p e c i f i c  F i l e  W 
O ~ a k e  Backup 

(nu) [r- 
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Quick Reference 

The SigPt'oc Menu (Section 10) Modifies a waveform (or a selected portion of the 
waveform) either with a constant value or with another waveform. 

Add Scalar Adds a constant value to the selected portion of the current waveform. 

fidd S c a l a r :  - ] u  

Processing Region 

@ E n t i r e  W a v e f o r m  

0 ~ e t w e e n  Markers 

( - H e l p  3 

Multiply by Scalar Multiplies a selected portion of the current waveform by a constant 
value. 



1 Quick Reference 

Add Waveforms Adds two waveforms together in selected processing region. 

Displayed Wavef orns - 

Processing Region 

@ ~ n t i r e  Waueforn 

OBetween Markers 

Wfn 1: Wfn 2: Wfn 3: 

SU btract Waveforms Subtracts one waveform from another in selected processing region. 

Multiply Waveforms Multiplies two waveforms together in selected processing region. 

Divide W a ~ e f 0 r m ~  Divides one waveform by another in selected processing region. 
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Quick Reference I 

The Transfer Menu (Section I I )  Selects a target instrument. Sets up communication with 
the instrument. Acquires and sends waveform data. 

ConfigureIChange configures new instruments. selects target instrument. 
Instrument 

Acquire Acquires data from an instrument configured with the Configure1 
Changelnstrument command. If the acquired data doesn't agree with 
system parameters set for the target instrument, voltage and timing 
data are affected. Dialog box that appears depends on the selected tar- 
get instrument. 
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Quick Reference 

B e g i n  Rddr: I - 
End Clddr: WI 

Bank Number: 

I 0 Replace Currenr  Uauef arm 

Uavef orm Name: 1 u n t i t l e d  1 
I (or) (-1 (1.1.) 

L o c a t i o n  

0 R E F 1  0 R E F 2  

0 R E F Z  0 R E F 4  

0 Rt?#>l . ih t : t?  l : c ~ x . r . t ? c i t *  Uirur?iox.n 

@ c r e a t e  Hew Waveform 

Name: I ACQ I 

r 5 2 6 0  Paramete rs  I 

Record Coc: [1 a 0 .F ~ n t i r e  - . -.-. - . - .. Record ....... 
: - a r t i a i i  ....................... 

Record information - start: 1- 

O R e p l a o e  C u r r e n t  Waveform (Ok) 
@ C r e a t e  New Uauef  o r n  

Name: -1 

Trace Stored 
Uavef o r n  Wavef o r n  

Trace/Stored Descr io t ion  

"hVGCL1) O N  MhIN" 
+ I h.~:~.~i.;i:~~+ii:i_~:~.i:iii:::i:;.ii'+i>.i>i:,i~..1:,.'.~~. + 
0 Beplace Current Uavef orm 

Adjust MaveUr i ter  hno l i tude  
t o  Full Scooc 

(O*_) (-3 (Hclp] 

I 0 Replace Current  Waveform 

I @ C r e a t e  Mu Waueform 

Adjust  hlauewriter Anpl i tude t o  
F u l l  Scope Range 



Quick Reference 1 
Send Transfers all or a part of the current waveform to the target instrument. 

Dialog box that appears depends on the selected target instrument. 

................ " .............................. 
Q i3:en.d .... i i~uefor .~;  
O S e n d  Waveform Between f iarkers 

Bank Number: 

Begin CLDDR: 1 0  I - 
F i l t e r :  

Output I m p l i t u d e :  1 4 1  U ( 5 0  Ohms) 

Time p e r  P o i n t :  [100n  I S - 

@ Send Haveform 
O ~ e n d  Uaveforn Between narkers 

I ! 
[Partial Waveform-1 Location @ . . ; 

." ......... ".." 
o REFZ o  REF^ start fit: lo]: ::: 
Vertical Position 

Set UaveWriter Screen 0 . 0  volts to 
Oscilloscope center graticule. 

Enter vertical position @ Uolts 
of ground reference: 0 nivisions 

(0.) (-1 (F) 

0 s i n a r y  Format 
@ H e x a d e c i m a l  Format 

[ X l l n c l u d e  Imbedded Addresses 

 ownlo load Packet  and Execute  

O ~ o w n l o a d  Packet  

Packet  Index: r I  
Sequence Index:  [ O I  
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Quick Reference 

g P ~ 2 & ~ ~ ~ m ~ . ~ ~ J p a a & ~ ~ d ~ ~ , ~ a : E 4 ~ g v q ~ . g ~ ~ g g $ & ~ ~ f 2 g h ~ ~ J ~ ~ $ ~ ~ ~ . ~ ~ g g ~ ~ R R ~ { ~ ~ i ~ s $ ~ $ g a ~ ~ ~ E $ ~ ~ g m ~ ~ . ~ ~ E s & ~ 4 ~ ~ $ > j ~ i ~ ~ $ ~ ( ~ ~ ~ ~ > ~ > ~ J  

Help Displays help for a list of topics. 
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Appendix C 
File Structures 

The ADlF Format 

Introduction The Analog Data Interchange Format (ADIF) was an evolving standard 
within Tektronixlt has been adopted by the SCPl consortium as part of 
the SCPl standard. Version 1.0 is compatible with the SCPl version.Ver- 
sion 0.99 is used by some software packages such as TekTMS and 
SPD. ADlF makes it easier to share waveform and other analog infor- 
mation between various software packages and instruments that sup- 
port it. It is flexible, extendable, and can accommodate a wide range of 
data structures and formats. 

ADlF is a data object description language that "packages" a descrip- 
tion of the data along with the data itself. A minimum of information 
about the data is required, but there is a wide and rich range of infor- 
mation that can be optionally associated with the data. ADlF is capable 
of representing very complex data dimensioned sets, but its block 
structure permits simple data sets to be represented in an easy to un- 
derstand manner. 

ADlF is hierarchically structured, and as such, can be subordinate to 
other structures. It is suitable as a file format and can be easily trans- 
mitted across lEEE488.1/ lEEE488.2, RS-232, SCSI, Ethernet, and 
various other transmission media and protocols. 

While ADlF can represent digital and other kinds of structured data, it 
is somewhat cumbersome. The accomodation of digital data is one of 
several possible extensions to ADIF. 

What is included here is not a rigorous definition of ADIF. The SCPl 
specification is the definitive document. 



I The ADlF Format 

Overview ADIF is block structured. An ADIF data set generally consists of 
several description blocks and a data block. A block typically contains 
keywords and may contain subordinate blocks. Keywords may have 
one or more values. Some blocks require modifiers. Modifiers allow a 
block to have a value as well as contain keywords and subordinate 
blocks. Modifiers also allow multiples of the same block type to be uni- 
quely distinguished from one another. 

Each block addresses a different aspect of data description: 

STD Specifies the version of the ADlF standard used to create the ADIF 
data set, as well as any optional protocols. 

IDENTIFY Names the data set and describes the environment in which it was 
generated. The environment description includes project name, test 
number and series, date and time, and source. 

DIMENSION Dimension blocks specify the structure and format of data in the DATA 
(CURVE) blocks. Provision is made for data scaling, offset, naming, 
and units specification. The DIMENSION, ENCODE and ORDER 
blocks, taken together, completely describe the structure and physical 
format of the data in the DATA (CURVE) blocks. 

A dimension may be either explicit or implicit. An implicit dimension is 
one that is represented by a function instead of actual data values. A 
waveform represented by voltage readings taken at a constant time in- 
terval is an example of a data set with an implicit and explicit dimen- 
sion. The implicit dimension is the time dimension and is represented 
by a function instead of data values. The voltage dimension is explicit, 
with values present in the DATA (CURVE) blocks. 

ENCODE Specifies the encoding format for data in the DATA and ENCODE 
blocks. Also covered are signal values for underflow, overflow, and no 
value, as well as the range and precision of the data. 

TRACE Logically groups dimensions as functions, surfaces, sets, etc. TRACE 
blocks provide semantic information about the data and are used in 
the construction of VIEW blocks. They also provide a convenient and 
powerful mechanism for sub-setting data. 

DATA The data. Different subordinate blocks described dimensioned data, 
pulse parameter measurements, sine parameter measurements, statis- 
tical measurements, and point values. 



The A DlF Format 

Block and Keyword The following example listing of blocks and keywords show the ADIF 
Organization hierarchical structure. Blocks are followed by a pair of parentheses. A 

block followed by an ellipsis is a repeat of a previous definition; If multi- 
ple occurences of a block or keyword are permitted, it is marked with 
'l[m]''s 

The ADlF standard and revision control block: 
STD 0 

VERSION 

The ADIF environment description blocks: 
IDENTIFY ( ) 

NAME 
DATE 
TIME 
SOURCE 0 

PACKAGES 

The ADlF data structure and format blocks: 
DIMENSION = <dimension label> ( )  [ml 

NAME 
UNITS 
SCALE 
OFFSET 
SIZE 
ENCODE ( ) . . . 
NOTE 

The ADlF blocks for semantic information: 
TRACE = <trace label> 0 [ml  

NAME 
INDEPENDENT ( ) 

DIMENSION 0 [ml 
LABEL 
START 
STOP 

DEPENDENT ( )  

DIMENSION ( )  [ml 
LABEL 

The ADlF data block: 
DATA = <data label> 0 

CURVE ( )  

VALUES 
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The ADIF Format 

Sequence Ed itor sequence files are specified with an ASCII string in the following for- 
File Format mat. In the example, text in brackets is descriptive, not literal, and is to 

be replaced with actual data -the brackets and the descriptive text 
are not included in the actual data string. The symbols 'R and L~ repre- 
sent carriage return and line-feed, respectively. Text in parentheses is 
commentary and is not part of the format: 

S E Q ~ R ~ F  

[Full path to the packet file] [repetition  count^^^^^ (Packet 1) 

[Full path to the packet file] [repetition c ~ u n t ] ~ ~ ~ ~  (Packet 2) 

[Full path to the packet file] [Repetition  count^^^^^ (Packet n) 

The Fullpath to the packet file and the Repetition count fields are vari- 
able length fields separated by an ASCII blank. 

- - 
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The AFG hsfrumenf Speclflc Format I 

The AFG Data sent to the AFG 51 0115501 arbitrary waveform generators isfor- 

Instrument Specific mated as follows. Text shown here in parentheses is commentary and 
is not part of the .ISF format. Text shown in brackets is descriptive, not 

Format literal, and is to be replaced with actual data. Although each item in the 
example is shown on a separate line, the data is sequential -there is 
no implied carriage returnlline feed separator: 

OFFSETO; (Offset initialized; see text) 

AMPL [n.nn]; (Amplitude value) 

OFFSET [n.nn]; (Offset value) 

RATE [n.nnEnn]; (Exponential notation) 

ARBDATA% (ASCII character string) 

[low byte ][high byte] (Byte count) 

[low byte ][high byte] (First data point) 

[low byte][high byte] (nth data point) 

[cksm byte] (Checksum byte) 

The first OFFSET parameter initializes the instrument to prevent an in- 
valid amplitudeloffset combination. Subsequent amplitude and offset 
values can be integer (0 to 4095), decimal, or exponential notation. 

Binary data values range from 0 to 4095. 

The byte count is twice the number of data points plus one for the 
checksum byte (the byte count will always be an odd integer). 

Dataconversion To convert a low bytelhigh byte pair to an integer value, use the 
equation: 

WfmValue = (LowByte << 8) 1 (HighByte & 255); 

WfmValue ranges from 0 to 4095. To convert WmValue to its ASCII 
equivalent, subtract 2047. 



I The 2400 DSO Instrument Specific Format 

The 2400 DSO Data sent to a 2400 Series Digital Storage Oscilloscope is formatted in 

Instrument Specific ASCII characters as follows. In the example, data values shown 
enclosed in brackets are descriptive, not literal, and are to be replaced 

Format with actual data. The brackets are not included in an actual data string: 

WFMPRE WFI:'2400DSO",ENCD:BINA,BN.F:RI, 

XINC:[clockrate] ,YMULT(Volts per level],YOFF{offset], 

PT.F:[Y or envelope]; 

CURVE %[high byte][low byte][data 1] ...[ data 10241 

[checksum] 

High byte and low byte are the byte count (1 025) that follows. 

High byte = 04 hex, low byte = 01 hex. 

Each data byte value ranges from -1 28 to +127. 



I VXI VX5790 Instrument Specific Formats 

VXI VX5790 To manage waveform sequences in a manner compatible with both 

Instrument Specific the DOS and VXI environments, WaveWriter maintains a cross-refer- 
ence file that combines the information required by both environments. 

Formats 

The VX5790 Cross In the example, text in brackets is descriptive, not literal, and is to be 
Reference File Format replaced with actual data - the brackets and the descriptive text are 

not included in the actual data string. The symbols 'FI and L~ repre- 
sent carriage return and line-feed, respectively. Text in parentheses is 
commentary and is not part of the format: 

[Packet index]:[packet filenamelCRLF (Packet 1)  

[Packet index]:[packet f i ~ e n a r n e ] ~ ~ ~ ~  (Packet 2) 

[Packet index]:[packet filenamelCRLF (Packet n) 

The Packet lndex and Packet File fields are separated by an ASCII 
colon. The Packet lndex field is a fixed length of four characters. The 
Packet File field is a variable length field. The Packet Filename does 
not include an extension -all packet filenames in the cross reference 
file are unique. 
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VXI VX5790 Instrument Specific Formats I 
The VXI VX5790 In the example, text in brackets is descriptive, not literal, and is to be 

Instrument Specific File replaced with actual data- the brackets and the descriptive text are 
not included in the actual data string. Text in parentheses is commen- 
ta, and is not part of the format. There are no embedded carriage- 
returns or line feeds in the actual data. The symbol s~ is an ASCII 
space character. 

:devOO (Embedded address -optional) 

:ins% (Compound command header) 

:offsp[offset1 ; (off set) 

:ampsp[amplitude] ; (Amplitude) 

:divsp[clock divisor] ; (Defines clock rate) 

:devOO (Embedded address -optional) 

:pac (Compound command header) 

:encdgsp[data type] ; (Packet format - hexor bin) 

: inde~~p[~acket ]  ; (Packet index number) 

shapeSp (Waveform data header) 

#3192 (Byte count. First char after "# " 

is the number of following charac- 

ters that define the byte count. 

In this example, it takes 3 charac- 

ters to state that 192 data bytes 

will follow the byte count.) 

001 900240037004d006100750089009e (1 92 data bytes) 

00b200c600db00ef01040117012c0141 

015501 6901 7e019201 a701 ba01cfO1 e4 

Olf8020a021 f02330248025~02700285 

029902ad02c202d602ea02ff03120328 

033b035003640378038d03a203b503ca 
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VXI VX5790 Instrument Specific Formats 

Sequence lnstrument 
Specific File Format 

Below is an example of a sequence file is SIS format. This file can be 
send directly to the VX5790 arbitrary waveform generator, however the 
sequence file should be sent after the corresponding waveform packet 
file are sent. In the example, a waveform should have previously been 
sent to packet locations 2,4, and 17. 

wai; 

inst 

:amp 6.5; 

off 0; 

div 10; 

:encdg hex; 

index 0; 

order 

# 2  

(Embedded address - optional) 

(Make sure instrument is stopped) 

(Make for previous commands to finish) 

(Instrument group compound header) 

(Set amplitude to 6.5 volts) 

(Set offset to 0 volts) 

(Set clock divisor to 10; 10.24 pseclpoint 

for internal clock) 

(Embedded address - optional) 

(Sequence group compound header) 

(Set data encoding to hexadecimal) 

(Set sequence index to 0) 

(Specifies that a sequence order follows) 

(Specifies that the next 2 digits are the 

byte count) 

(Specifies that 18 bytes follow) 

(Waveform packet location 2 is 

repeated 1 time, not repeated) 

(Waveform packet location 4 is 

repeated 6 times.) 

(Waveform packet location 17 (1 1 hex) is 

03; repeated 3 times) 
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I VXI VX5790 Instrument Specific Formats I 
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Appendix D 
Error and Warning Messages 

Introduction Some messages are specific to an invalid edit box entry. When you 
select the error message box OK command, you will return to that edit 
box to correct the value. 

Generally, when values are entered, they are not checked for validity 
until the OK command has been selected. 

In the following error messages, items enclosed in square 
brackets ([ 1) are replaced with actual values in the error message box 
when it is displayed. 

If you see an error message other than listed below, it is a Microsoft 
Windowserror message. Refer to the Microsoft manual for more infor- 
mation. 

Error Messages 

E300 - Out of memory. 
Not enough memory was available to perform the selected operation. 
Clear unneeded waveforms or programs from memory and try again. 

E301 - Window creation failed. 
Not enough memory was available to create a window within Wave 
Writer Clear unneeded waveforms or programs from memory. 

E302 - Error accessing listbox. 
Not enough memory was available to fill a list box in a dialog box so 
the list of entries may not be complete. Clear unneeded waveforms or 
programs from memory and try again. 



Error Messages 

lnitializationfailed. 
When Wavewriterwas first loaded, there was not sufficient memory 
to initialize the defaults. Clear unneeded programs from memory and 
try again. 

Waveform name [name] already exists. 
You attempted to create a waveform which already exists. Specify a 
new name to proceed with the operation. 

Error reading file [filename]. 
An error was detected when reading the filename shown. This may be 
due to a disk error, or a corrupt file. 

Error creating file [filename]. 
An error was detected when trying to create the filename shown. This 
is most likely due to a disk error. 

Error closing file [filename]. 
An error was detected when trying to close the filename shown. This is 
most likely due to a disk error. It may also occur if the disk is full. 

Error opening file [filename] for read. 
An error was detected when trying to open the filename shown. This is 
most likely due to a disk error. 

Error creating temporary file. 
An error was detected when trying to create a temporary file. 

Error removing temporary files. 
An error was detected when trying to delete temporary files created by 
WaveWriterThe files may remain on disk. 

Error writing to disk. 
When creating or writing to an output file, an error was detected. This 
is most likely because the disk became full. If possible, free up more 
disk space by deleting unneeded files. To avoid losing data, you can 
minimize Wavewriterand use the Wndows control panel to delete 
the files, and then maximize Wavewriterwith waveforms still intact. 

Premature EOF. 
When the selected file was read in, the end-of file was detected before 
all data was read. This may have been due to a disk full error when writ- 
ing the file, or the file or disk may be corrupt. 
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E313 - Access denied. File cannot be overwritten, or directory full, 
or directory not found, or path specifies a directory. 

Executing the requested command violates the access mode of the 
file, subdirectory, or device involved. This can occur for the following 
reasons: 

-An attempt was made to write to a file marked read-only, or read a 
file that is write-only. 

- An attempt was made to open a subdirectory as a file. 

-The specified directory did not exist. 

E314 - Sharing mode specified when file sharing not installed, or 
access-mode value invalid. 

This can occur for the following reasons: 

-The given path name is a directory. 

- An attempt was made to open a read-only file for writing. 

- A sharing violation occurred (the file's sharing mode does not 
allow the specified operations). 

E315 - [name] - Path or file not found. 
The path or file specified does not exist. Check the name and try again. 

E316 - Too many open file handles. 
Too many files were already open to permit opening another. Close un- 
needed files or increase the FILES= value in the CONFIG.SYS file and 
reboot. 

E317 - Error creating cutlcopy buffer. 
CutlCopy operation aborted. 

For either menu selection Cut or Copy, Wavewriterwas not able to 
store the selected waveform segment on disk. This would occur if the 
disk was full. Eliminate unused disk files. 

E318 - Cannot open cutlcopy buffer. 
CutlCopy operation aborted. 

For either menu selection Cut or Copy, the cutlcopy buffer could not 
be opened. The operation is aborted. 

E319 - Problem reading cutlcopy buffer. 
Insert/Replace/Append operation aborted. 

For menu selection Insert, Replace or Append, the cutlcopy buffer 
could not be read. The selected operation was aborted. 



Error Messages 

E320 - 'Wave.cfgY corrupted. Only able to read in part of it. 
When loading WaveWriter the configuration file WAVE.CFG was cor- 
rupt. Default values were assigned by WaveWriterWhen you exit 
WaveWriter a new configuration file will be saved with the currently 
selected defaults. 

E321 - Not enough memory. Only part of the configure file was read. 
When loading Wavewriter the configuration file WAVE.CFG is read to 
get Wavewriterdefaults. Only part of the file was read. Default values 
were assigned by Wavewriterfor portions of the file which were not 
found. When you exit WaveWriter a new configuration file will be 
saved with the currently selected defaults. 

E322 - [filename] is not a valid library file. 
For the Equation menu selection, the library file selected was not the 
proper format for equation library. 

E323- Only 1 Help window may be opened at a time. 
You may only select one help window to be displayed at a time. To dis- 
play another help window, you must first close the currently displayed 
help window. 

E324 - Help topic not found. 
The selected help topic is not available. This error should not occur 
under normal circumstances. 

E325 - Help file [filename] not found. 
The help text file for the selected help topic was not found. All help text 
files should be on a subdirectory HELP from the directory where the 
WaveWriter executable file resides. Perhaps the file was inadvertently 
deleted. Either reinstall WaveWriter software, or copy all .HLP files 
from WaveWriter Disk # 2 to the HELP subdirectory. 

E326 - Error reading help topics and files. 
File HLPTOPIC.HLP, which is a list of all help topics presented from 
the Help selection in the Main Menu, was not found or is corrupt. 
Either reinstall Wavewritersoftware, or copy file HLPTOPIC.HLP from 
WaveWriter Disk # 2 to the HELP subdirectory. 

E327 - Corrupted sequence file [filename]. 
For menu selection Sequence, the file you selected to open is cor- 
rupted. 
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E328- File [filename] cannot be read in either ADlF 
or instrument specific format. 

For menu selection Open, the selected file cannot be read as either an 
ADlF file, or an instrument specific file for the currently selected target 
instrument. If the ADlF file was not created by Wavewriter it may not 
be a compatible version. If the file cannot be read in instrument 
specific format, it may be because the file was created for use by a dif- 
ferent instrument. If so, use the ChangeIConfigurelnstrurnent selec- 
tion to change the target instrument, and then select Open again to try 
to read the desired file. 

E350 - Invalid number. 
In response to an edit box, you entered an invalid number. Check the 
value and try again. 

E351- Must be a digit 0 - 9. 
In response to an edit box, you entered a character which was not a 
combination of the digits 0, 1, 2,3, 4,5 ,  6,7,8, and 9. Check the value 
and try again. 

E352- lnvalid number. The number must be greater than [number]. 
In response to an edit box, you entered a number which was out of the 
acceptable range. The error message tells you the acceptable lower 
bound. Check the value and try again. 

E353- lnvalid number. The number must be less than [number]. 
In response to an edit box, you entered a number which was out of the 
acceptable range. The error message tells you the acceptable upper 
bound. Check the value and try again. 

E354- lnvalid number. The number must be between [number - number]. 
In response to an edit box, you entered a number which was out of the 
acceptable range. The error message tells you the acceptable lower 
and upper bounds. Check the value and try again. 

E355 - lnvalid number. The number must be non-negative. 
In response to an edit box, you entered a number which was out of the 
acceptable range. Enter a number which is greater than or equal to 
zero. 

E356 - Invalid number. Too small for instrument to handle. 
For menu selection Set AxisRanges, you entered a value for 
Amplitude which is too small for the target instrument to handle. 
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E357- Waveform size exceeds repetition size of [size]. 
For menu selection Sequence, the number of repetitions exceeded 
the maximum amount for the target instrument. The last digit you 
entered was discarded. 

E358 - Invalid filename. 
In response to a file name edit box, you entered an invalid filename. 

The following characters are not allowed in filenames: 
. " / \ < > : I [ ] + = ; ,  
ASCII characters less than 20H 

The following reserved words are not allowed for filenames: 
aux, con, prn, nul, coml, com2, com3, ~ 0 m 4 ,  
Iptl , lpt2, lpt3, wave 

E359 - Invalid displayed waveform name. 
In responses to an edit box prompt for a waveform name which must 
be in WaveWritermemory, you entered a name which does not exist. 
Check the spelling of the name entered, or use the Waveform List to 
see a list of all waveforms currently in WaveWritermemory. 

E360 - Name already exists. 
For menu selection Change/Configurelnstrument, you entered a 
name which already exists and then selected Add to add a new entry 
to the instrument list. Either provide a unique name and select Add 
again, or select Replace if you meant to replace information for the 
selected instrument. 

E361- Invalid offset for current display amplitude. 
For menu selection Save, the offset entered is not appropriate for the 
current display amplitude. This error is generated for instruments 
which require the offset to be within a certain range, based on the 
amplitude. See E l  005 for more information. 



Error Messages 

E362 - Parameters given require a period larger than that which is defined. 
For menu selection Pulse or Square, the values you entered to define 
the waveform were not appropriate. The component parameters you 
entered together exceed the waveform period. 

For Pulse, the following relationship must be satisfied: 

Delay + Pulse Width + Rise + Fall < Period 

For Square, the following relationship must be satisfied: 

Rise + Fall < (Stop - Start) / Cycles 

The Rise and Fall in the above equations are not the Rise and Fall that 
you enter into the edit boxes, but rather are modified based on 
whether Ramp or Sine squared was selected. For Ramp, Rise and Fall 
will be altered by a factor of 1.25. For Sine squared, they will be altered 
by a factor of 2.073878. Check the entries again and correct the invalid 
response(s). 

E363- Waveform length too large. The length must be less than [length]. 
For menu selection Sequence, the waveform selected for the se- 
quence was larger than the maximum allowable length. You may need 
to break the waveform into smaller components and save in new files 
before using them with the sequence editor. 

E364- Invalid Number. 0 c Duty Cycle c 100. 
For menu selection Square, the Duty Cycle you entered was invalid. 
The duty cycle must be greater than 0 and less than 100. 

E365 - An envelope waveform cannot be coupled. 
For menu selection EnvelopeCouple, you entered a waveform name 
which is an envelope waveform for one of the input waveform names. 
To use Envelope Couple, you supply two input waveform names 
which are not envelope waveforms, and another name for the output 
waveform, where the created envelope waveform will be stored. 

E366 - An envelope waveform must be selected to decouple. 
For menu selection EnvelopeDecouple, you entered a waveform 
name which is not an envelope waveform in response to the prompt 
for the input waveform. To use EnvelopeDecouple, you supply an 
input waveform name, which must already be an envelope in memory, 
and two output waveforms, where the component non-envelope 
waveforms will be stored. 

E367- The [name] waveform is the same as the envelope waveform. 
They must be unique. 

For menu selection Envelope Couple, one of the input waveform 
names entered was the same as the envelope waveform selected for 
the output waveform. They must be unique. 



I Error Messaaes I 

No tolerance has been entered. 
Try again or cancel. 

For menu selection EnvelopeTolerance, no tolerance was entered. 
To proceed with the function, you must supply a tolerance. Otherwise 
select Cancel to abort. 

Cannot add, subtract, multiply, or divide envelopes. 
For either menu selection AddWaveforms, SubtractWaveforms, 
MultiplyWaveforms, or DivideWaveforms, you specified an en- 
velope waveform name. Only normal waveforms may be used for 
these operations. 

Could not complete horizontal resolution. 
For menu selection HorizontalResolution, the selected operation 
could not be completed. 

Use the file extension edit boxes to enter the extension. 
For menu selection Save, you started to enter a file extension as part 
~f the filename edit box. Instead, you should enter only the filename 
prefix in the filename edit box, and the extension in the appropriate ex- 
tension box(es), depending on whether you select ADlF or instrument 
specific format. 

Identical file extensions for both ADlF and instrument specific files not allowed. 
For menu selection Save, the same extension was supplied for ADlF 
and instrument specific files. You must select different extension so 
that two distinct files can be created. 

A file type must be selected. 
For menu selection Save, neither the ADlF or Instrument Specific File 
check boxes were selected. Select one or both of these check boxes 
to indicate which type of file(s) you want created. 

Invalid device name. 
This message is only generated if the Windows configuration file 
WIN.INI is corrupt and has invalid device names specified for the 
printer devices. Check WIN.INI to see if it is corrupt, and if so, make a 
new copy using the appropriate Windows disk. 

Printer not available. 
For menu selection Hardcopy, the printer was not available. Please en- 
sure the printer is available (powered on, on-line, cables firmly con- 
nected, paper loaded). If all these things are okay, check to see that 
the printer is configured correctly. 
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E376 - Feature currently not supported for [driver]. 
You selected a menu selection which is not appropriate for the current- 
ly selected target instrument. For example, you selected Acquirewhen 
the target instrument is the VX5790. 

E377 - GPlB error. 
Check all GPlB cables to ensure they are securely attached. If the ad- 
rlres!: is inrnrrect rise ChannelCanfinurelnstrument to set it to the .-.-"" .., ...--..--., --- -..--. '"'a---.' -----" '- --' .' '- -.-- 

proper value, and try again. 

E378 - Illegal symbol: [symbol] 
For menu selection Equation, you entered a symbol in the equation 
edit box which is not allowed. Use 4' as a placeholder for the running 
variable, e.g. sin(2'pi't). 

E379 - YACC internal stack overflow. 
For menu selection Equation, the equation is too complex for the par- 
ser to handle. Try simplifying the equation. 

E380 - Syntax error. 
For menu selection Equation, a syntax error was detected in the equa- 
tion edit box. Acknowledge this error and you may get more specific in- 
formation about the error. 

E381- Missing variable (t), operator, or parenthesis. 
For menu selection Equation, the equation entered was either missing 
the variable t, an operator, or had mismatched parenthesis. Check the 
equation and try again. 

E382 - Maximum and minimum waveforms cannot be the same. 
When creating envelopes, you cannot specify the same waveform to 
be both the maximum limit and the minimum limit. 

E383 - Invalid number for the function [function name]. 
The number entered as a parameter for the particular math function is 
invalid. For example "sqrt (0)", is invalid. 

E384 - Acquisition-Only instrument, cannot be selected as the target instrument. 
Instruments marked with an "*" in the Change/Configureinstrument 
dialog box are acquisition-only and cannot be made the target instru- 
ment. You are not able to send data to these instruments, you can only 
acquire data. 
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Warning Messages 

W400 - Replace existing [filename] file? 
This warning tells you that the selected output file already exists and al- 
lows you to confirm that you want to replace it. Enter 'Y' to replace the 
existing file and 'N' to cancel the operation. 

W401- [filename] has changed. Do you wish to save? 
For menu selection ClearWaveform(s), if you choose to clear a 
waveform which has changed and not been saved, you are given the 
opportunity to save it first. Enter 'Y' to save it, or 'N' to not save it. You 
are also given this option when you exit Wavewriterand memory 
waveforms which have been created or altered have not been saved. 

W402 - Configuration values changed but not saved. Exit still? 
This is a reminder that for the ConfigureIChangelnstrument menu 
selection, you changed values for the highlighted entry, but didn't 
choose either Add or Replace to update them. Enter 'Y' if you don't 
want to change them; enter 'N' if you want to return to the dialog box 
to perform the desired operation. 

W403- Sequence is not saved. Do you wish to save it? 
For menu selection Sequence, you chose to exit the menu selection 
without having saved the information you entered. You are warned and 
given the opportunity to save it. Enter 'Y' to save it or 'N' to not save it. 

W404 - Unknown FORMAT type - ASCll used. 
For menu selection Open, an ADlF file was read for which the FOR- 
MATfield was invalid. ASCll was assumed. 

W405 - Attempt to divide by zero. 
For menu selection Divide, one or points of the divisor waveform was 
zero. Instead, Wavewriteruses the smallest nonzero adjacent data 
point. If all adjacent points are 0, it divides by 1. 

W406 - SYSTEM LIMITS EXCEEDED! Resultant waveform was clipped at [value]. 
For either menu selection Addscalar, Multiply by  Scalar, Add 
Waveforms, SubtractWaveforms, MultiplyWaveforms, or Divide 
Waveforms, the resultant waveform would have had a value which ex- 
ceeded the system limits. The upperllower bound value was assigned 
instead. 
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W407- Unable to create Undo buffer. 'Undo' will not be available. 
Select OK to continue anyway. 

When attempting to preserve a copy of the waveform before altering it, 
insufficient disk space was available. You are asked if you still want to 
proceed with the operation that will change the waveform. Select OK if 
you wish to proceed; Cancel otherwise. To free up the necessary disk 
space, you may wish to delete unneeded files. 

W408- Current display amplitude is too large for selected target instrument. 
Display amplitude will be adjusted. 

For menu selection ChangelConfigurelnstrument, you changed the 
target instrument and the current vertical axis range now exceeds the 
maximum allowed for the target instrument. The vertical axis will be ad- 
justed to the maximum allowed for the target instrument. Waveforms 
will be clipped on the display, but no data is lost. 

W409 - Full autoscale needs a display amplitude which is too large for 
the target instrument. Display amplitude will be adjusted to 
the maximum possible. 

When attempting to autoscale the current waveform, the waveform 
amplitude of the current waveform exceeded the maximum amplitude 
allowed for the target instrument. The viewport was adjusted to the 
maximum allowed for the target instrument. The waveform will be 
clipped on the display. No waveform data is lost. 

W410- One or more waveforms have a clock rate different from the sequence 
clock rate. 

This warning appears when all waveform clock rates are not equal to 
the sequence clock. The clock rates should be the same when sending 
the sequence to the instrument. To correct the problem, use Change 
Clock Rate and then use Save to save the waveform with the new 
clock rate. 

W411 - The path in [fully specified filename] will be ignored. 
You entered a path with the filename in response to a filename edit 
box. The path was ignored. Either change the default path via the 
Open menu selection, or specify the path when you save the file. 
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AFG 5101 Error Messages 

El 000 - Error acquiring waveform from AFG 51 0115501. 
An error was detected when acquiring a waveform from the 
AFG 510115501. Check the GPlB cables to see that they are securely 
attached and try again. 

El 001 - Error sending waveform to AFG 510115501. 
An error was detected when sending a waveform to the 
AFG 510115501. Check the GPIB cables to see that they are securely 
attached and try again. 

El 002- All addresses searched. No AFG 51 0115501 found. 
All primary addresses were checked for the presence of an 
AFG 510115501 and none was found. Check the GPlB cables to see 
that they are securely attached and try again. 

El 003- Current clock rate is invalid for AFG 51 0115501. 
Accept upper limit of 999.9S? 

A clock rate which is above the upper limit for the AFG 51 0115501 was 
entered. The acceptable range is: 1OOnS to 999.98. You are offered the 
opportunity to change it to the upper limit. 

El  004 - Current clock rate is invalid for AFG 51 0115501. 
Accept lower limit of 1 OOnS? 

A clock rate which is below the lower limit for the AFG 51 0115501 was 
entered. The acceptable range is: 100nS to 999.9s. You are offered the 
opportunity to change it to the lower limit. 

El  005- Invalid amplitude 1 offset pair for AFG 51 0115501. 
The amplitudeloffset combination entered when sending a waveform 
to the AFG 510115501 is outside of the acceptable limits. The 
amplitude and offset must conform to the following relationship: 

Amplitude I 2 + Offset = Absolute peak amplitude 
+ offset into 50 Ohms 

AmplitudeRange Peak Amplitude + Resolution 
Absoluteoffset into 50 Ohms 
into 50 Ohms 
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El 006 - Waveform exceeds limit for AFG 51 01 15501. 

Must be less than or equal to 8192. 
When attempting to send a waveform to the AFG 5101, the waveform 
size was greater than the maximum record length of 81 92. Use 
markers to segment off a section which is the appropriate size, and 
choose to send only the portion of the waveform between the markers. 

El 007 - AFG 51 01 15501 does not support envelope waveforms. 
You attempted to either save an instrument specific file or send the 
waveform to the AFG 5101/5501 and the current waveform is an en- 
velope. The instrument does not support envelopes. You may want to 
use EnvelopeDecouple to break the envelope into 2 components 
and sendlsave them individually. 

El008- Number of points to send + Beginning Address exceeds 8192. 
When attempting to send a waveform to the AFG 51 0115501, the Begin- 
ning Address specified plus the number of waveform points selected 
exceeds the maximum record length of 8192. Either change the Begin- 
ning Address to a smaller value, or move the markers to change the 
number of points of the waveform to send. 
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2200 DSO Error Messages 

E l  300 - Error acquiring waveform from 2200 DSO. 
An error was detected when acquiring a waveform from a 2200 DSO. 
Check the GPlB cables to see that they are securely attached and try 
again. 

E l  301 - All addresses searched. No 2200 DSO found. 
All primary addresses were checked for the presence of a 2200 DSO 
and none was found. Check the GPlB cables to see that they are 
securely attached and try again. 

E l  302 - XY Mode is not supported. 
Waveform data stored in the VerticalMode 'XY'cannot be read into 
Wave Writer. 

E l  303 - Reference memory [number] empty. 
There is no waveform in the selected reference memory. 
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2400 DSO Error Messages 

E l  100 - Error acquiring waveform from 2400 DSO. 
An error was detected when acquiring a waveform from a 2400 DSO. 
Check the GPlB cables to see that they are securely attached and try 
again. 

E l  101 - Error sending waveform to 2400 DSO. 
An error was detected when sending a waveform to the 2400 DSO. 
Check the GPlB cables to see that they are securely attached and try 
again. 

E l  102 - All addresses searched. No 2400 DSO found. 
All primary addresses were checked for the presence of a 2400 DSO 
and none was found. Check the GPlB cables to see that they are 
securely attached and try again. 

E l  103- Data has more than 1024 points. 
Too large for 2400 DSO record length. 

When attempting to send a waveform to the 2400 DSO, the waveform 
size was greater than the maximum record length of 1024. Use 
markers to segment off a section which is of the appropriate size, and 
choose to send only the portion of the waveform between the markers. 

E l  104- Number of points to send + Start At value exceeds 1024. 
When attempting to send a partial waveform to the 2400 DSO, the start- 
ing address specified plus the number of points between the markers 
exceeds the maximum record length of 1024. Either change the start- 
ing address to a smaller value, or move the markers to change the 
number of points of the waveform to send. 

E l  105 - 2400 DSO cannot run at clock rates slower than 0.1 seclpoint 
(5.0 secldiv). Is 0.1 seclpoint acceptable? 

A clock rate which is too slow for the 2400 DSO was entered. For 
24403, the acceptable range is 40 pico-secondslpoint to .1 
secondslpoint. For all other 2400 DSO's, the acceptable range is 100 
pico-seconds/point to .1 seconds/point. Both clock rates must con- 
form to a 1, 2,5 sequence. You are offered the opportunity to change 
it to .1 seconds/point. 
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El 106 - Too slow for the 2400 external clock. Accept lower limit of 
1 uslpoint? 

The clock rate entered is invalid for the 2400 DSO with an external 
clock. You are offered the opportunity to change it to the lower limit 
shown. 

El 107 - Too fast for the 2400 external clock. 
Accept upper limit of 10 nslpoint? 

The clock rate entered is invalid for the 2400 DSO with an external 
clock. You are offered the opportunity to change it to the upper limit 
shown. 



I VX5790 Error Messages I 

VX5790 Error Messages 

E l  200 - Error sending waveform to VX5790. 
An error was detected when sending a waveform to the VX5790. 
Check the GPlB cables to see that they are securely attached and try 
again. 

El201 - No VX5790 AWG found at address [address]. 
When attempting to communicate with the VX5790 AWG, the instru- 
ment was not found at the shown address, i.e. the address specified in 
the ChangeIConfigurelnstnrment menu selection. 

E l  202- VX5790 does not support envelope waveforms. 
You attempted to either save an instrument specific file or send the 
waveform to the VX5790 and the current waveform is an envelope. The 
instrument does not support envelopes. You may want to use En- 
velopeDecouple to break the envelope into 2 components and 
sendlsave them individually. 

E l  205- VXI communication error. 
Unable to communicate over the VXI bus. Check that the logical ad- 
dress is correct, that the jumpers in the mainframe are properly set, 
and that the instrument is fully plugged into the mainframe. 

W1203- Current clock rate was not valid for the VX5790 and 
was changed to the nearest valid rate of [new rate]. 

For ConfigureIChangelnstrument, you changed the target instru- 
ment to the VX5790, but the current clock rate is not one of the valid 
rates for the VX5790. The clock rate is changed to the nearest valid 
rate as shown in the message. 

W1204- Waveform size is greater than one packet. Multiple packets will be created. 
Do you wish to continue? 

When the waveform size is greater than the maximum packet size, 
(2048), Wavewriteruses the VX5790 CURVE command. This com- 
mand uses sequential packets to hold the waveform data and will auto- 
matically generate a sequence to execute the waveform. The specified 
packet index is used as the starting location for the packets, and the 
specified sequence index is used to hold the sequence. Existing pack- 
ets in the VX5790 within the range of the CURVE command will be 
overwritten. 



I VX5260 Error Messages 

VX5260 Error Messages 

E l  500 - Error acquiring waveform from VX5260 Digitizer. 
An error was detected when acquiring a waveform from a VX5260 
digitizer. Check the GPIB cables to see that they are securely attached 
and try again. 

E l  501 - All addresses searched. No VX5260 digitizer. 
All primary addresses were checked for the presence of a VX5260 
digitizer and none was found. Check the GPIB cables to see that they 
are securely attached and try again. 

E l  502 - VXI communication error. 
Unable to communicate over the VXI bus. Check that the logical ad- 
dress is correct, that the jumpers in the mainframe are properly set, 
and that the instrument is fully plugged into the mainframe. 

E l  503 - VXI message delivery system (MDS) not loaded. 
The message delivery system required for the VX5530lVX5535 has not 
been loaded. See the VX5530lVX5535 User's Manual for installation 
procedures. 

W155Q- No data in the VX5260 for this record location. 

W1554 - No record location specified. Please enter a number in the Record Loc edit box. 
The number entered must be between 1 and 128. 

W1552- Start plus count exceeds the VX5260 record length. Need to decrease start and/or 
count. 

W1553- Size of data transfer greater than Wavewriter limit of 32767. Need to set count to 
32767 or less. 

W1554- Invalid count. Please enter a number greater than 1 for count. 
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11 000 Series DSO Error Messages 

El 400 - All addresses searched. No 1 1 K or DSA found. 
All primary addresses where checked for the presence of an 1 1 K DSO 
or DSA and none were found. Check the GPlB cable to see that they 
are securely attached and try again. 

El 401 - Error acquiring waveform from 1 1 K DSO. 
An error was detected when acquiring a waveform from an 11 K DSO 
or DSA. Check the GPlB cables to see that they are securely attached 
and try agin. 

El 402 - Error acquiring preamble from 1 1 K DSO. 
An error was detected when acquiring the preamble from an 11 K DSO 
or DSA. Check all GPIB connections and try again. 

El403- GPlB error: Unable to communicate with device at address [number]. 
Unable to communicate on the GPlB bus. Check that all cables are 
securely attached and try again. 

El 404 - No valid sources available. 
There are no traces defined and there are no stored waveforms. Apply 
an input source to the scope and try again. 

El 405 - Invalid source selected. 
The waveform selected to transfer is no longer available on the scope. 
Check the available sources and try again. 



11 000 Series DSO Error Messages 
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2400 Series Digital Storage Oscilloscope 
Acquire waveform, 1 1-9,B-21 
Clock Rate, 7-8, B-9 
Error messages, D-15 
Instrument specific file format, C-6 
Send waveform, 11 -1 3,B-22 

A 
About, 5-1 2, B-4 
Acquire, 1 1-4,B-20 

AFG 510115501, 11-5, 8-21 
1 1000 Series DSO, 11 -1 1,B-21 
2200 Series DSO, 11 -7, B-21 
2400 Series DSO, 11-9, B-21 
VX5260Digitizer,ll-21 

Acquisition Only, 3-1 
Add Equation, 9-8 
Add Scalar, 10-1 , B-18 
Add Waveforms, 10-3,B-19 
ADlFfile, 5-7, C-1 
AFG 510115501 Arbitrary Function Generator 

Acquire waveform, 11 -5,B-21 
Change Clock Rate, 7-6, B-9 
Error messages, D-12 
Instrument specific file format, C-5 
Send waveform, 1 1-20,B-22 

Amplitude, 9-3 
Append to End of Waveform, 6-5, B-6 
AUTOEXEC.BAT,2-3 
Autoline, 8-6, B-11 
Autoscale Current Waveform, 7-5, B-9 

B 
Bit range, 3-2,7-4 

C 
Change Clock Rate, 7-6, B-9 

2400 Series DSO, 7-8, B-9 
AFG 51 01 /5501,7-7, B-9 
VXI W 7 9 0  AWG, 7-10, B-9 

Change current directory, 5-4 
Change Current Waveform, 3-1 5,7-11, B-10 

Clear Waveform(s), 6-2, B-5 
Clock rate, 3-1,3-18,s-5,7-6,9-6,11-6, B-9 
ConfigureIChange Instrument, 11 -l,B-20 
Configuring DOS, 2-3 
Configuring GPIB, 2-3 
Control-Menu, 3-7 
Conventions, 1-5 

Direction keys, 1-5 
Entering data from keyboard, 1-5 
Enter key, 1-5 
Key combinations and sequences, 1-5 
Keyboard versus mouse, 1-6 
Key names, 1 -5 

Copy Between Markers, 6-4,B-5 
Coordinates, 3-1 6,8-2 
Create menu, 9-1,B-12 

Envelope Couple, 9-32,B-16 
Envelope Decouple, 9-34,B-17 
EnvelopeTolerance, 9-29,B-16 
Equation, 9-5,B-12 

Definitions, 9-6,B-13 
Example, 9-7, B-13 
Functions, 9-5,B-13 
Operators, 9-5,B-13 

Library, 9-9,B-12 
Add Equation, 9-8 
Remove Equation, 9-9 

Overview,9-1 



INDEX I 
C (Continued) 

Parameterdefinitions, 9-3,9-4 
Pulse, 9-21, B-15 
Sequence Editor, 9-36,B-17 
Sequence Editor Menus, 9-41 
Sine, 9-15, B-14 
Square,9-25, B-15 
Triangle, 9-1 8, B-14 

Current Waveform, 3-15,7-11 
Cut Between Markers, 6-4, B-5 
Cycles, 9-3 

D 
Data non-conformance, 5-5 
Default extensions, 5-7 
Delay, 9-4 
Delete Between Markers, 6-4, B-5 
Dialog boxes and controls, 3-9,3-10 
Directory (changing current), 5-4 
Display, 3-2,7-4 
Display elements, 3-4,3-5 
Display menu, 7-1, B-8 

Autoscale Current Waveform, 7-5, B-9 
Change Clock Rate, 7-6,B-9 

2400 Series DSO, 7-8, B-9 
AFG 51 01/5501, 7-7, B-9 
VXI VW790 AWG, 7-1 0, B-9 

Change Current Waveform, 7-1 1, B-10 
Ove~ iew,  7-1 
Redraw Dot, 7-2, B-8 
Redraw Vector, 7-2,B-8 
Set Axis Ranges, 7-4, B-8 
Set Colors and Line Styles, 7-1 1 
Show Crosshairs, 7-1 1, B-10 
Zoom In, 7-2,7-3,B-8 
Zoom Out, 7-2,7-3,B-8 

Divide Waveforms, 10-3, B-19 
DOS configuration, 2-3 
Draw menu, 8-1, B-1 1 

Autoline, 8-6,B-11 
Control key, 8-2 
Envelope Max, 8-9, B-11 
Envelope Max Don't Care, 8-7, B-11 
Envelope Min, 8-9, B-1 1 
Envelope Min Don't Care, 8-8, B-11 

Draw Menu (Continued) 
Freehand, 8-3, B-11 
Horizontal, 8-4, B-11 
Nodraw, 8-2, B-1 1 
Overview,8-1 
Screen Redraw, 8-2, B-11 
Starting out, 8-2 
Vertical, 8-5,B-11 

Duty cycle, 9-4 

E 
Edit buffer, 6-4, B-5 
Edit menu, 6-1,B-5 

Append to End of Waveform, 6-5, B-6 
Clear Waveform(s), 6-2, B-5 
Copy Between Markers, 6-4, B-5 
Cut Between Markers, 6-5, B-5 
Delete Between Markers, 6-4, B-5 
Edit Buffer, 6-4 
Flip Horizontal Between Markers, 6-5, B-6 
Flip Vertical Between Markers, 6-5, B-6 
Horizontal Resolution, 6-6, B-6 
Insert at Start Marker, 6-4, B-6 
Overview,6-1 
Replace Between Markers, 6-5, B-6 
Undo, 6-2,843 
Vertical Resolution, 6-9,B-7 

Envelope Couple, 9-32, B-16 
Envelope Decouple, 9-34, B-17 
Envelope Max, 8-9, B-11 
Envelope Max Don't Care, 8-7, B-11 
Envelope Min, 8-9, B-11 
Envelope Min Don't Care, 8-8, B-11 
Envelope Tolerance, 9-29,B-16 
Equation, 9-5 

Definition, 9-6 
Example, 9-7 
Functions, 9-5 
Operators, 9-5 

Equation Library, 9-9 
Add Equation, 9-8 
Remove Equation, 9-9 

Equipment required, 1-3 
Error messages, D-1 
Exit, 5-1 2, B-4 
Extensions, default, 5-7 



INDEX 

F 
Falltime, 9-4 
Fall type, 9-4 
File formats, 5-7, C-1 

ADlF file, 5-7, C-1 
Default extensions, 5-7 
Instrument specific file, 5-7 

AFG 51 0115501 instrument specific 
format, C-5 
2400 Series DSO instrument specific 
format, C-6 
VXI VX5790 cross reference file format, 
VXI VX5790 instrument specific file 
format, C-8 

Sequence Editor File Format, C-4 
File menu, 5-1, B-1 

About, 5-12, B-4 
Exit, 5-1 2, B-4 
Hardcopy, 5-1 1,B-4 
Open, 5-4,B-2 
Overview, 5-1 
New, 5-2, B-1 
Save, 5-6, B-3 

Filename, 5-4,s-7 
Flip Horizontal Between Markers, 6-5, B-6 
Flip Vertical Between Markers, 6-5, B-6 
Freehand, 8-3 
Frequency, 9-3 

G 
GPlB configuration, 2-3 

H 
Hardcopy, 5-1 1,B-4 
Hardware required, 1-3 
Hardware setup, 2-3 
Help, 3-1 8 
~orizontal Draw, 8-4, B-11 
Horizontal Resolution, 6-6, B-6 

I 
Insert at Start Marker, 6-4, B-6 
Installation, 2-1 
Instruments supported, 1-3 
Instrument specific file, 5-7 

2400 Series DSO, C-6 
AFG 5101/5501, C-5 
VXI VX5790 AWG, C-8 

L 
Library, 9-9 

Add Equation, 9-8 
Remove Equation, 9-9 

Longer function, 6-8 

M 
Markers 3-3,3-16 
Max, 9-3 
Menu Map, A-1 
Menus, 3-7 
Microsoft Windows 3-13 - 3-13 

Control-Menu, 3-7 
Dialog boxes and controls, 3-9 

Check boxes, 3-9,1-13 
Command buttons, 3-9,3-13 
Data already entered, 3-1 0 

C-7 Edit boxes, 3-9,3-11 
Escape key, 3-1 3 
Grayed display, 3-1 0 
Group boxes, 3-9 
List boxes, 3-1 2 
Option buttons, 3-9,3-13 
Tab key, 3-9 

Display Elements, 3-4,3-5 
Menus, 3-7 
Scrolling, 3-6 

Min, 9-3 
Mouse terms, 1-6 

Click, 1-6 
Double-click, 1-6 
Drag, 1-6 
Move, 1-6 
Point, 1-6 

Multiply by Scalar, 10-1, 8-1 8 
Multiply Waveforms, 10-3,B-19 

N 
Nearest related point, 6-7 
New, 5-2, B-1 
Nodraw, 8-2, B-11 
Normal waveform, 5-2 

0 
Offset, 3-2,3-15,5-6,9-3,9-6 
Open, 5-4, B-2 

P 
Packet, 9-36 
Parameterdefinitions, 9-3,9-4 
Period, 9-3 
Phase,9-3 
Printer configuration, 5-1 1 
Printers,5-11 
Pulse, 9-21,B-15 
Pulse Width, 9-3 
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INDEX 

Q 
Quick Reference, B-1 

R 
Ramp, 9-4 
Redraw Dot, 7-2, B-8 
Redraw Vector, 7-2, B-8 
Remove Equation, 9-9 
Replace Between Markers, 6-5, B-6 
Risetime,9-4 
Rise type, 9-4 

Save, 5-6, B-3 
VX5790AWG, 5-9, B-3 

Screen redraw, 8-2 
Scrolling, 3-6 
Selecting current waveform, 3-15,7-11 
Selecting target instrument, 11-2 
Send, 11-19, B-22 

2400 Series DSO, 1 1-22 
AFG 51 01 /5501,11-20 
VXI VX5790 AWG, 1 1-24 

Sequence Editor, 9-36 
Sequence Editor file format, C-4 
Sequence Editor Menus, 9-41 
Set Axis Ranges, 7-4,B-8 
Set Colors and Line Styles, 7-1 1 
Short function, 6-7 
Show Crosshairs, 7-1 1, B-10 
SigProc (signal processing) menu, 10-1,B-18 

Add Scalar, 10-1, B-18 
Add Waveforms, 10-3,B-19 
Divide Waveforms, 10-3, B-19 
Multiply by Scalar, 10-1,B-18 
Multiply Waveforms, 10-3,B-19 
Overview, 1 0-1 
Subtract Waveforms, 10-3, B-19 

Sine, 9-15, B-14 
Sine squared, 9-4 
Software installation, 2-1 
Square, 9-25, B-15 
Starting WaveWriter, 2-2 
Start marker, 3-1 6 
Start point, 9-3 
Stop marker, 3-1 6 
Stop point, 9-3 
Subtract Waveforms, 10-3, B-19 
Supported instruments, 1-3 

T 
Target Instrument, 3-1,11-1,11-2 
Technical support, 1-7 
Title bar, 3-1 6 
Transfer Menu, 11 -1, B-20 

Acquire, 1 1-4,B-20 
1 1000 Series DSO, 1 1-1 1,B-21 
2200 Series DSO, 11 -7,B-21 
2400 Series DSO, 1 1-9,B-21 
AFG5101/5501,11-5,B-21 
VX5260Digitizer, 1 1-1 5,B-21 

ConfigureJChange Instrument, 11-1, B-20 
Overview, 1 1-1 
Selecting target instrument, 11-2 
Send, 1 1-19, B-22 

2400 Series DSO, 11 -22 
AFG 51 01/5501,11-20 
VXI VX5790 AWG, 1 1-24 

Transform method, 6-7 
Triangle,9-18, B-14 

U 
Undo, 6-2, B-5 
Units (choice of), 3-14,9-2 
Units of measure, 3-1 4,9-2 

v 
Vertical Draw, 8-5, B-11 
Vertical Resolution, 6-9, B-7 
VXI VX5790 Arbitrary Waveform Generator 

Change Clock Rate, 7-1 0, B-9 
Cross reference file format, C-7 
Instrument specific file format, C-8 
Save, 5-9, B-3 
Send waveform, 1 1-24 
Error messages, D-17 

VXI VX5260 Waveform Digitizer 
Acquire waveform, 1 1-1 5 
VX5260Parameters,l1-15 
VX5260 Record Information, 1 1-1 7 
VX5260TalkerIListener,ll-18 
Error Messages, D-18 

W 
Warning messages, D-10 
Waveform Display Area, 3-1 7,7-4 
Waveform List, 3-15, 7-1 1 
Waveform List icon, 3-1 5 
Waveform name, 5-2 
Wavewriterwindow, 3-1 6 

z 
Zoom In, 7-2,7-3, B-8 
Zoom Out, 7-2,7-3,B-8 
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